Preparing to Teach Online

UNIVERSITY OF HARTFORD
FACULTY CENTER FOR LEARNING DEVELOPMENT
Mortensen L203
hartford.edu/fcld
860.768.4661 • fcld@hartford.edu
TECHNOLOGY AT THE UNIVERSITY OF HARTFORD

**hartford.edu/OTS**
860.768.4357 (on-campus)
844.292.3213 (off campus)
helpdesk@hartford.edu
For help with:
- E-Mail Password
- Self-Service or Banner Issues
- Wi-Fi or Network Issues
- Classroom Technology

**hartford.edu/MTS**
860.768.4662
mts@hartford.edu
- Classroom Technology
- WebEx
  - Personal & Lecture Capture
- Ensemble

**Wi-Fi Network**
Choose “hawknet” wherever possible.
- Username: University email (NOT including @hartford.edu)
- Password: Email password

**Email & Download Office365**
https://portal.office.com
- Username: full University email address
- Password: Email password

**Faculty Center for Learning Development**
860.768.4661
fcld@hartford.edu
hartford.edu/fcld
- Faculty Blackboard Support
- Faculty Seminars, Guest Presenters & How-to-Workshops
- Instructional design consulting
- Written Guides/Videos on Academic Technology
- Drop-in Faculty Lab

**Student Blackboard Support**
860.768.4636
bbsupport@hartford.edu
hartford.edu/studentbbsupport

**Blackboard Login:**
Username: first part of your email (do NOT include @hartford.edu)
Password: last four digits of University ID

**Reset Email Password**
https://hartford.edu/reset

**Self-Service**
https://hartford.edu/selfserve/

**Compass (Student Success)**
Tab in Blackboard

---

**TECHNICAL SUPPORT TAB IN BLACKBOARD**

---

**UNIVERSITY OF HARTFORD**

---

**Student Technical Support**
Student Blackboard Support
https://blackboard.uc.hartford.edu
(800) 866-3742 (Submit a Ticket)

General Technical Support (Email, Self-Service, etc.)
Office of Technology Services
(908) 766-4287 (email) | (844) 292-3213 (off-campus) | (800) 866-3742 @uc.hartford.edu

**Faculty Technical Support**
Faculty Blackboard Support
http://blackboard.uc.hartford.edu
Blackboard Instructions
Blackboard Orientation Schedule

General Technical Support (Email, Self-Service, etc.)
Office of Technology Services
(800) 766-4287 (email) | (844) 292-3213 (off-campus) | (800) 866-3742 @uc.hartford.edu

**Technical Alerts**
- 9/14/2017 - Blackboard Faculty and Student experiencing difficulty in viewing content, course files, etc. due to browser cache and cookies. All users should clear cache and try again. Mozilla Firefox and Chrome users should clear browser cache and cookies. Adobe users should clear Flash and Java cookies. Please see instructions below.
- 5/23/2017 - Problems using Blackboard or mobile devices? Check out these updates. [Contact the Mobile Support Team]
- 5/23/2017 - Students, your university email has migrated to Microsoft Office 365. Don't know your new email? Visit [https://portal.office.com](https://portal.office.com). If you have any issues, please contact the help desk at 860.768.4357 or helpdesk@hartford.edu.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLE OF CONTENTS</td>
<td>1</td>
</tr>
<tr>
<td>SEMINAR SERIES: PREPARING TO TEACH ONLINE</td>
<td>5</td>
</tr>
<tr>
<td>SEMINAR 1: PLANNING AND DEVELOPING AN ONLINE COURSE</td>
<td>7</td>
</tr>
<tr>
<td>Planning &amp; Developing an Online Course</td>
<td>9</td>
</tr>
<tr>
<td>Transforming a Course for Online Learning</td>
<td>12</td>
</tr>
<tr>
<td>Bloom’s Revised Taxonomy Planning Worksheet for One Topic</td>
<td>17</td>
</tr>
<tr>
<td>ABCD’s of Writing Objectives</td>
<td>18</td>
</tr>
<tr>
<td>Course Organization: Chunking</td>
<td>20</td>
</tr>
<tr>
<td>Learning Modules in Blackboard</td>
<td>23</td>
</tr>
<tr>
<td>Blackboard Exemplary Courses</td>
<td>24</td>
</tr>
<tr>
<td>Translating Face-to-Face into Online Courses</td>
<td>24</td>
</tr>
<tr>
<td>Content Planner Template</td>
<td>25</td>
</tr>
<tr>
<td>Course Organization: Alignment</td>
<td>26</td>
</tr>
<tr>
<td>Storyboarding</td>
<td>26</td>
</tr>
<tr>
<td>Best Practices in Designing Online Courses</td>
<td>28</td>
</tr>
<tr>
<td>Summary</td>
<td>35</td>
</tr>
<tr>
<td>Building a Learning Module in Blackboard</td>
<td>36</td>
</tr>
<tr>
<td>SEMINAR 2: CREATING ORGANIZED AND EFFECTIVE INSTRUCTION</td>
<td>41</td>
</tr>
<tr>
<td>Organizing your Course Menu</td>
<td>43</td>
</tr>
<tr>
<td>Activity: Adding, Renaming, and Deleting Menu Items</td>
<td>44</td>
</tr>
<tr>
<td>Visual Map of an Online Lesson: 5 Key Elements</td>
<td>47</td>
</tr>
<tr>
<td>Translating Face-to-Face to Online</td>
<td>48</td>
</tr>
<tr>
<td>Article: Translating On-Ground Courses into Effective Web-Based Learning</td>
<td>50</td>
</tr>
<tr>
<td>Engaging Content Resources</td>
<td>54</td>
</tr>
<tr>
<td>Legal Considerations</td>
<td>60</td>
</tr>
<tr>
<td>FERPA</td>
<td>60</td>
</tr>
<tr>
<td>Copyright &amp; Fair Use</td>
<td>60</td>
</tr>
<tr>
<td>Fair Use Checklist</td>
<td>61</td>
</tr>
</tbody>
</table>
Activity: Customizing your Course – Adding a Course Banner ................................................. 63
Introduction to Course Design Rubrics ................................................................................................. 64
Chico State’s Rubric for Online Instruction .............................................................................................. 65
Summary ............................................................................................................................................... 69

SEMINAR 3: BASIC TOOLS FOR ONLINE INSTRUCTION ................................................................. 71
Course Organization: Folders ..................................................................................................................... 73
Announcements ........................................................................................................................................ 74
Activity: Create an Announcement ........................................................................................................ 75
Blackboard Email ....................................................................................................................................... 76
Activity: Sending a Blackboard Email ..................................................................................................... 77
Blackboard Course Messages ................................................................................................................... 78
Blackboard Assignments .......................................................................................................................... 79
Integrated Assignment/Safe-Assign Tool ............................................................................................... 79
Activity: Creating an Assignment .......................................................................................................... 80
Activity: Submitting an Assignment ........................................................................................................ 82
Inline Grading with Annotations for Assignments ................................................................................... 87
Activity: Making Annotations on Uploaded Documents ......................................................................... 92
Using SafeAssign ....................................................................................................................................... 93
Activity: SafeAssign for Student Use – Draft Submission .................................................................... 95
Rosters and Managing Users in Blackboard Courses ........................................................................... 100
Activity: Add a Test Student to Your Course ....................................................................................... 102
Making your Blackboard Course Available ........................................................................................... 103

SEMINAR 4: FOSTERING INTERACTION AND COLLABORATION ................................................ 105
Interaction and Collaboration .................................................................................................................... 107
Using Groups as a Collaboration Tool ..................................................................................................... 110
Activity: Creating a Random Enroll Group ............................................................................................. 116
Article: Different Types of Group Work: Clearing up the Confusion .................................................... 119
Article: How to Design Effective Online Group Work Activities ......................................................... 121
Article: Five Steps to Improving Online Group Work Assignments ...................................................... 122
Article: Fostering Collaboration in the Online Classroom ....................................................................... 126
Discussion Boards .................................................................................................................................... 128
Activity: Creating a Discussion Forum ................................................................. 135
Activity: Replying to a Threaded Discussion ........................................................ 137
Article: The Art of Asking Questions ................................................................... 138
Distinction between Blogs, Wikis and Journals .................................................... 141
Activity: Blackboard Journals ................................................................................. 142
Activity: Blackboard Blogs ....................................................................................... 144
Activity: Blackboard Wikis ....................................................................................... 148
Blackboard Blogs, Wikis and Discussions Comparison Chart .............................. 151
SEMINAR 5: TESTS, GRADING, FEEDBACK & SUPPORT ..................................... 153
Ways to Evaluate Learning ...................................................................................... 155
Formative vs. Summative Assessments ................................................................. 156
Evaluating with Rubrics ......................................................................................... 157
Activity: Create a Blackboard Rubric ................................................................. 160
Blackboard Tests ...................................................................................................... 165
Activity: Create a Test in Blackboard Using the Test Manager ............................ 166
Blackboard Surveys ............................................................................................... 177
Blackboard’s Grade Center ..................................................................................... 179
SEMINAR 6: TIPS FROM EXPERIENCED ONLINE INSTRUCTORS ......................... 187
SEMINAR 7: ADDITIONAL TOOLS FOR TEACHING ONLINE (OPTIONAL) ............. 189
Creating Digital Content for Online Teaching and Learning ................................ 191
Capturing Your Computer Screen including Audio (Your Voice) ......................... 192
Helpful Tips for Audio Recording ......................................................................... 193
Narrating PowerPoint ............................................................................................ 194
Creating a Narrated PowerPoint ............................................................................ 195
Getting Started with Ensemble ............................................................................. 196
Using Ensemble Anthem Screen Capture ............................................................ 212
Explain Everything ............................................................................................... 224
SEMINAR 8: CLOSED CAPTIONING & ALT TAGS? LEARN UNIVERSAL DESIGN ... 229
What is Accessibility? ............................................................................................ 231
How does this translate to the (online) classroom? .............................................. 232
Blackboard Ally ..................................................................................................... 233
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Captioning of Videos</td>
<td>237</td>
</tr>
<tr>
<td>Ensemble Closed Captioning</td>
<td>237</td>
</tr>
<tr>
<td>Blackboard Accessibility Checklist</td>
<td>242</td>
</tr>
<tr>
<td>Creating Accessible Documents</td>
<td>245</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>247</td>
</tr>
</tbody>
</table>
SEMINAR SERIES:
PREPARING TO TEACH ONLINE

The Preparing to Teach Online Series was developed by the Faculty Center for Learning Development in cooperation with the Department of University Programs to train faculty in the development of online courses for delivery at the University of Hartford. Participants in this Seminar series are given access to two course shells in Blackboard, the University’s Learning Management System (LMS):

1. A Preparing to Teach Online course, in which they are a student participant and have access to all the materials for the course, including all those within this book; and
2. A Practice Shell, similar to a regular Blackboard academic course, in which participants are enrolled as the instructor with a set of sample students, and they can begin practicing and applying the skills learned within this seminar series.

References to these two Blackboard courses are periodically mentioned within this book.

After completing this course, faculty participants will be able to:

- Write learning objectives for an online course.
- Develop Learning Modules in Blackboard that align learning objectives, assignments, and assessments.
- Provide rich and engaging learning experiences in each module.
- Create a syllabus and assignment schedule for an online course.
- Draw, or 'storyboard', an organizing framework for an online course and modify the Blackboard course menu accordingly.
- Set up and use Blackboard and other tools necessary for online teaching and learning.
- Create and provide descriptions, instructions, rubrics, models, etc., for Discussion Board forums, SafeAssign, Assignments, Tests/Quizzes, Wikis, Blogs, Journals, Help and Tech Support, etc., so that students know how to be successful.
- Set up Grade Center to reflect all gradable work by modifying columns automatically created or creating them, and setting up a 'grade so far' column.

SEMINAR 1: PLANNING AND DESIGNING AN ONLINE COURSE
“What do I need to know to be an effective online instructor?” In this first seminar, we will answer this question, as well as demonstrate best practices for transforming face-to-face courses into online courses, show examples of exemplary online courses and syllabi, build a Blackboard Learning Module, and share useful resources that will help you as you design your online course.

SEMINAR 2: CREATING ORGANIZED & EFFECTIVE INSTRUCTION
In this hands-on seminar, we will use Blackboard to apply what was discussed in week one. Participants will learn different ways to structure and organize course content, as well as use Blackboard Learning Modules to create easy-to-follow online lessons. Finally, we’ll explore the many diverse sources of ready-made course content already available on the Internet.

SEMINAR 3: BASIC TOOLS FOR ONLINE INSTRUCTION
Just like any instruction, we need to be able to communicate with students, collect assignments, and facilitate group work such as case studies and projects. This seminar covers basic Blackboard tools that are essential for online instruction including Email, Announcements, the Assignment Tool, and Blackboard Groups.

SEMENAR 4: FOSTERING INTERACTION AND COLLABORATION
Distance education means there is “a distance between learner and teacher which is not merely geographic, but educational and psychological as well” (Moore, 1983). One hallmark of a well-designed online course is that it uses interaction to close up this distance, building in lots of different ways for students to work together and form their own online community. During this seminar, participants will learn how to foster and encourage interactivity using tools such as the Discussion Board, Blogs, Wikis, Journals, and other non-Blackboard tools.

SEMENAR 5: TESTS, GRADING, FEEDBACK, AND SUPPORT
Keep your students informed about their progress using Grade Center! Learn basic housekeeping and ways to set up Grade Center to reflect your grading scenario. We’ll also demonstrate and discuss ways you can offer feedback and build in student support.

SEMENAR 6: TIPS AND TRICKS FROM EXPERIENCED ONLINE INSTRUCTORS
One of the best ways to learn about teaching online is hearing about the experiences of instructors who have taught online in the past. University of Hartford instructors will share their online courses, tips, and tricks they’ve learned, as well as field questions from audience participants in this informal Q & A session.

SEMENAR 7: MUST HAVE TOOLS FOR TEACHING ONLINE
Just because you are not face-to-face with your online students, doesn’t mean you can’t ‘talk’ to them and with them. It’s not difficult to prepare audio and video clips so you can demonstrate worked problems, introduce a topic, summarize a complex issue, or even meet together once or twice. This session will offer a ‘survey course’ on tools that can help.

SEMENAR 8: CLOSED CAPTIONS & ALT TAGS? LEARN UNIVERSAL DESIGN!
In this hands-on session, participants will learn how to use automatic video captioning in Ensemble (new!), how to edit captions, how to create alternative text (alt tags) for images in Blackboard, as well as some tips and tricks for making documents uploaded to Blackboard accessible. FCLD will also demonstrate Ally, a new accessibility tool, which uses a wizard tool to assist faculty in automatically making documents accessible, as well as giving just-in-time tips to instructors. This session is open to all faculty, but will be especially helpful for online, flipping or hybrid instructors.
“What do I need to know to be an effective online instructor?” In this first seminar we will answer this question, as well as demonstrate best practices for transforming face-to-face courses into online courses, show examples of exemplary online courses and syllabi, build a Blackboard Learning Module, and share useful resources that will help you as you design your online course.

Learning Objectives

- Recognize a well-designed online course.
- Define a typical online learner.
- List the steps of a course redesign process.
- Define and develop learning objectives.
- Develop a Blackboard Course Module.

Seminar Contents

Planning & Developing an Online Course ...................................................................................... 9
Transforming a Course for Online Learning ................................................................................ 12
Bloom’s Revised Taxonomy Planning Worksheet for One Topic ............................................... 17
ABCD’s of Writing Objectives ..................................................................................................... 18
Course Organization: Chunking ................................................................................................... 20
Learning Modules in Blackboard .................................................................................................. 23
Blackboard Exemplary Courses .................................................................................................... 24
Translating Face-to-Face into Online Courses ............................................................................. 24
Content Planner Template ............................................................................................................. 25
Course Organization: Alignment ................................................................................................... 26
Storyboarding ................................................................................................................................ 26
Best Practices in Designing Online Courses ............................................................................... 28
Summary ....................................................................................................................................... 35

Seminar Activities

Building a Learning Module in Blackboard .................................................................................. 36
Additional Resources/Web Sources

Visit the Seminar 1 Learning Module in your Preparing to Teach Online course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
Planning & Developing an Online Course

This week we are going to share some common best practices and approaches for redesigning (some people called it translating) your course for online teaching and learning. We hope to point out some useful resources to help you, and share some tools that can help you design your own online course. The approach we are going to share on redesigning for online learning is based on standard best practices currently used by colleges and Universities around the country…they are tried and tested true.

Since 2003, Babson Survey Research Group began tracking online enrollment numbers. The number of students who take at least one online course has grown at a greater rate than that of the overall educational student body, which topped at 20% in 2003, 2005 and 2009. There is still growth in the online market, but at a much more moderate rate than before, due to the collapse of several private, for-profit institutions.

Below is a graph from the Babson Research Group with the 2003 to 2013 IPEDs data:

(Allan & Seaman, 2015).

Because much of this seminar series will be applied and hands on, we’ve provided each of you with a sample course to work in during the course of this seminar series. You might consider bringing your syllabus so you can apply what you learn using your own course.

To start, let’s think about the typical online student…

- Where is he?
- What is going on around her?
- Anyone else nearby?
- What does the room look like?
- What can you hear?
- What time is it?
What you should know about the typical online student…

More than 5.2 million students took at least one online class in 2015 (Allan & Seaman, 2015). Online students are largely adult professionals seeking degrees on a full or part-time basis to either advance in their current careers or change careers (Aslanian & Clinefelter, 2012).

They are adult learners. They are trying to get ahead in their careers. They want to share their experiences in their learning.

However, interestingly enough, a 2015 study shows that these numbers are now skewing towards “traditional” academic ages (18 to 24 years of age) enrolling in online programs. In 2012, 25% of online students were under 24, in 2015, this increased to 34%, showing a 9% growth rate (Clinefelter & Aslanian, 2015).

This is largely due to the growing availability of online programs at much lower cost to the students, and the economic need to enter the workforce and find convenient access to academic courses.

Here are some of the very important facts and pointers about online learning, many of which are covered in the following weeks. (Klonoski, 2004).

Traits of Successful Online Students

✓ Open about sharing life, work, and experiences.
✓ Able to communicate well through writing.
✓ Self-motivated and self-disciplined.
✓ Able to ‘speak up’ when problems arise.
✓ Have practically unlimited access to a computer and the Internet.
✓ Feel that quality education can happen online just as in the classroom.

Instructor Course Policies and Expectations – should communicated clearly from the start

✓ Email response rate
✓ Scheduled virtual office hours
✓ Language requirements for threaded discussion – provide samples
✓ Plagiarism
✓ Deadlines – date stamped by Blackboard
✓ Course access rate (log in requirement/expectation?)
Blackboard Tools Instructors Need to Know

✓ Email, Announcements, etc.
✓ Discussion Board
✓ Assignment/SafeAssign Plagiarism detection tool
✓ Groups
✓ Course Files
✓ Grade Center

Other Helpful Type of Tools

✓ Wikis, blogs, journals
✓ Screen capture, Chat, Web conferencing or some other ‘live’ tools
✓ Lecture Capture (to capture ‘lectureettes’, not full lectures)

Basic Elements to Include in an Online Course

✓ Clear, structured course roadmap
✓ Rich, engaging activities & resources
✓ Organizational consistency “Where do I find?”
✓ Opportunities to communicate, get feedback
✓ Copyright notices
✓ Technical support

Required Instructor Skills

✓ How to be explicit in written assignment descriptions
✓ How to write with a familiar tone that conveys both meaning and personality
✓ How to sequence online learning activities
✓ How to phrase and sequence questions that prompt meaningful discussion
✓ How to integrate formative assessment into pilot offerings
✓ How to use that assessment to make constructive revisions

Distance education is just another modality, like independent study, practice, portfolios, etc. You need to redesign your courses using the same content, like revising a publication. At the end, you will have a new cover for your course, but the content will be pretty much the same. Online learning requires a more conscious design approach because with distance education the learner is quite independent. They have to be able to navigate your course on their own most of the time. Keep in mind that technology is less adaptive than a human instructor. So instructors need to provide a structured approach. A structured approach will help the online student, but will also shorten development time. Matthews and Cotler call this course authorship (2004).
Transforming a Course for Online Learning

For starters, let’s consider how your course menu will be set up. In a face-to-face course, your course menu in Blackboard is standard, typically with minimal buttons, and only includes the information your students need outside the class. Most instructors use Blackboard so that they can email students, then maybe post documents, videos and assignments for students to complete outside the classroom environment. It is essentially a content repository for files.

An online class needs to be set up to deliver all instruction, so organizing your course structure is critical. Students need to have all the information they need to successfully complete the course at their fingertips. The course structure needs to be highly organized and guide them step-by-step in what they need to do. So, the menu is very different…

Blackboard Course Menu: Face-to-Face vs. Online Course

Face-to-Face Course

Online Course
Course Menu Organization for an Online Course

The Course Menu for an online course is organized, has a starting point, includes support links; all activity tools under one button; and all course lessons are carefully sequenced and in chronological order. Blackboard has a tool called a learning module that can help create these lessons. The menu above has been redesigned for online learning.
Where do we begin the process of transforming a course for online learning?

Steps of Course (re) Design Process

 ✓ Analyze your course - What do they need to know, do create, analyze, measure, calculate, list, describe…What do you want your students to know? What skills do you want them to be able to do? How will they have changed and grown by the end of your course?
 ✓ Use the verbs you used to describe student skills to build learning objectives.
 ✓ Find diverse and engaging activities that help them learn how to create, analyze, measure, etc. They should match your objectives you just wrote…
 ✓ Build in ways to see if they are getting it. Can they create, analyze, measure, calculate, list, etc?

Overview of Course Development

1. Analyze your course and write your overall objectives.
2. Chunk the course into large chunks of conceptually related content.
3. Divide these into smaller related chunks and these will become your lessons.
4. Continue with this process until content is broken down into topics that your students can get through in 20-25 minutes. Create a consistent, logical workflow for each topic - for example, an introduction, interaction, practice, and a demonstration of proficiency.
5. Storyboard all the lessons and other pieces of the course (e.g., technical support, etc).
7. Review the course using an online course design rubric.

All online course design starts with analysis – we need to accurate quantify what learning will happen so we can break it down into bite sizes. More than just broad goals, we need to break up the goals into discreet, measurable bits of learning. Here’s one way to do that…

1. First ask: What is the vision of the course? What dream do you have for your students? By the course end, what will they have gotten out of the course? These are our goals. I imagine most of you have taught your courses before, so you probably have a pretty good idea of what content you want to cover. You might want to think about whether it is doable in the allotted time you have, then cull some material that isn’t essential. Instead of aiming for content ‘coverage’, focus on the significant concepts, those concepts that are used frequently in your discipline, and also on the fundamental processes and thinking for your discipline (Monahan, 2015).
2. Break down your goals into the discreet knowledge skills each requires. These are our objectives and will be the core of our instructional path.
3. After we have identified our objectives, we will sequence the objectives in a logical way and find appropriate instructional strategies for each objective. Instructional strategies are not just activities, they include ways to motivate your students, engage
them…readings, cases, assessments, you name it. Plan for lots of diversity…You can’t really lecture online, so you have to find ways to translate lectures into other means of presenting content.

4. Build in lots of assessments…these help us keep students on track, let us know if they are getting it. Think in terms of a critical path…if I am not getting concept A and I am now being asked to look at concept B, which builds on A, I am already in trouble. If I can have some way to know the student didn’t get A, I can intervene – review, clarify, etc.

The toughest part is breaking down goals into objectives. Most of us have some kind of objectives in our courses. Usually, these are the broad brush strokes, so they are likely to be goals and not objectives. We find objectives by breaking down the goals. Objectives, unlike goals, are observable behaviors and skills. Objectives are a way to state the actual things our students will be able to do when a lesson is completed.

Writing objectives is not easy. They were first developed in the 1950’s, as part of a movement to analyze and then classify various aspects of learning. In 1956, Benjamin Bloom came up with a taxonomy for learning outcomes. He said that instruction was a mix of all kinds of knowledge skills, for example remembering, applying, evaluating. Further, that learning has simple and complex aspects. Learners start simple and progress to complex forms of learning, what we often refer to lower versus higher order thinking skills. We need to master lower order skills (e.g., memorize facts and concepts) before we are able to apply, evaluate, and problem solve using those facts and concepts. They build on each other in a logical progression. He developed a visual chart for this hierarchical organization of learning (Bloom, 1956).

David Krathwohl and Lorin Anderson updated it for the digital world – basically added descriptive verbs for key concepts.
This revised version of Bloom’s taxonomy is often referred to as the Digital Taxonomy.

Bloom’s charts help us to analyze the type of learning and find useful verbs for cognitive skills. When we design a course, we typically aim to include objectives from across the spectrum of these skills.

On the following page is a Bloom’s Taxonomy Planning Worksheet (Tarlington, 2003). As you develop your course, we encourage you to map out your own course objectives, resources, learning activities/strategies and ways to assess/have students show evidence of learning.
### Bloom’s Revised Taxonomy Planning Worksheet for One Topic

<table>
<thead>
<tr>
<th>Level of Learning</th>
<th>Action Verbs</th>
<th>Products</th>
<th>Objectives</th>
<th>Resources</th>
<th>Learning Activities / Strategies</th>
<th>Evidence of Learning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Lower-Order Thinking</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remembering</td>
<td>Recognising</td>
<td>Quiz</td>
<td>Definition</td>
<td>List</td>
<td>Quiz</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Listing</td>
<td></td>
<td>Fact</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Describing</td>
<td></td>
<td>Worksheet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Identifying</td>
<td></td>
<td>Test</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Retrieving</td>
<td></td>
<td>Label</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Naming</td>
<td></td>
<td>List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Locating</td>
<td></td>
<td>Workbook</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Finding</td>
<td></td>
<td>Reproduction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Understanding</td>
<td>Interpreting</td>
<td>Recitation</td>
<td>Summary</td>
<td>Collection</td>
<td>Essay</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exemplifying</td>
<td></td>
<td>Explanation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summarising</td>
<td></td>
<td>Show and Tell</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inference</td>
<td></td>
<td>Example</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Paraphrasing</td>
<td></td>
<td>Quiz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Classifying</td>
<td></td>
<td>List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Comparing</td>
<td></td>
<td>Label</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Explaining</td>
<td></td>
<td>Outlines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Analyzing</strong></td>
<td>Comparing</td>
<td>Survey</td>
<td>Database</td>
<td>Mobile</td>
<td>Abstract</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Organising</td>
<td></td>
<td>Report</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deconstructing</td>
<td></td>
<td>Graph</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Attributing</td>
<td></td>
<td>Spreadsheet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Outlining</td>
<td></td>
<td>Checklist</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Structuring</td>
<td></td>
<td>Chart</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Integrating</td>
<td></td>
<td>Outlines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Applying</strong></td>
<td>Implementing</td>
<td>Illustration</td>
<td>Simulation</td>
<td>Sculpture</td>
<td>Demonstration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Carrying out</td>
<td></td>
<td>Presentation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Executing</td>
<td></td>
<td>Interview</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Evaluating</strong></td>
<td>Checking</td>
<td>Debate</td>
<td>Panel</td>
<td>Report</td>
<td>Evaluation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hypothesising</td>
<td></td>
<td>Investigation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Critiquing</td>
<td></td>
<td>Verdict</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Experimenting</td>
<td></td>
<td>Conclusion</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Judging</td>
<td></td>
<td>Persuasive</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Testing</td>
<td></td>
<td>Speech</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Detecting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Monitoring</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Creating</strong></td>
<td>Designing</td>
<td>Film</td>
<td>Story</td>
<td>Project</td>
<td>Plan</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Constructing</td>
<td></td>
<td>New game</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Planning</td>
<td></td>
<td>Song</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Producing</td>
<td></td>
<td>Media product</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inventing</td>
<td></td>
<td>Advertisement</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Devising</td>
<td></td>
<td>Painting</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
ABCD’s of Writing Objectives

Writing objectives follows a kind of formula…ABCD is one way to help remember the formula.

- Audience – who will be doing this?
- Behavior – what will they be doing? Aim for one action verb per objective…so they aren’t goals. Not just activities, but outcomes.
- Condition – under what conditions?
- Degree – to what degree? Generally, the degree is about the speed and/or the accuracy. What are the criteria for being proficient? Of course, most instructors aren’t quite so formal. Typically they stick to audience and behavior.

Here are two examples of learning objectives written in the ABCD form.

**Example 1:**

Given a full stack of playing cards, the student will be able to distinguish the suit of a card within a minute, 80% of the time.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Audience</th>
<th>Behavior</th>
<th>Degree</th>
</tr>
</thead>
<tbody>
<tr>
<td>Given a full stack of playing cards</td>
<td>the student</td>
<td>will be able to distinguish the suit of a card</td>
<td>within a minute, 80% of the time.</td>
</tr>
</tbody>
</table>

**Example 2:**

Using a computer and a connection to the Internet, the student will be able to accurately identify three primary source articles from credible sources within a period of fifteen minutes.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Audience</th>
<th>Behavior</th>
<th>Degree</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a computer and a connection to the Internet</td>
<td>the student</td>
<td>will be able to accurately identify three primary source articles from credible sources</td>
<td>within a period of fifteen minutes.</td>
</tr>
</tbody>
</table>

But these are very, very formally written. Most folks omit the condition and degree. Here are those same examples written less formally.

1. Students will be able to distinguish the suit of a playing card.
2. Students will be able to identify primary course articles.
Penn State has some very helpful online resources for writing objectives.


If you are having trouble developing specific learning objectives, you might try having a conversation with someone who is unfamiliar with your discipline. Have them play a little game, called, “So What, Who Cares?” To begin, state one of the things you plan to teach in your course. Your partner responds “Why?” You answer, and then your partner responds “So What?” Answer him or her, and then your partner responds “Who Cares?” This exercise is often used in business to define relevance, but has been widely adopted into other areas, including education. A shorter version uses only the “So What?” and “Who Cares?” questions.
Course Organization: Chunking

Now that we have our objectives, we need to organize them into lessons.

People can’t easily recall and retrieve large amounts of ideas/facts/concepts. So, we break up our learning into smaller chunks. A student should be able to get through a chunk in about 20 minutes.

Start with large chunks of conceptually related content, and then divide these into smaller related chunks. Continue with this process until content is broken down into chunks that contain 5-9 or so ideas/facts/concepts, less if the content is more complex.

One recommendation for a face-to-face class is 7 chunks per lecture period (University of Southern Florida COPH ETA, 2011). For an online course, it depends on who you ask, and also depends on the complexity of the chunk. Our working memory doesn’t hold all that much, so chunks are better for learning. Chunking is also a better fit for online students who are likely juggling family, work, and classes. They are very easily distracted, so chunking helps keep them focused (University of Southern Florida COPH ETA, 2011) and fits into their busy schedules.

It might help if you think of it in terms of how a text book is written. Typically, text books have chapters, and then the chapters are broken down into units and lessons. We are doing the same thing, but in an online course. We’re trying to figure out a logical progression for our modules, lessons, and topics (Malamed, 2009).

We recommend that you develop chunks that a student can get through in say 20-25 minutes. Then, scale up. 3 chunks = lesson, 3 lessons = unit. Each module should segue one to the other, and be interrelated in some form. Since your course template is set up by weeks, you will need to figure out what to include in each week.

“Each lesson should (Netnet, 2002):
• Immediately capture the student’s attention
• Explain its own relevance by answering the student’s question, "What's in it for me?"
• Present specific and measurable learning objectives
• Present engaging content through design and media
• Offer the student an opportunity for practice and recall
• Include a final post-test or other device to indicate mastery “
What’s in a Chunk?

Use whatever works for you. Here are two examples of simple chunking organizers. These organizers can help you to plan your weekly content in your online course.

<table>
<thead>
<tr>
<th>Learning Objective</th>
<th>Instructional Activity</th>
<th>Assessment Activity</th>
<th>Resources Required</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Learning Objective</th>
<th>Introduction</th>
<th>Presentation of Content</th>
<th>Interactivity</th>
<th>Practice</th>
<th>Demonstration of Proficiency</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

First, map out what you plan to do. Here’s a quick overview of an online lesson. It includes an Introduction, practice/application, and then demonstration that they mastered it. This is the
sequence we apply to our chunks and using this consistently throughout the course will help the online learner.

For each Learning Objective provide:

- Introduction
- Presentation of Content
- Activity/Interactivity/Practice
- Demonstration of Proficiency

Try whenever possible to build in some form of interaction…this closes up the distance for learners and helps them build a sense of group, rather than feeling isolated. It also allows learners to share their own expertise with the class. Adult learners like interaction and they want to share.

So, these pieces – interaction, practice, etc. are instructional strategies that help move us towards reaching our objectives. While you probably use these already in face-to-face instruction, you may not do so consciously…However, when we design an online course, we need to consciously design for all the parts that make up our chunk. Remember, you aren’t there with them to guide them. Each piece has to be very clearly written and/or designed. How will you get their attention? Introduce the materials? How will you know they ‘got it’? Each one of these questions must be translated into some kind of student activity.
Learning Modules in Blackboard

How do we put all this into Blackboard? What tool will help us develop our lessons in a cohesive fashion? Blackboard’s Learning Modules developed for just this purpose. A learning module contains a self-contained lesson, typically organized, as shown below.

Simple Learning Module in Blackboard

See page 36 for related activity: Building a Learning Module in Blackboard
Blackboard Exemplary Courses

As you develop your lessons, you might want to look at some exemplary courses. Here are website featuring some.

Embry-Riddle Marketing Course
http://www.screencast.com/t/LFQ5hiwqp

BU Art Education Course
http://www.bu.edu/av/disted/html_swf_previews/MET/ODE/ODE_bb_11_su2_jsimpson/

Environmental Systems – University of Denver
http://flashmedia2.du.edu/relay/BbECP_KeablesM_-_Flash_(Large)_-20110516_02.32.11PM.html

Blackboard Exemplary Course Program Winners (2013)
https://www.youtube.com/playlist?list=PLontYaReEU1voZsmm5gDVNT6imGKnLWTp

Translating Face-to-Face into Online Courses

But how do I? First time online instructors often struggle with translating their face-to-face activities into online ones. Here’s a chart that shows some basic activities and how you do them in an online course.

<table>
<thead>
<tr>
<th>How you do this face-to-face</th>
<th>How we do this online</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation of facts/concepts/principles</td>
<td>YouTube or other premade videos, readings, podcasts, recording “lecturettes”</td>
</tr>
<tr>
<td>Discussion</td>
<td>Discussion Board</td>
</tr>
<tr>
<td>Quizzes</td>
<td>Quizzes (but not many)</td>
</tr>
<tr>
<td>Practice</td>
<td>Publisher’s digital exercises like flashcards</td>
</tr>
<tr>
<td>Reflection</td>
<td>Journals, written short essays</td>
</tr>
<tr>
<td>Group work</td>
<td>Collaborative tools like Blackboard groups, web conferencing, wikis</td>
</tr>
</tbody>
</table>

They are very similar, but you may have to learn some new Blackboard tools. The main difference is that your lesson-size is much, much smaller, is more interactive (less lecture) and the discussion board is typically used to assess learning, rather than testing (because you can’t proctor an online test easily).
One helpful way to organize all these activities and sequence them by using some sort of visual representation, a chart. A chart can be the template for your content and help you design the overall structure of the course content for students. Look carefully at it to see if all the parts fit together. This may help you to identify if all the parts interrelate in a logical fashion (Quality Matters Standards, 2011).

The following is an example of a course planner template.

### Spanish 101

<table>
<thead>
<tr>
<th>Weeks/Outcomes</th>
<th>Readings</th>
<th>Assignments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Week 1</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| **Learning Outcomes:** | • Recognize and reproduce sounds of the Spanish alphabet.  
  • Identify and practice the difference between formal and informal greetings.  
  • Perform basic introductions: greet someone, introduce someone, say goodbye | • Course Documents, Course Information, Syllabus  
  • View Fotonovela  
  • Listen to Pronunciación  
  • Read the Cultura section about Greetings in the Hispanic World.  
  • View video section of Cultura | • Online Orientation Quiz  
  • Send email to Professor  
  • Post Introduction to the Discussion Board  
  • Complete Assigned activities on *En Línea*, Pronunciación, Contextos and Estructura 1.1 sections. |
| **Week 2**       |                                                                          |                                                       |
| **Learning Outcomes:** | • Recognize and practice with numbers 0-30  
  • Recite your phone number in Spanish  
  • Conjugate the verb ser and apply to describe self: personality and physical traits | • Chapter 1, Sections: Adelante, Estructura 1.3 and 1.3. | • Post reply to week 2 prompt on the Discussion Board  
  • Complete Assigned activities on *En Línea*, Adelante and Estructura 1.2 and 1.3 sections. |
| **Week 3**       |                                                                          |                                                       |
| **Learning Outcomes:** | • Label clocks and describe how to tell time in Spanish  
  • Demonstrate asking “at what time” an event takes place  
  • Review and memorize vocabulary from Lección 1 | • Course Documents, Course Information, Syllabus  
  • Chapter 1, Sections: Estructura 1.4 and Recapitulación. | • Post reply to week 3 prompt on the Discussion Board  
  • Complete Assigned activities on *En Línea*, Estructura 1.4 and Recapitulación sections.  
  • Complete Prueba 1 (Quiz) |
Course Organization: Alignment

In online learning, it is critical that we pay attention to alignment. Alignment is among three main course components ensures an internally consistent structure. Essentially, these three parts need to be flow one to the other. A visual map or chart can help because you can see the flow from one to the other…nice way to catch any misalignment.

According to the Eberly Center for Teaching Excellence & Educational Innovation at Carnegie Mellon, alignment is when:

- OBJECTIVES articulate the knowledge and skills you want students to acquire by the end of the course
- ASSESSMENTS allow the instructor to check the degree to which the students are meeting the learning objectives
- INSTRUCTIONAL STRATEGIES are chosen to foster student learning towards meeting the objectives

(Carnegie Mellon, 2012)

Storyboarding

But what about all the other pieces you need to include besides content? After all, your course content is just one piece of many that you will need to include in your online course. At the beginning, we listed other items such as policies, technical requirements, and where to find help. One useful design tool is storyboarding, which is used ubiquitously in TV, for designing websites, and many other projects. Effectively, it is a visual outline of your end product, a sketch or mockup of all the parts and pieces. You can do this any way you want. Storyboards or Roadmaps - whichever visual tool you use - save you from finding out you are missing something and having to start all over again, or redo large parts. This prevents costly mistakes – either monetarily or time-wise. They are also great for seeing the relationships between parts. It does not matter how simple or complex it is, it needs to work for you and help you identify gaps.
SPA 101 Course Roadmap

Syllabus
- Course Objectives
  - Textbook/Online Course Code
  - Technical Requirements
  - Course Schedule

Instructor Information
- Contact Information
  - Office Hours
  - Biography

Course Information
- Course Objectives
- Course Expectations
- Technical Requirements
- Rubrics

Course Documents
- Study Guides
- Accent Guides
- Verb Charts

Discussions
- Q&A Board
- Water Cooler
- Introductions
  - Week 1
  - Week 2
  - Week 3
  - Week 4
  - Week 5
  - Week 6
  - Week 7
  - Week 8
  - Week 9

Course Content

Lección 1
Week 1
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments

Week 2
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments

Week 3
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments
- Prueba (Quiz) 1

Lección 2
Week 4
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments

Week 5
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments

Week 6
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments
- Prueba (Quiz) 2

Lección 3
Week 7
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments

Week 8
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments

Week 9
- Overview/Intro
- Weekly Objectives
- Readings/Videos
- Lectures/PPTs
- Discussions
- Assignments
- Prueba (Quiz) 3
Best Practices in Designing Online Courses

The following chart is a checklist created by Las Positas College. It was developed to help faculty “design online courses that are instructionally and pedagogically sound. The best practices are a synthesis of strategies, activities, design techniques, organizational tips, etc., that have been successful in higher education.”

Retrieved from http://lpc1.clpeccd.cc.ca.us/lpc/blackboard/best_practices/ - Used with permission, Creative Commons.

I. Course Introduction
II. Course Organization and Design
III. Instructional Design

I. Course Introduction

<table>
<thead>
<tr>
<th>Standard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Detail the general course content and student responsibilities, among other items, in your syllabus.</td>
<td>Include items that address/explain the following:</td>
</tr>
<tr>
<td></td>
<td>• Course description</td>
</tr>
<tr>
<td></td>
<td>• Faculty contact information. Include a statement on how long students should expect to get a reply from you.</td>
</tr>
<tr>
<td></td>
<td>• Textbooks</td>
</tr>
<tr>
<td></td>
<td>• Learning outcomes that are measurable</td>
</tr>
<tr>
<td></td>
<td>• Instructor-Student communication. Describe the frequency and timeliness with which students should expect contact initiated by you and feedback/replies given by you. (For reference, view LPC's Effective Contact Guidelines)</td>
</tr>
<tr>
<td></td>
<td>• How the course is organized and how it works</td>
</tr>
<tr>
<td></td>
<td>• Grading policy</td>
</tr>
<tr>
<td></td>
<td>• Exams</td>
</tr>
<tr>
<td></td>
<td>• Term papers/projects</td>
</tr>
<tr>
<td></td>
<td>• Course schedule</td>
</tr>
<tr>
<td></td>
<td>• Research information and links</td>
</tr>
<tr>
<td></td>
<td>• Netiquette</td>
</tr>
<tr>
<td></td>
<td>• Plagiarism</td>
</tr>
<tr>
<td></td>
<td>• How to succeed in an online course</td>
</tr>
<tr>
<td></td>
<td>• The college withdrawal policy</td>
</tr>
<tr>
<td></td>
<td>• Instructor's Withdrawal Options for Distance Education courses</td>
</tr>
<tr>
<td></td>
<td>• Technical requirements for the course</td>
</tr>
<tr>
<td></td>
<td>• Downloads/plug-ins</td>
</tr>
</tbody>
</table>

Preparing to Teach Online | Faculty Center for Learning Development 28
### 2. Greet your students with a welcome message, and tell them how to get started in the course.

This welcome message should be the first thing students see when they initially log into the course. Keep the tone of this message warm and inviting.

**View example welcome message**

### 3. Introduce yourself to the class, and have students introduce themselves to you and to one another in order to begin building a “community of learners”.

The instructor might ask students to answer specific questions, such as their year in college, major, what high school they attended, city they live in, hobbies, future goals, family, pets, job, and anything else they are willing to share.

**View example discussion assignment**

If you want to create more community, you can incorporate a blog. **View example blog assignment**

### 4. Acquaint students with the course software.

Instructors can have students:

- Send an email in which students explain why they enrolled in the course, what they already know about the content of the course, and what they hope to learn. **View example assignment**
- Introduce themselves in the discussion board. **View example assignment**
- Send an email that details their computer-related skills and experience. **View example assignment**
- Post a message in the appropriate group discussion board with a link to a web site they think will benefit students in the class. **View example assignment**
- Post to a blog. **View example assignment**
- Complete a quiz based on the syllabus. **View example quiz**

### Technical support

- Help for students with disabilities
- Copyright information for students
- Others who might have access to the course, including invited guests, technical support people, and course evaluators

**View syllabus template**
5. Ensure that students understand what is required for them to succeed in an online course.

Include an activity that teaches students:
- Successful study strategies
- How to communicate online
- How to behave ethically online
- How to prepare technologically for the course
- Where to access college resources

An interactive tutorial called Succeeding in an Online Course is on the LPC Online Learning web site. View tutorial

Quizzes for each chapter have been created and can be inputted into online courses. For more information about these quizzes, and/or if you want to use one or more of them, contact Scott Vigallon.

II. Course Organization and Design

<table>
<thead>
<tr>
<th>Standard</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1. Structure your course in a well-organized manner, and make it easy to navigate. | Students should be able to intuitively get from place to place within the course.  
- Content should be divided into learning units, appropriately labeled, and presented in a logical manner. Instructors typically divide these learning units into modules, chapters, etc. View example course structure View example module structure |
| 2. Ensure that your links are active and up-to-date. | Instructors should check all links prior to the course and prior to each segment of the course. Inactive links should be fixed or removed. Links with outdated information should be updated. |
| 3. Create web pages that are consistent and reasonably attractive. | If you are creating web pages and need design help, consult the college’s instructional technology staff. View good example View bad example The course’s main navigation menu should not be cluttered with unnecessary items. |
4. Design your course so that all aspects of it are accessible to students with disabilities.  
If you need assistance, consult the college’s instructional technology staff.  
View LPC’s Web Accessibility web site.

5. Include one discussion board forum where students can ask and answer class-related questions and one where they can ask and answer non-class-related questions. Also, post frequently-asked questions in your course.  
Possibilities for labeling the two discussion boards are "Student-to-Student questions" and "Virtual Cafe". To signify that posts to these boards will not be graded, you can included the word "Ungraded" in front of each.  
View example.

6. Design your course so that pages can be downloaded within a reasonable period of time even without a high-speed Internet connection.  
Do not upload extremely large files to your course. Image file size should be under 50k. The JPEG format should be used for photos; GIF should be used for all other graphics. Audio and video can be streamed, instead of downloaded. Design for users with a 56k modem.  
If you need assistance with any of the above, consult the college’s instructional technology staff.  
Use a connection speed-download speed calculator.

---

### III. Instructional Design

<table>
<thead>
<tr>
<th>Standard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduce learning units with an overview of the topic.</td>
<td>This can simply be a paragraph that briefly explains the topic to be studied. View example</td>
</tr>
<tr>
<td>2. Connect what the students already know about the topic to what they are going to learn.</td>
<td>This can include questions or activities to make this connection. Recalling prior knowledge should help provide a context for the students and get them excited about the learning tasks ahead of them. View example</td>
</tr>
<tr>
<td>3. Write and post objectives for each learning unit.</td>
<td>Your objectives should emanate from your course’s learning outcomes and detail the specific tasks that students will be able to complete. View example</td>
</tr>
<tr>
<td>4. Align your learning activities to your objectives and outcomes.</td>
<td>Use your objectives and outcomes to determine your learning activities. Be consistent. For example, if one of your objectives states that students will discuss a topic, make sure the activity is a class discussion in the discussion board. View example</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>5. Align your assessments to your objectives and outcomes.</td>
<td>Use your objectives and outcomes to determine your assessments. Be consistent. For example, if one of your objectives states that students will evaluate a topic, make sure the assessment has a corresponding essay question that asks students to evaluate. View example</td>
</tr>
<tr>
<td>6. Structure your learning activities to foster student-instructor, student-student, and student-content interactions.</td>
<td>Strive to design a student-centered classroom where active learning and engaging activities are present. For examples of how to do this, click Learning Activities that Foster Interaction (PDF).</td>
</tr>
<tr>
<td>7. Clearly write your content and lessons.</td>
<td>Ambiguity will result in confused students and a lot of emails to you. If your instructions aren't clear, the students don't have you in front of them to ask clarifying questions. The clearer you write, the less confusion for your students. Include formatting techniques such as bolds, bullets, and white space, and make sure your text contains no spelling or grammar errors. View example 1 (PDF) View example 2 (PDF) View example 3 (PDF)</td>
</tr>
<tr>
<td>8. Post model submission assignments.</td>
<td>Model assignments are examples that your students can view in order to better understand the differences between quality and non-quality work. To use model assignments from former students, get their permission in writing, and remove their names from the assignments prior to posting. If you can’t get these from former students, consider creating them yourself. View example</td>
</tr>
<tr>
<td>9. Post rubrics for grading.</td>
<td>Rubrics are criteria for grading non-objective tests and assignments. They let students know exactly how you will grade them, and they take the subjectivity out of your grading. You can develop rubrics for individual assignments, or in the case of discussion board postings, you can develop a generic rubric that applies to all posting assignments. View example</td>
</tr>
<tr>
<td>10. Ensure that the breadth of your content covers all of the content in the course outline of record.</td>
<td>If your course doesn’t cover everything in the course outline, your students won’t learn everything they are supposed to learn. This especially has a negative impact on students who transfer to four-year institutions and are expected to know specific content. View course outlines</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>11. “Chunk” the information that you post for students.</td>
<td>Written material posted to students, particularly lectures, should be divided into short, readable (“chunked”) sections with links to subsequent pages, if necessary. PowerPoint presentations— with or without audio narration—should be chunked and 5-10 minutes in duration. Podcast lectures should be chunked and the same length. View example lecture View example presentation Listen to example podcast</td>
</tr>
<tr>
<td>12. Ensure that your content meets the needs of students with different learning styles.</td>
<td>Multimedia works best to meet the needs of audio, visual, and kinesthetic learners. Audio narrations, podcasts, videos, pictures, charts and graphs, and simulations all enhance learning. View text with audio narration View presentation with audio narration View example simulation View example concept map</td>
</tr>
<tr>
<td>13. Extend your students’ learning with optional web resources.</td>
<td>For those students who get excited about a topic and want to learn more on their own, provide links to web sites that you think will be helpful. Conversely, you can also provide links that will help remediate students who struggled through a topic.</td>
</tr>
<tr>
<td>14. When designing lengthy quizzes or exams, design them so students see one question at a time.</td>
<td>This way, each answer gets saved once the student goes to the next question, which is helpful in case the student’s browser times out. If you decide that you really want all of the questions presented on the same screen, consider dividing the lengthy exam in multiple shorter exams, and tell students to save answers after each question.</td>
</tr>
<tr>
<td>15. Gather feedback from your students on the course so you can improve it for the future.</td>
<td>Gathering feedback is not done as an official evaluation of the course; it is merely an way to improve the course. Surveys can be used to gather the feedback, and they can be used at any point during, and/or toward the end of, the course. View example survey (PDF)</td>
</tr>
<tr>
<td>16. Refrain from using copyrighted materials illegally.</td>
<td>If you are unsure as to whether you are violating copyright law, seek permission to use the copyrighted material. For more information on the U.S. Copyright Law, visit the U.S. Copyright Office’s web site.</td>
</tr>
</tbody>
</table>
Sources for information on best practices (Las Positas):

Guidelines for Good Practice: Technology Mediated Instruction, The Academic Senate for California Community Colleges

Distance Learning Manual, Accrediting Commission for Community and Junior Colleges

Rubric for Online Instruction, CSU Chico

Quality Matters Peer Course Review Rubric, Maryland Online

Best Practices in Distance Learning Programming – Award Criteria, U.S. Distance Learning Association

Selection Criteria for Best Online Teaching Website, California Virtual Campus

ADEC Guiding Principles for Distance Teaching and Learning, The American Distance Education Consortium

Quality on the Line, National Education Association and Blackboard, Inc.
Summary

We covered the big picture of course design: breaking down your content into outcomes and then creating manageable chunks that include some way to help move the students toward these outcomes. But we really only touched on what kinds of online activities we can use for content presentation, practice, interaction, and assessment. Your course needs to be more than just read, then take a quiz, read, then take a quiz. You need to aim for a rich and diverse variety of activities so you keep your student interested and engaged. If you use in-class discussions a lot, how can we craft one online? What other strategies can be used that will work well online? How do we organize our course in our Blackboard template? These are the things we will cover in Seminar Two.
Building a Learning Module in Blackboard

**Step One: Build the Learning Module shell**
Building a Learning Module in Blackboard involves two parts: first, you create a shell (kind of like a folder) for your Learning Module, which includes a name and description. Next, you click open the Learning Module and begin adding content. First, we will go through a few simple steps and set up our Learning Module:

1. Click on the Course Documents button on your Course Menu.
2. From the Build Content menu at the top of the screen, select Learning Module.
3. For the name, type: “Module 1: Online Learning and Fair Use” (sans quotes). You can also add a description if you like.
4. Set Permit Users to View This Content, select Yes. You do not need to set dates for when the material will be made available.
5. Set Track Number of Views to Yes.
6. Do not set Date and Time Restrictions.
7. Click Submit.

**Step Two: Add Learning Objectives**
The content of your Content Folders will vary according to the courses you teach, but keep in mind that a Content Folder should consist of a small unit of content. A Content Folder should focus on a single concept rather or a ‘chapter’ of content.

To start adding content to your Content Folder, click on the name of the folder and open it. You should see menus for adding content at the top of the folder.
**Lesson Objectives:** First, we will use a simple text box to post the lesson objectives

1. Select **Build Content → Item.** We will use a simple text box to post the lesson objectives.

![Image of Build Content options]

2. Fill in the Name and then type the objectives in the text box as shown below.

   By the end of this module, you will be able to:
   - Describe the four factors in the ‘Four Factor Test’ in Fair Use guidelines.
   - List three ways faculty can apply the Teach Act in a Blackboard course site.
   - Identify one or two credible online resources you can use to find out more about Fair Use.

![Image of text box with objectives]

**What the Objectives look like inside an Item**

3. Next, be sure you permit users to view the content. **Set Track Number of Views to Yes.**
4. Click **Submit.**
Step Three: Add a YouTube Video

Next, will add a video explaining the basics of Fair Use. Make sure you preview the video and ensure that it has Closed Captioning enabled (CC symbol) in the lower right. For accessibility reasons, we want to ensure that all videos posted in Blackboard have closed captioning enabled.

1. Go to Build Content ➔ YouTube Video at the top of the screen.
2. In the search bar that appears, type “Fair Use” (sans quotes). Set the next box to “Exact Phrase”.
3. Choose a video in the search results (Preview it to make sure it has the CC symbol), then click Select.
4. A form opens with a text box. Type a short description of the video to direct the learning you wish to take place. Leave the other options as they are for now. You may wish to change some when you actually build your own Content Folder.
5. Click Submit.

Step Four: Add a Web Link

1. Go to the website you want to add a link to and copy the URL using Control and C keys.
2. Return to Blackboard and your course content area.
3. Go to Build Content ➔ Web Link.
4. Enter a Name for the video and paste in the URL using Control V keys. Add a description.
5. Make sure Open in New Window and Permit Users to View this Content are set to Yes.
6. Click Submit.

Step Five: Add a File

1. Go to Build Content ➔ File at the top of the screen.
2. Enter a Name for the file.
3. Click the Browse My Computer or alternatively Browse Course (if you’ve already uploaded the file previously).
4. Find the file you want to attach and click on it, then click Open.
5. Select Yes under Open in New Window.
6. Click Submit.
Lesson Assessment: To check student learning, students will discuss what they’ve learned in the discussion board.

Step Six: Add an Item with Additional Directions
1. Click Create Item and then title it “Now Discuss.”
2. In the body of content editor, type up the following directions:

   Now go out to the Discussion Board for Week 1 and respond to the discussion prompt on Copyright by Wednesday at 11:59 p.m. Also, you must respond to at least two of your peers by Friday at 11:59 p.m.

3. Click Submit.
SEMINAR 2:
CREATING ORGANIZED AND EFFECTIVE INSTRUCTION

In this hands-on seminar, we will use Blackboard to apply what was discussed in week one. Participants will learn different ways to structure and organize course content, as well use Blackboard Learning Modules to create easy-to-follow online lessons. Finally, we’ll explore the many diverse sources of ready-made course content readily available on the Internet.

Learning Objectives

- List three Federal Acts applicable in online courses.
- Structure all the pieces of an online course.
- List five essential elements of an effective online course.
- Explore online sources for rich and engaging content.
- Customize the look of your Blackboard course

Seminar Contents

Organizing your Course Menu ................................................................. 43
Activity: Adding, Renaming, and Deleting Menu Items ........................................ 44
Visual Map of an Online Lesson: 5 Key Elements ............................................. 47
Translating Face-to-Face to Online ............................................................... 48
Article: Translating On-Ground Courses into Effective Web-Based Learning ....... 50
Engaging Content Resources ....................................................................... 54
Legal Considerations ................................................................................. 60
FERPA ........................................................................................................ 60
Copyright & Fair Use .............................................................................. 60
Fair Use Checklist .................................................................................. 61
Activity: Customizing your Course – Adding a Course Banner ....................... 63
Introduction to Course Design Rubrics ..................................................... 64
Chico State’s Rubric for Online Instruction .............................................. 65
Summary ............................................................................................... 69
**Seminar Activities**
Activity: Adding, Renaming, and Deleting Menu Items .............................................................. 44
Activity: Customizing your Course – Adding a Course Banner................................................... 63

**Additional Resources/Web Sources**
Visit the Seminar 2 Learning Module in your *Preparing to Teach Online* course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
Organizing your Course Menu

Distance learning courses are likely to fail if they are delivered as if they were traditional courses. If you already use Blackboard for your courses, it probably looks something along these lines (shown on the left). This is our basic template for a face-to-face Blackboard course. It is basically a place to put things; a ‘content dump’ if you will, but it doesn’t teach by itself. If we were to translate the basic Blackboard course into our physical classrooms, it would be the equivalent of walking into your classroom, dumping textbooks and articles on a table, then leaving. For a distance education course, we need all the myriad things we do in and out of the classroom to be included – the Instructor presence as a Socratic guide through the key concepts and principles, the small group activities, the encouraging, the over-the-shoulder check-in, etc. - you name it. On the right is the basic template for an online course. Notice the difference between the two.

Blackboard Course Menu: Face-to-Face vs. Online Course

Go into your own Practice Course and practice adding, removing and renaming buttons on the Content bar.
Activity: Adding, Renaming, and Deleting Menu Items

To add or edit buttons in the main Course Menu:

1. Click the “+” icon in the upper left of the Course Menu.
2. Choose the type of menu item needed.
3. Name the button, make it available to users and click Submit.

Button Choices

**Content Area** is a place to upload files or create content, such as Course Documents or Course Information.

**Module Pages** are customizable “alert” areas that allow students to see grades, alerts, and tasks in a dashboard layout.

**Blank Pages** adds a single page of content as a clickable link in your Course Menu. Only text, images and files can be added to Blank Pages.

**Tool Link** links to tools, including class blogs, wikis, etc.

**Web Link** pages make it easy to add links to Internet Web sites.

**Course Link** creates a link to a specific area in your course. If you post your syllabus under “Course Information,” you can link to it from your Course Menu by adding a Course Link.

**Subheaders and Dividers** allow you to add headings & divider lines.

1. Click on the plus icon and select divider (last option in list). The divider will appear at the bottom of your course menu.
2. Left click the up/down arrows that appear to the left of the divider and drag it up the course menu until it is just below the Announcements button.
3. Add a Content Area (hidden under Add Menu Item in picture above) and label it *Start Here*.
4. Move this new button up until it is just above the divider.
5. Add a second content area and name it *Modules*.
6. Move this new button up until it is just below the *Course Information* button.
7. Remove the button called *Course Documents* – we will use Modules instead.
8. Finally, add another divider and move it up until it is right above the Assignments button.

**Steps for Adding a Button**

1. Click the “+” icon upper left, choose your content area.
2. Fill in the name of the link.
3. Check available to users.
4. Click *Submit*. 
Creating a button for uploading files (e.g. Course Documents, Course Information)

Creating a button that opens a specific tool.

Don’t forget to make it available so students can see it.
Steps for renaming a link
1. Hover over the link in the menu bar, click the down arrow, then click Rename Link.
2. Rename the link then press enter or the green check mark.

To Reorder Links on the Course menu
1. Hover over the link, a four-way arrow will appear, click and hold on it and drag it up or down and release the mouse button.
Visual Map of an Online Lesson: 5 Key Elements

Remember our Visual Map of an online lesson from Seminar 1? Let’s take a look at it in more detail…

For each Learning Objective provide:

- Introduction
- Presentation of Content
- Activity/Practice
- Demonstration of Proficiency
- And above all… INTERACTION

Interaction is a critical piece, especially for online adult learners. Remember, we have to build in all the myriad of interactions that happen in our course. Don’t we stop and ask questions part way through our lecture; check-in to see if they are getting it? Read their body language? How do you keep them engaged, motivated?

Remember adult learners want to share and want to teach one another. You must build in interaction. Watching a video and then taking a quiz alone does not provide all this.

Also, remember that our attention spans are very limited. Most of us tend to tune in and out, not stay focused for long durations (Bunce, 2010). That is just how we are built.

So let’s take a look at the kinds of activities we can use in an online course.
Translating Face-to-Face to Online

It might be helpful to evaluate what we’re doing in our face-to-face courses. You’re probably still wondering exactly how to go from your live persona in the classroom to the online persona.

Let’s think about what we do...
What kind of learning activities go into your typical face-to-face class? What kind of strategies do you employ? What types of activities do you use?

How do we translate our face-to-face activities into online ones? There is a surfeit of freely available materials out on the Internet or available from publishers.
<table>
<thead>
<tr>
<th>Face-to-F Elements</th>
<th>What they might look like online…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation of facts/concepts/Principles</td>
<td>Videos, readings, podcasts, recorded ‘lecturettes’ and other multi-media created by you or found online.</td>
</tr>
<tr>
<td>Discussion</td>
<td>Discussion Board</td>
</tr>
<tr>
<td>Practice</td>
<td>Publisher’s digital exercises like flashcards, low stakes quizzes, problem sets, writing assignments, case studies</td>
</tr>
<tr>
<td>Reflection</td>
<td>Journals, short essays</td>
</tr>
<tr>
<td>Demonstrate Proficiency</td>
<td>Application (go do it!), written assignments, tests, problem sets, case studies, projects, Discussion Board</td>
</tr>
<tr>
<td>Group Work</td>
<td>Blackboard groups, web conferencing, wikis</td>
</tr>
</tbody>
</table>

On the next page is a wonderful article that gives some pointers on taking your face-to-face courses and creating effective online courses. The key points you need to think about here are:

1. Assess the materials you use in your face-to-face class. Will they work online?
2. Make lecture content interactive.
3. Provide an area in your discussions for your students to socialize.
4. Provide a list of resources.
5. Do a skills inventory activity to give students a baseline from which to work.
6. Provide practice activities.
7. Use research-based principles of design in creating your online course.
8. INTERACTION with your students.
9. Consider how you will assess students and do so frequently to make sure they are on track.
10. Ask for feedback from the students.
Translating On-Ground Courses into Effective Online Education

By: Sherion Jackson

Creating a Web-based course from a current, successful on-ground course is difficult and, at best, can be considered a translation process. In the past, instructors have created Web-based courses by taking those courses that were being taught on-ground and posting the information online, then calling these courses “Web-based.” Imitating a sound, successful on-ground course will not necessarily bring about the same success for students in a Web-based learning environment. Simply converting lectures and other course materials from on-ground courses to Web-based platforms may not be as effective as hoped. (American Federations of Teachers, 2000, p. 8).

The breadth and depth of the subject matter coverage should be equal in every way in Web-based courses to the coverage in the corresponding on-ground classroom. In past translations, that was taken to mean “posting” materials one for one. This assumes that Web-based and on-ground presentation styles are the same and that this “posting” will ensure the same breadth and depth in student learning in both on-ground and Web-based courses. Kearsley (2000) maintains that it is not the same and that the Web-based classroom is a special social environment that is very different from the on-ground classroom. If this is the case, then students lose out on critical elements of the educational process due to the instructor’s and facilitator’s inability to meet the student’s individual needs when translating on-ground courses into effective Web-based courses.

Web-based learning has been referred to as a presentation style or a medium that is used to present information and to encourage the acquisition of knowledge or learning. Adopting this perception causes facilitators and instructors to contemplate a template style different from those used in the face-to-face, on-ground classrooms. The American Federation of Teachers noted in Distance Education: Guidelines for Good Practice (2000) that “Each medium has its own
strengths and weaknesses and can deliver different kinds of dramatic experiences.” (p. 8) While students in on-ground courses may not need to experience additional social aspects of the course, the Web-based course may require an enhanced social aspect for the majority of the students enrolled in order to maximize the student’s learning experience through the presentation style. Taking this into consideration, it is detrimental to student success to just accept information presented in the face-to-face, on-ground classroom and commit it to a Web-based course platform. As the old saying goes, “we lose something in the translation,” and in Web-based courses that “something” is often the student.

The following suggestions may help facilitators and instructors review priorities and translate effective on-ground courses into effective Web-based courses by creating a presentation methodology that addressed the different needs of students in Web-based courses.

1. **Remove materials.** Take an inventory of all of the instructional materials you have used in the past on-ground equivalent course. Some of the materials will relate well in Web-based courses but others will not. Don’t be afraid to remove or replace the materials that need face-to-face interaction in order to be effective.

2. **Make lectures interactive.** By adding websites and simulations throughout the written lecture that support the lecture topic, students will be better able to understand examples, to experiment with ideas, and to acquire a deeper understanding of the course topic.

3. **Provide a social outlet from the very beginning.** Many students will feel isolated if not provided with networking capability. This social networking capability is built into the on-ground course by the mere nature of the presentation style. This is not the case with the Web-based course. For example, the instructor must work hard to provide an opportunity and place for interaction during online courses. Discussions of specified topics, team or group work, and instructor-led interactions all encourage networking.

4. **List website resources.** Assume that many of the students will come to the Web-based courses with insufficient skills in technology, formatting styles, and library usage. Provide websites that will help enhance those skills and encourage students to use these websites.

5. **Provide a survey of skills activity.** Students may not know that they have a skill deficiency compared to the expectations established for the course unless you provide a
way for them to rate their abilities. Providing survey tools for students to review their skills is very helpful in pointing to deficiencies.

6. **Provide transition activities.** On any new skill activity, provide a “practice run” at the beginning of the course. This will yield a better assessment of true student learning and not merely an assessment of technology skills. For example, if use of the library is essential in the course, create a treasure hunt that provides use of the skills required before students need to use the library to access knowledge.


8. **Interact with students.** Picciano (1998) found that instructors’ activities were related to students’ perceived learning in online education courses. Interacting with students means responding to concerns and question in a timely manner, giving plenty of constructive feedback, and providing opportunities for the student to work with others in order to avoid feeling isolated.

9. **Assess students regularly.** Schedule student assessments, both subjective and informative, to let students know at the beginning of the course when they can expect to receive grades or scores and keep to that schedule.

10. **Ask for feedback.** Evaluate the course at least twice during the semester. This evaluation should include student feedback on needs and wants within the knowledge-base of the course.

The successful translation from an on-ground into a Web-based course requires a rearrangement of course priorities for the facilitator or instructor of the Web-based course. It has been asserted that the style of presentation may not matter as long as the students are comfortable in the online environment and are having their needs met. As instructors or facilitators, we want to ensure learning through effective methods for the student. If that means changing perceptions and looking at Web-based instruction as a medium or presentation style, and developing materials that encourage learning through this medium, then that should define the route to take in order to ensure that students aren’t “lost in translation.”
References


*Sherion Jackson is an associate professor of educational administration at Texas A&M University-Commerce. Contact her at sherion_jackson@tamu-commerce.edu.*
Engaging Content Resources

Here are some resources for good, engaging materials you can find freely available on the internet. You might want to look at these and think about including them in your online course as either presentation of content, practice activities, and/or additional resources.

Open Source

Open source is a growing movement and can include full courses or course materials that are not in a repository. Do you use open source books or Slideshare?

MIT Open Courseware Initiative - [http://ocw.mit.edu/OcwWeb/web/home/home/index.htm](http://ocw.mit.edu/OcwWeb/web/home/home/index.htm)

Internet Archives - [http://www.archive.org/details/audio](http://www.archive.org/details/audio)

GoogleBooks - [https://books.google.com/](https://books.google.com/)


Creative Commons - [http://search.creativecommons.org/](http://search.creativecommons.org/)

Slideshare - [http://www.slideshare.net/mehettable/cool-tech-tools-for-ece](http://www.slideshare.net/mehettable/cool-tech-tools-for-ece)
**Digital Repositories**

Digital repositories (like Merlot – [http://merlot.org](http://merlot.org), which is one of the earliest), offers a collection of digital learning objects that are:

- Peer reviewed
- Searchable
- Discipline-specific

Search Google for lists of digital repositories available out there.

**Online Libraries**

Within our library, you might find materials you can use, for example ArtSTOR

ARTStor is an online database of images, which includes photos, illustrations, and art images. You can access it through the Library databases. Look under Art & Architecture.

**Khan Academy**

Khan – [http://khanacademy.org](http://khanacademy.org) has a lot of online videos tutorials and lessons. You don’t have to build them yourself, there are so many out there. Some examples:

**Biology**


**Booleans** [http://www.khanacademy.org/cs/booleans/839898911](http://www.khanacademy.org/cs/booleans/839898911)
Videos

YouTube

YouTube is another source of videos on the web. Be sure to find ones that are closed captioned as much as possible.

YouTube EDU

https://www.youtube.com/channel/UCt84aUC9OG6di8kSdKzEHTQ

YouTube is good for concepts or primary source materials. There is a YouTube channel specific for educators in YouTube.

If you want to learn how blogs, wikis and RSS feeds work, check out YouTube’s In Plain English

http://www.youtube.com/results?search_type=&search_query=In+Plain+English&aq=f

Consider sharing them with your students so they can learn too.

You can locate many sources that have videos that can be embedded in your course.

Public Broadcasting Service (PBS)

PBS has a wealth of videos you can use in your courses as well.

http://www.pbs.org/
Speakers: Ted Talks

Ted Talks [http://www.ted.com/talks] is a fabulous site, chock full of great speakers of the day. They have keynote speakers, supplemental resources and ways to build lesson plans with Ted Ed [http://ed.ted.com/].

Templates and Games

Teacherworld.com has free PowerPoint Templates. It’s a great site for creating all kinds of fun and engaging PowerPoints, which are good for practice, reinforcement of concepts, and facts. They provide template, you just edit the words. [http://teacherworld.com/ppgames]

Blogs

Blogs can be either content or practice (make your own blog). Michael Robinson is a Professor of History in Hillyer College. For example: [http://timetoeatthedogs.com/]

Preparing to Teach Online | Faculty Center for Learning Development
Museums
Museums are also digitizing as much as they can. For example: Guggenheim Online
http://www.guggenheim.org/new-york/online

Interactive Sites
Google search “Interactive ________ (your discipline) to find all kinds of interactive websites.

Example: University of Houston Digital History
http://www.digitalhistory.uh.edu/index.cfm

Primary Source Manuscripts
Another place to find content for your online course are primary source manuscripts, such as those from the British Library (http://www.bl.uk/onlinegallery/index.html).

Government Sources
Government sources hold a wealth of freely available resources and they have been digitizing content like crazy. Some sites to check out:

Library of Congress

National Archives
http://www.archives.gov/

Smithsonian
http://www.si.edu/Collections
Simulations/Games
Simulations and Online Games are wonderful ways to engage your students that are fun and give students practical hands-on, applied experience.

CSI: The Experience Web Adventures [http://forensics.rice.edu/]

PhET Interactive Simulations – a repository of hundreds of science and math simulations

https://phet.colorado.edu/en/simulations/category/new
Legal Considerations

Now that we’ve talked about the kinds of interactive content and activities we can incorporate into our online courses, there are some legal considerations to keep in mind. These are things that all faculty and staff know, but we may need a refresher on some of the details. As so many of you already know, Harvard and MIT were recently sued for inaccessibility. This highlights our need to make sure we are in compliance both in our online courses and face-to-face courses.

FERPA

“The Family Educational Rights and Privacy Act (FERPA) (20 U.S.C. § 1232g; 34 CFR Part 99) is a Federal law that protects the privacy of student education records. The law applies to all schools that receive funds under an applicable program of the U.S. Department of Education.”


University of Hartford: FERPA
https://www.hartford.edu/about/offices-divisions/office-registrar/ferpa.aspx

FERPA Primer: The Basics and Beyond https://www.naceweb.org/public/ferpa0808.htm

FERPASherpa https://ferpasherpa.org/

Copyright & Fair Use

Fair use (in US copyright law) is a doctrine that allows, that under certain circumstances, excerpts of copyrighted material may be used or quoted verbatim for the furthering of instruction, research, or to improve upon a subject without the express permission or payment from the copyright holder. There are usually four factors that govern whether use of this material is considered “fair use” or not. See the resources below for more on this topic.

Copyright Crash Course – “Fair use of copyrighted materials”
http://copyright.lib.utexas.edu/copypol2.html#image

American Library Association – “Fair Use” http://www.ala.org/advocacy/copyright/fairuse

Music Library Association https://www.musiclibraryassoc.org/mpage/copyright_home

Fair Use Evaluator – this is an interactive tool that aids you in self-evaluating fair use of material http://librarycopyright.net/resources/fairuse/
The Fair Use Checklist and variations on it have been widely used for many years to help educators, librarians, lawyers, and many other users of copyrighted works determine whether their activities are within the limits of fair use under U.S. copyright law (Section 107 of the U.S. Copyright Act). Fair use is determined by a balanced application of four factors set forth in the statute: (1) the purpose of the use; (2) the nature of the work used; (3) the amount and substantiality of the work used; and (4) the effect of the use upon the potential market for or value of the work used. Those factors form the structure of this checklist. Congress and courts have offered some insights into the specific meaning of the factors, and those interpretations are reflected in the details of this form.

Benefits of the Checklist
A proper use of this checklist should serve two purposes. First, it should help you to focus on factual circumstances that are important in your evaluation of fair use. The meaning and scope of fair use depends on the particular facts of a given situation, and changing one or more facts may alter the analysis. Second, the checklist can provide an important mechanism to document your decision-making process. Maintaining a record of your fair use analysis can be critical for establishing good faith; consider adding to the checklist the current date and notes about your project. Keep completed checklists on file for future reference.

The Checklist as Roadmap
As you use the checklist and apply it to your situations, you are likely to check more than one box in each column and even check boxes across columns. Some checked boxes will favor fair use and others may oppose fair use. A key issue is whether you are acting reasonably in checking any given box, with the ultimate question being whether the cumulative weight of the factors favors or turns you away from fair use. This is not an exercise in simply checking and counting boxes.

Instead, you need to consider the relative persuasive strength of the circumstances and if the overall conditions lean most convincingly for or against fair use. Because you are most familiar with your project, you are probably best positioned to evaluate the facts and make the decision.

Further Information
You can learn more about fair use from many sources, including the website of the Copyright Advisory Office of Columbia University: www.copyright.columbia.edu.

Creative Commons: Want to reproduce or adapt this checklist (and this introduction) for your needs? Please do. Regard the checklist and introduction as “Creative Commons Attribution Only” (http://creativecommons.org/licenses/) with credit to the original creators of the checklist, Kenneth D. Crews (Columbia University) and Dwayne K. Buttler (University of Louisville).

Simple requests to users: Please do include a version of this introduction to help users of the checklist. Please send us an email (to copyright [at] columbia [dot] edu) with your thoughts or just to let us know how you may have found the checklist to be helpful.

Thank you!
© 2011 Columbia University Libraries/Information Services
**FAIR USE CHECKLIST** for Indiana University

*Instructional project name*

Instructor ___________________________ Date __________ Prepared by ___________________________

*Please complete and retain a copy of this form in connection with each possible “fair use” of a copyrighted work for your project.*

<table>
<thead>
<tr>
<th>Favoring fair use</th>
<th>Opposing fair use</th>
</tr>
</thead>
<tbody>
<tr>
<td>PURPOSE</td>
<td>PURPOSE</td>
</tr>
<tr>
<td>Teaching (includes multiple copies for classroom use)</td>
<td>Commercial activity</td>
</tr>
<tr>
<td>Research</td>
<td>Profiting from the use</td>
</tr>
<tr>
<td>Scholarship</td>
<td>Entertainment</td>
</tr>
<tr>
<td>Nonprofit educational institution</td>
<td>Bad-faith behavior</td>
</tr>
<tr>
<td>Criticism</td>
<td>Denying credit to original author</td>
</tr>
<tr>
<td>Comment</td>
<td></td>
</tr>
<tr>
<td>News reporting</td>
<td></td>
</tr>
<tr>
<td>Transformative or productive use (changes the work for new utility)</td>
<td></td>
</tr>
<tr>
<td>Restricted access (to students or other appropriate group)</td>
<td></td>
</tr>
<tr>
<td>Parody</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>NATURE</td>
<td>NATURE</td>
</tr>
<tr>
<td>Published work</td>
<td>Unpublished work</td>
</tr>
<tr>
<td>Factual or nonfiction based</td>
<td>Highly creative work (art, music, novels, films, plays)</td>
</tr>
<tr>
<td>Important to favored educational objectives</td>
<td>Fiction</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td>AMOUNT</td>
</tr>
<tr>
<td>Small quantity</td>
<td>Large portion or whole work used</td>
</tr>
<tr>
<td>Portion used is not central or significant</td>
<td>Portion used is central to or “heart of the work”</td>
</tr>
<tr>
<td>Amount is appropriate for favored educational purpose</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>EFFECT</td>
<td>EFFECT</td>
</tr>
<tr>
<td>User owns lawfully purchased or acquired copy of original work</td>
<td>Could replace sale of copyrighted work</td>
</tr>
<tr>
<td>One or few copies made</td>
<td>Significantly impairs market or potential market for copyrighted work or derivative</td>
</tr>
<tr>
<td>No significant effect on the market or potential market for copyrighted work</td>
<td>Reasonably available licensing mechanism for use of the copyrighted work</td>
</tr>
<tr>
<td>No similar product marketed by the copyright holder</td>
<td>Affordable permission available for using work</td>
</tr>
<tr>
<td>Lack of licensing mechanism</td>
<td>Numerous copies made</td>
</tr>
<tr>
<td></td>
<td>You made it accessible on the web or in other public forum</td>
</tr>
<tr>
<td></td>
<td>Repeated or long-term use</td>
</tr>
</tbody>
</table>

*The original Fair Use Checklist, developed by Dr. Kenneth D. Crews, Director of Columbia University Libraries/Information Services Copyright Advisory Office, is available as a PDF from: http://copyright.columbia.edu/copyright/fair-use/fair-use-checklist/*

*revised 10 JAN 2012*
Activity: Customizing your Course – Adding a Course Banner

Now that you’ve got your menu organized and have gathered some activities to put into your course, it’s time to customize your course a bit. How are some ways we can make the course more personal... more you?

The first, easiest, and most visually impactful way is by creating a course banner.
We’ve got our lessons, our content within our lessons, redesigned the navigation in our course and customized it to express our own teaching styles… what else do we need?

Introduction to Course Design Rubrics

There are several well-known checklists used to make sure your design includes all the critical success factors. One is Quality Matters, another is Blackboard’s Exemplary Course Rubric, and another is Chico State’s Rubric for Online Instruction. Each of the rubrics below are linked in the Preparing to Teach Online Blackboard Course.

Quality Matters
https://www.qualitymatters.org/qa-resources/rubric-standards

OLC Quality Scorecard
https://onlinelearningconsortium.org

Chico State EOI (Exemplary Online Instruction) Rubric
https://www.csuchico.edu/eoi/

Tour of Online Course
http://www.screencast.com/t/LFQ5hiwpq

Blackboard Exemplary Course Program
https://community.blackboard.com/community/ecp

Chico State’s Rubric for Online Instruction

Retrieved from: [http://www.csuchico.edu/roi/documents/rubricpdf](http://www.csuchico.edu/roi/documents/rubricpdf) (used with permission, Creative Commons)

Rationale California State University, Chico's first strategic priority is to create and enhance high quality learning environments. Academic technologies, especially online or web-enhanced courses, have a significant role in the creation of those learning environments. The University's Strategic Priorities challenge faculty and staff to use academic technologies to create and enhance high quality learning environments in a demonstrable manner.

What should a quality online course look like?

Chico’s Rubric for Online Instruction offers a framework for addressing this question. Use of this rubric represents a developmental process for online course design and delivery, and provides a means for an instructor to self-assess course(s) based on University expectations. Furthermore, the rubric provides a means for supporting and recognizing a faculty member's effort in developing expertise in online instruction as part of our commitment to high quality learning environments.

The Rubric for Online Instruction can be used in three ways.

1. As a course "self-evaluation" tool - advising instructors how to revise an existing course to the Rubric for Online Instruction.
2. As a way to design a new course for the online environment, following the rubric as a road map.
3. As a means for getting recognition for exemplary online instruction - going through a nomination/recognition process on campus. Faculty can receive recognition to go in their RTP file.

Historical Perspective

The process by which faculty and staff came together to write this rubric is available for your review. This describes the history and work of a dedicated committee.

The Rubric for Online Instruction initiated the Exemplary Online Instruction Awards, a recognition made public at the annual CELT Conference at CSU, Chico. The website demonstrates examples of exemplary online instruction and is available for viewing.

License

This work is licensed under the Creative Commons Attribution 3.0 United States License. To view a copy of this license, visit [http://creativecommons.org/licenses/by/3.0/us/](http://creativecommons.org/licenses/by/3.0/us/) or send a letter to Creative Commons, 171 Second Street, Suite 300, San Francisco, California, 94105, USA.
### Category 1: Learner Support & Resources

<table>
<thead>
<tr>
<th>Baseline</th>
<th>Effective</th>
<th>Exemplary</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Course contains limited information for online learner support and links to campus resources.</td>
<td>A. Course contains adequate information for online learner support and links to campus resources.</td>
<td>A. Course contains extensive information about being an online learner and links to campus resources.</td>
</tr>
<tr>
<td>B. Course provides limited course-specific resources, limited contact information for instructor, department, and/or program.</td>
<td>B. Course provides adequate course-specific resources, some contact information for instructor, department, and program.</td>
<td>B. Course provides a variety of course-specific resources, contact information for instructor, department, and program.</td>
</tr>
<tr>
<td>C. Course offers limited resources supporting course content and different learning abilities.</td>
<td>C. Course offers access to adequate resources supporting course content and different learning abilities.</td>
<td>C. Course offers access to a wide range of resources supporting course content and different learning abilities.</td>
</tr>
</tbody>
</table>

### Category 2: Online Organization & Design

<table>
<thead>
<tr>
<th>Baseline</th>
<th>Effective</th>
<th>Exemplary</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Much of the course is under construction, with some key components identified such as the syllabus.</td>
<td>A. Course is organized and navigable. Students can understand the key components and structure of the course.</td>
<td>A. Course is well-organized and easy to navigate. Students can clearly understand all components and structure of the course.</td>
</tr>
<tr>
<td>B. Course syllabus is unclear about what is expected of students.</td>
<td>B. Course syllabus identifies and delineates the role the online environment will play in the course.</td>
<td>B. Course syllabus identifies and clearly delineates the role the online environment will play in the total course.</td>
</tr>
<tr>
<td>C. Aesthetic design does not present and communicate course information clearly.</td>
<td>C. Aesthetic design presents and communicates course information clearly.</td>
<td>C. Aesthetic design presents and communicates course information clearly throughout the course.</td>
</tr>
<tr>
<td>D. Web pages are inconsistent both visually and functionally.</td>
<td>D. Most web pages are visually and functionally consistent.</td>
<td>D. All web pages are visually and functionally consistent throughout the course.</td>
</tr>
<tr>
<td>E. Accessibility issues are not addressed. (Including: sight, mobility, hearing, cognition, ESL, and technical.)</td>
<td>E. Accessibility issues are briefly addressed. (Including: sight, mobility, hearing, cognition, ESL, and technical.)</td>
<td>E. Accessibility issues are addressed throughout the course. (Including: sight, mobility, hearing, cognition, ESL, and technical.)</td>
</tr>
</tbody>
</table>
## Category 3
### Instructional Design & Delivery

<table>
<thead>
<tr>
<th>Baseline</th>
<th>Effective</th>
<th>Exemplary</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Course offers limited opportunity for interaction and communication student to student, student to instructor and student to content.</td>
<td>A. Course offers adequate opportunities for interaction and communication student to student, student to instructor and student to content.</td>
<td>A. Course offers ample opportunities for interaction and communication student to student, student to instructor and student to content.</td>
</tr>
<tr>
<td>B. Course goals are not clearly defined and do not align to learning objectives.</td>
<td>B. Course goals are adequately defined but may not align to learning objectives.</td>
<td>B. Course goals are clearly defined and aligned to learning objectives.</td>
</tr>
<tr>
<td>C. Learning objectives are vague or incomplete and learning activities are absent or unclear.</td>
<td>C. Learning objectives are identified and learning activities are implied.</td>
<td>C. Learning objectives are identified and learning activities are clearly integrated.</td>
</tr>
<tr>
<td>D. Course provides limited visual, textual, kinesthetic, and/or auditory activities to enhance student learning and accessibility.</td>
<td>D. Course provides adequate visual, textual, kinesthetic, and/or auditory activities to enhance student learning and accessibility.</td>
<td>D. Course provides multiple visual, textual, kinesthetic, and/or auditory activities to enhance student learning and accessibility.</td>
</tr>
<tr>
<td>E. Course provides limited activities to help students develop critical thinking and/or problem-solving skills.</td>
<td>E. Course provides adequate activities to help students develop critical thinking and/or problem-solving skills.</td>
<td>E. Course provides multiple activities that help students develop critical thinking and problem-solving skills.</td>
</tr>
</tbody>
</table>

---

## Category 4
### Assessment & Evaluation of Student Learning

<table>
<thead>
<tr>
<th>Baseline</th>
<th>Effective</th>
<th>Exemplary</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Course has limited activities to assess student readiness for course content and mode of delivery.</td>
<td>A. Course has adequate activities to assess student readiness for course content and mode of delivery.</td>
<td>A. Course has multiple timely and appropriate activities to assess student readiness for course content and mode of delivery.</td>
</tr>
<tr>
<td>B. Learning objectives, instructional and assessment activities are not aligned.</td>
<td>B. Learning objectives, instructional and assessment activities are adequately aligned.</td>
<td>B. Learning objectives, instructional and assessment activities are closely aligned.</td>
</tr>
<tr>
<td>C. Assessment strategies are limited in use to measure content knowledge, attitudes, and skills.</td>
<td>C. Ongoing strategies are used to measure content knowledge, attitudes, and skills.</td>
<td>C. Ongoing multiple assessment strategies are used to measure content knowledge, attitudes, and skills.</td>
</tr>
<tr>
<td>D. Opportunities for students to receive feedback about their own performance are infrequent and sporadic.</td>
<td>D. Opportunities for students to receive feedback about their own performance are provided.</td>
<td>D. Regular feedback about student performance is provided in a timely manner throughout the course.</td>
</tr>
<tr>
<td>E. Students' self-assessments and/or peer feedback opportunities are limited.</td>
<td>E. Students' self-assessments and/or peer feedback opportunities exist.</td>
<td>E. Students' self-assessments and peer feedback opportunities exist throughout the course.</td>
</tr>
</tbody>
</table>
### Category 5

#### Innovative Teaching with Technology

<table>
<thead>
<tr>
<th>Baseline</th>
<th>Effective</th>
<th>Exemplary</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Course uses limited technology tools to facilitate communication and learning.</td>
<td>A. Course uses adequate technology tools to facilitate communication and learning.</td>
<td>A. Course uses a variety of technology tools to appropriately facilitate communication and learning.</td>
</tr>
<tr>
<td>B. New teaching methods applied to enhance student learning are limited.</td>
<td>B. New teaching methods are adequately applied to innovatively enhance student learning.</td>
<td>B. New teaching methods are applied and innovatively enhance student learning, and interactively engage students.</td>
</tr>
<tr>
<td>C. There are limited multimedia elements and/or learning objects for accommodating different learning styles.</td>
<td>C. Multimedia elements and/or learning objects are used and are relevant to accommodate different learning styles.</td>
<td>C. A variety of multimedia elements and/or learning objects are used and are relevant to accommodate different learning styles throughout the course.</td>
</tr>
<tr>
<td>D. Course uses Internet access and engages students in the learning process in a very limited way.</td>
<td>D. Course optimizes Internet access and effectively engages students in the learning process.</td>
<td>D. Course optimizes Internet access and effectively engages students in the learning process in a variety of ways throughout the course.</td>
</tr>
</tbody>
</table>

### Category 6

#### Faculty Use of Student Feedback

<table>
<thead>
<tr>
<th>Baseline</th>
<th>Effective</th>
<th>Exemplary</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Instructor offers limited opportunity for students to give feedback to faculty on course content.</td>
<td>A. Instructor offers adequate opportunities for students to give feedback on course content.</td>
<td>A. Instructor offers multiple opportunities for students to give feedback on course content.</td>
</tr>
<tr>
<td>B. Instructor offers limited opportunity for students to give feedback on ease of online technology and accessibility of course.</td>
<td>B. Instructor offers adequate opportunities for students to give feedback on ease of online technology and accessibility of course.</td>
<td>B. Instructor offers multiple opportunities for students to give feedback on ease of online technology and accessibility of course.</td>
</tr>
<tr>
<td>C. Instructor uses student feedback to help plan instruction and assessment of student learning for the next semester in a limited way.</td>
<td>C. Instructor requests and uses student feedback a couple times during the semester to help plan instruction and assessment of student learning for the rest of the semester.</td>
<td>C. Instructor uses formal and informal student feedback in an ongoing basis to help plan instruction and assessment of student learning throughout the semester.</td>
</tr>
</tbody>
</table>
Once you have developed your lessons or smallest units, you need to get all of that, plus more, into your Blackboard course and then put it all together in a cohesive, easily navigable format.

One of the best ways to design your course in Blackboard:

- Storyboard all the lessons and pieces of the course.
- Build the lessons in Blackboard using the Learning Module tool.
- Create the remaining course menu items.
- Review the course using an online course design rubric.

In the next seminar, we will discuss some different ways to organize your courses and some other basic tools used for online instruction.
SEMINARY 3:
BASIC TOOLS FOR ONLINE INSTRUCTION

As with any instruction, we need to be able to communicate with students, collect assignments, and facilitate group work such as case studies and projects. This seminar covers basic Blackboard tools that are essential for online instruction including Email, Announcements and Alerts, the Assignment Tool, and Blackboard Groups.

Learning Objectives

- Create and use folders in a content area to organize content.
- Toggle the “Student Preview Mode” to view content as a student.
- Manage users and groups. View your course roster via the 'Users' tool.
- Use and make the connection between Announcements, Email and Course Messages as communication tools with students.
- Create assignments using Blackboard's Assignment/ SafeAssign tool.
- Manage user rosters in Blackboard.
- Make your course available to students.

Seminar Contents

Course Organization: Folders ....................................................................................................... 73
Announcements............................................................................................................................. 74
Blackboard Email.......................................................................................................................... 76
Blackboard Course Messages ....................................................................................................... 78
Blackboard Assignments .............................................................................................................. 79
Integrated Assignment/Safe-Assign Tool ..................................................................................... 79
Inline Grading with Annotations for Assignments ....................................................................... 87
Using SafeAssign.......................................................................................................................... 93
Rosters and Managing Users in Blackboard Courses .................................................................... 100
Making your Blackboard Course Available ............................................................................... 103

Seminar Activities

Activity: Create an Announcement............................................................................................... 75
Activity: Sending a Blackboard Email ........................................................................................ 77
Activity: Creating an Assignment................................................................................................. 80
Activity: Submitting an Assignment............................................................................................ 82
Activity: Making Annotations on Uploaded Documents.............................................................. 92
Activity: SafeAssign for Student Use – Draft Submission............................................................ 95
Activity: Add a Test Student to Your Course............................................................................. 102

**Additional Resources/Web Sources**

Visit the Seminar 3 Learning Module in your *Preparing to Teach Online* course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
Course Organization: Folders

We taught you about learning modules, but you will notice in some of the exemplary courses that instructors used folders. It doesn’t really matter whether you choose to use folders versus using learning modules; it is the principle that is important. We need organized, consistent content that is easy to follow. You don’t want your students to spend all their time trying to find things. You want to avoid a ‘content dump’. Whether you use folders or modules, you will need to include lots and lots of text throughout – instructions, helpful tips, and key learning take-aways. Don’t just plunk the materials into the course without an introduction for each piece. This helps them to ‘hear’ you as they are going through the materials and close some of that distance.

To create a folder in Blackboard:

1. Go to any content area of your course (such as Assignments).
2. Click the Build Content button → Click Content Folder.
3. In the Create Content Folder window, enter a Name for the folder, and optionally a description under text.
4. Make sure users can view the content and set other options as needed.
5. When done, click Submit.

After creating the folder, you can add content. Simply click on the folder title, then add files, images, assignments as you normally do.
Announcements

Announcements should be one of the most used tools for communicating with your students in an online course. Your announcements should be personable and used to establish presence.

Some best practices and tips for using Announcements include:

- Make the most of your announcements. Use images and be creative.
- Use announcements to establish presence in the course, a sense of who you are… your personality.
- Use a conversational tone and be welcoming to students. Keep the pace and tone consistent.
- Send frequent reminders of requirements, guidelines and assignments. Inform, remind, reiterate, redirect, alert, praise…
- Do not use date restrictions because you will want to use the email feature.
- Use the email announcement feature to send the announcement as an email as well.

Bienvenidos Estudiantes (Welcome Students)

Posted on: Friday, November 13, 2015 10:36:56 AM EST

¡Hola estudiantes y bienvenidos a Español 101!

I hope you all have had a wonderful winter break and are geared up to dive into course this Spring!

One of the first questions I get at the beginning of this course is if you need a physical text book. The answer is no, you only need to sign up for the code for the online program. Go to your syllabus for instructions. You may order the code for the online program + the companion text if you so choose instead (this will come to you in a loosedef version put into a 3-ring binder). Don’t forget to use your Charter Oaks email address when you sign up.

Spanish 1 students can purchase their book as follows:

1. Click the link for http://utahhigherlearning.com/students/store/en-linea-3-02001
3. This will get you the En Linea 3.0 book for Spanish 1. You need at least the Code option to read the text, complete the activities and quizzes for this course.
4. The course code for your textbook online is: M918773.
5. Log in to En Linea and create an account at http://books.yale.com. Enter the book code and/or course code to get started. Follow the directions found in Course Documents.

Here’s a few important issues to bear in mind when you start:

SYLLABUS, PARA EMPEZAR (GET STARTED) & DOCUMENTOS should be the first documents you read to get acquainted with the rules of the course.

Also read and be familiar with RECURSOS, ACADEMIC HONESTY AND STUDENT RESOURCES.

TAREA (COURSE CONTENT) should be the Menu on the left Item you check every week to see what has to be done. This may contain something new and updated from the Syllabus.
Activity: Create an Announcement

Go into your course and create an announcement, sending it to students.

Click the **Announcements** link on the main Course Menu.

1. Click the **Create Announcement** button.

2. Add any information, text, videos, graphics, photos you like just as you would in any other content area in Blackboard.

3. In section 2, **Web Announcement Options**, set Announcement to **Not Date Restricted**, otherwise, your announcement will not appear to students until the date you set below under **Date Restricted**.

4. You can also Email your students a copy of the Announcement by checking **Send a copy of this announcement immediately**. Please note, that when you send messages through Blackboard’s email system, it will send it in a text (not HTML) format, so you will not see images in the body of your message.

   NOTE: Your email is sent **immediately** to students, even if the announcement is date restricted.

5. When done with your announcement, click **Submit**.
Blackboard Email

Email is available directly in your Blackboard Course under the Tools section. Here are some email best practice tips:

- Use the tool in Blackboard to send emails to student accounts – email will be securely sent directly to the students’ hartford.edu accounts, not the students’ personal accounts. This is a best practice for FERPA issues.
- Email in Blackboard cannot send stand-alone image files. Instead, insert the image in a document and then attach the document.
- Inform students that they cannot use Reply All to an email sent back to the whole group; Replies only go back to the sender.
- Use only email or a phone to communicate private and sensitive information. You should not be using discussions, for example, to communicate sensitive and other private information with the student re: illnesses and private and confidential information such as grades.
- Blackboard doesn’t keep records of sent email; however, a copy of the email you send will also be sent to your hartford.edu email address.
- Keep the email format simple and easy to read.

As a best practice, your students should not be submitting assignments via email because Blackboard does not keep a record of this. Instead, they should be submitted via the Assignments tool.
Activity: Sending a Blackboard Email

Blackboard has a built-in Email tool available to course users within each course. There are two ways to access it. Go into your practice course and send a test email to the sample students in your course.

A. On the Course Menu → Tools → Send Email
B. On the Course Menu → Course Management section → Course Tools → Send Email

Here you can chose to send your email to:

- All Users
- All Groups
- All Student Users
- All Teaching Assistant Users
- All Instructor Users
- All Observer Users
- Single/Select Users
- Single/Select Groups
- or Single/Select Observer Users

Compose your email just as you would regularly, then click Submit.
Blackboard Course Messages

Blackboard has a built-in Email tool available to course users within each course. It is important to note that Blackboard does keep a record of Course Messages, where it does not emails. If you choose to use Course Messages to communicate with students, be sure to post Announcements to remind students to check Course Messages for information regularly.

There are two ways to access it:

A. On the Course Menu → Tools → Course Messages
B. On the Course Menu → Course Management section → Course Tools → Course Messages

1. In the Course Messages window, click Create Message

2. Click the To button to expand and select the recipients from the list, clicking the > arrow to move them to the Recipients box on the right.
3. Enter your subject and the body of your message as well. When done, click Submit.
Assignments are a critical component to any course – whether it be a face-to-face or an online course. Blackboard has a built-in Assignment tool (which has now integrated with SafeAssign) to act as a submission tool for students to upload their assignments for instructor grading. As a best practice, do not have your students email assignments as there is no way to track whether or not they have done the assignment. For transparency reasons, Assignments should be submitted via the Assignments tool in Blackboard. Once they have been submitted, Blackboard’s Grade Center has a mechanism that shows the submissions the student has made. From here, you have many options in setting up the Assignments and for grading them.

**Integrated Assignment/Safe-Assign Tool**

The Blackboard Assignment Tool is used for assignment submission. Instructors who have used it in the past may find that the Assignment Tool is now integrated with SafeAssign, a plagiarism detection tool. Faculty users have found the program to be effective both as a learning tool for students and as a deterrent to plagiarism. Some of the benefits the combined Assignment/SafeAssign tools offer are:

- An integrated solution for collecting Assignments and submitting via SafeAssign for plagiarism review.
- Easy in-line grading and annotation of submitted files without ever leaving Blackboard.
- Downloading files is available by clicking a link within the inline grading panel.
- A one-click way to download all submitted assignment files to your computer.
- Convenient grading - assignment items are automatically entered into Grade Center.
- A way to post more sophisticated assignments, such as side-by-side pictures.

**Here’s how it works...**

- The instructor sets up the assignment (with or without SafeAssign)
- The student submits their assignment
- The instructor goes to the grade center
- The instructor reviews the assignment directly in the grade center and makes comments and enters the grade.

**VERY IMPORTANT:** Due to the interactive nature of the Assignments tool, your assignments may not always copy over when copying content into a new course. You may have to recreate assignments in the new course.
If you plan to use SafeAssign...
As a best practice, the Office of the Provost recommends that you post a message in your assignment directions, in your syllabus and in your announcements informing students that you will be using SafeAssign as a plagiarism detection tool.

See the section on “Using SafeAssign in Blackboard” (page 93) for more detailed information on using SafeAssign and viewing reports, along with some sample messages you can post in your course.

Activity: Creating an Assignment

Assignments are one of the critical ways to assess students and evaluate their meeting of the course and/or lesson learning objectives. Go into your Practice Course and create an assignment.

1. Open up a Content Area (e.g. “Course Documents” or “Assignments”).
2. From the Assessments menu, select Assignment. The Assignment Tool opens.
3. Type a name for the assignment.
4. Enter very clear instructions for the students on how to complete and submit it.
5. Optional: Use the Browse button to upload long assignments as attached file (e.g., Word document, Excel file, etc.).
6. Optional: Set a Due Date. Items submitted after the Due Date will be marked late in the grade center.
7. Designate a point value (for grading), and add a rubric if desired.

8. Several changes were made to the Create Assignment page in Blackboard under the Grading section. Previously, these blocks were openly displayed, but now they are collapsed. Click on each link to expand the block.
**Submission Details:**

SafeAssign is now integrated into regular Blackboard Learn Assignments under this section.

a. Choose whether the assignment is an **Individual** or a **Group Submission**.
b. Instructors can select the **Number of Attempts** allowed (Single, Multiple, Unlimited)
c. The following Plagiarism Tools are now available:
   - Check submissions for plagiarism under SafeAssign
   - Allow students to view SafeAssign originality report for their attempts
   - Exclude submissions from the Institutional and Global References Databases

![Setting Submission Details in the Assignment Tool](image)

**Grading Options:**

a. **Anonymous Grading** – instructors can choose to hide assignment names when viewing and grading submissions. To ensure anonymity, a message is displayed to students on the **Upload Assignment** page asking them not to include identifying information in their assignment submissions.
b. **Delegated Grading** - Instructors can also delegate grading to one or more users with grading privileges to promote reliability and remove bias.

![Grading Options](image)

**Display of Grades:**

a. Choose how you want your grades displayed (Score, Letter, Text, Percentage, Complete/Incomplete)
b. Choose whether or not to *Include in Grade Center grading calculations*

c. Select whether or not you want to *Show to students in My Grades*

d. Elect whether or not to *Show Statistics*

![Display of Grades](image)

**Setting how Grades will be Displayed in the Assignment Tool**

9. Set the Availability Dates if you choose and whether or not to track views.

10. When done with choosing your Assignment Options, click **Submit**.

---

### Activity: Submitting an Assignment

It is also helpful to know what your students will be doing on their end when submitting an assignment. Complete the following activity to submit your own assignment in the Preparing to Teach Course.

Go into the *Preparing to Teach Online* course and submit an Assignment in the *Seminar 3 Learning Module*.

Students access the assignment by locating the assignment and then clicking on the name of the assignment. They have two options for submitting the assignment:

- On the **Upload Assignment** page, they can paste their submission into the text box under **Assignment Materials** and click **Submit**. This works best for short written assignments, or for students who might have difficulty attaching their work as a Word file.

- For longer assignments, students should complete the assignment in Word or make a PDF file and upload it to Blackboard. On the **Upload Assignment** page, they would click on **Browse My Computer** to find and attach the file to their assignment. Students can attach multiple files to the same assignment. After uploading the assignment, students should click the **Submit** button.

After submitting, the **Review Submission History** page appears, where can review the item they have just submitted. From here, they should click **OK**.

To save the assignment and return to it later, click on the **Save as Draft** button. This takes the student to the **Review Submission History** page. From here, they can click on **Continue**.
**Current Submission** to return to the assignment, or they can log out of the course and return to it at a later time.

**Grading and Returning an Assignment**

When you create an assignment using the Assignment Tool, a column is automatically created for it in the Grade Center. Instructors access students’ submitted assignments through the Grade Center and have the option of accessing individual assignments for grading, or of downloading all assignments and then grading them.

Submitted assignments will appear in the Grade Center as a green exclamation point. If the student has only saved it, but not used the Submit button, you will see a notebook icon instead.

![Accessing an Individual Assignment from the Grade Center](image)

**Grading a Single Student’s Assignment**

1. Enter the Grade Center from the Control Panel.
2. For each student who has an assignment that needs grading, you will see a green exclamation mark icon. Click on the chevron icon next to it and select **View Grade Details** to access a student’s assignment.
3. Click **View Attempts** to open up the assignment and access the student’s submitted file. The Inline Grading panel will open up with the currently selected student’s name at the top.
4. If the student submitted a file, **Crocodoc** will load the paper in the preview panel where you can annotate and mark up the document. In the Assignment Details panel on the right, enter the Grade and Feedback to Learner.
5. **SafeAssign Submission** – This option only comes up if you as the Instructor have elected to have students submit their work via SafeAssign for plagiarism.
1. The inline grading block to the right will indicate how much of an overall match the assignment is.

2. Click the down arrow next to SafeAssign to expand the block and then click View Originality Report.

3. A new window will take you out of Blackboard to SafeAssign’s page where it will let you see where students stand on their plagiarism and their sources.

6. Alternatively, instructors can click the link for the file under Submission on the Assignment Details panel on the right to download the file to your computer to grade the paper offline.

7. NOTE: If there was a problem with the submission, go back to the Grade Center, View Grade Details and use Clear Attempt. Clearing the attempt allows student to complete the assignment again, but removes all trace of partially completed work!

8. Locate the file on your computer and grade it. Afterwards, return to the Blackboard Grade Center and click View Grade Details.

9. Click on View Attempt again.

10. Under Assignment Details, insert a grade and comments for the student. If you are returning the student’s assignment with markups, click the paperclip icon in the Feedback to Learner box, Browse to upload the file.

11. Add Notes – This used to be formerly Instructor Notes. Use this to add private notes and/or attach a file if needed. Students cannot see these notes or files!

12. Click Submit. You are returned to the Grade Details window. Check to be sure that the student’s grade has been entered. Click Return to Grade Center and verify that the grade is in the column.

**Downloading and Grading All Students’ Assignments**

- In the Grade Center, click on the assignment column heading, and then select Assignment File Download.
- Click on the column headings to sort the students into categories (e.g. “needs grading”).
- Use the checkboxes to select which students’ assignments you would like to download. To select all students, click on the checkbox next to the word “Name.”
Selecting a Download Option

- After selecting, click **Submit** at the top or bottom of the page.
- Click on the link name to download the zipped file to your computer (MAC users should press `control` and `click`). You can now unzip it to review and grade students’ work.

### Assignment Submission Problems, and Cleaning Up Files

If an error has occurred during submission, you may have to clear the attempt and have the student resubmit the file.

**Clearing an Individual Student Attempt**

1. Go to **Control Panel ➔ Grade Center**.
2. Click in the Grade Center cell for that assignment next to the student in question.
3. Click on the chevron icon and select **View Grade Details** to access a student’s assignment.
4. Select **View Attempt** to see the assignment (this may not be possible).
5. Select **Clear Attempt** to remove the assignment so the student can try again.
6. Confirm your selection by clicking **OK**.
7. You will receive confirmation that the assignment was cleared. Click **OK**.
8. You will be returned to Grade Center. Click **OK**.

**Removing Assignment Files (Optional)**

Because one assignment can generate as many as three files - the original assignment file, the student’s submitted file, the instructor’s returning assignment file - assignments can take up a lot of space on Blackboard. After downloading files to your computer, it is possible to remove them. Be aware that removed files cannot be recovered!

**To remove old assignment files:**

1. Select **Control Panel ➔ Grade Center**.
2. Select the chevron next to the column label for the assignment to be cleaned up.
3. Select **Assignment File Cleanup**.
4. Click on the column headers to sort the files into categories (e.g. by file size or type).
5. Click on the checkboxes next to the files you wish to delete.
6. Click on the **Delete** button above or below the list of names.
7. Click **OK**.
Allowing Rewrites and Resubmissions (Optional)

If you would like to allow your students to rewrite an assignment, you can choose to have the Assignment Tool accept multiple attempts. You can modify the Assignment in the Grade Center to count the grade of the last attempt only, the attempt with the highest grade, or an average of the grades on all attempts.

To allow multiple attempts on an assignment, create an assignment under a Content Area and select the number of attempts under Availability.

When students are ready to submit a rewrite of an assignment, they open the Content Area where the assignment is located and click on the name of the assignment. From there, they will see a list of all previous submissions for this particular assignment, along with links to attached files. Students should click on the Start New Submission button to submit the second attempt.

Instructors can view and grade all of a student’s attempts to an assignment from the Grade Center. If you have graded one attempt, but have not graded the other attempts, you will see both a number and a green exclamation point by the student’s name.

By default, the Grade Center will only count the grade of the last attempt in the student’s grade calculations. To modify this (so that the Grade Center will only count the highest grade or an average of the attempts, for example):

- Enter the Grade Center and click on the chevron next to the name of the column.
- Use the dropdown menu next to Score attempts using to choose your grading option.
- Click Submit.
Inline Grading with Annotations for Assignments

Excerpted from: http://help.blackboard.com

When you create an assignment, a column is added automatically to the Grade Center. An assignment that has been submitted, but not graded, is indicated with an exclamation mark—the needs grading icon.

You can access assignments that have been submitted by students and need grading from the:

- Needs Grading page
- Full Grade Center

Depending on your grading style, you can access and grade one assignment attempt, view all the submissions for one assignment, or view all the assignments with submissions that need grading.

Inline Grading means you can open a submitted assignment, mark it up, add comments, and annotate the document—all within Blackboard. You no longer have to download the document and open it in Microsoft Word to mark it up.

**Inline Assignment Grading and New Box View**

The Blackboard Assignment tool has an online document viewer and annotation feature that uses a third party technology licensed by Blackboard, formerly known as Crocodoc. Crocodoc was acquired by Box in Fall 2017 and Blackboard has been updated to the new Box View.

Student file submissions are stored in University of Hartford’s Blackboard Learn instance as always. No personally identifiable data about students is sent to Box. Blackboard Learn retrieves a document ID from Box and assigns it to the document. That mapping of Document ID to user, course, assignment, and attempt is tracked locally in Learn. None of that data is available to Box. All that is transmitted to Box is the file for conversion. The converted file is stored in the Box service, as are any annotations made on the converted file.

The New Box view offers a few improvements over Crocodoc, including improved rendering and expanded support of new file types. The New Box view provides a simple and convenient way to annotate student submissions. Prior student work that had been graded and annotated within Crocodoc has been migrated to the New Box view and instructors and students will be able to continue to view those documents.
How to Access Submitted Assignments from the Grade Center

The Grade Center shows all gradable items. The number of items may influence how you organize your time for grading tasks. You may also find it beneficial to view a student's previous grades as you grade.

To grade a single assignment attempt:

1. Go to the Grade Center.
2. Locate the cell for a student's assignment containing an exclamation mark.
3. Access the cell's contextual menu and select Attempt.
4. The Grade Assignment page appears.

To grade all submissions for an assignment:

1. Access the assignment column's contextual menu.
2. Select Grade Attempts.
3. The Grade Assignment page appears.

About the Grade Assignment Page

You access the Grade Assignment page from the Needs Grading page or the Full Grade Center. You can navigate among users and attempts, view rubrics, grade anonymously, and view information about an assignment.

Assignment submissions created with the content editor are not compatible with inline grading. Submissions of this type show in the window, but annotation is not available.
Annotations in New Box View

A. Draw directly on the document
B. Review and comment directly in the document.
C. Input the grade. Grade the submission from the inline grading sidebar. From here you can view the assignment details, the grading rubric and each attempt.
D. Give feedback to learner. You can type an overall grade and grades for each attempt as well as provide feedback to your students without leaving the page.
E. Download the document.
F. On the action bar, you can:
   - Click Hide User Names to grade attempts anonymously. Click Show User Names to display user information.
   - Click Jump to and select another attempt to view or grade.
   - Navigate among available attempts.
How to Use the Annotation Tools

Drawing Tool
Click the Pencil icon in the viewer toolbar, then press down and draw on the document. Click **Done** when finished.

![Drawing Tool Example](image)

Comment Tool
Click on the Comment button in the viewer toolbar, then click anywhere within the document to place the comment. Type your comment into the box, then click submit.

![Comment Tool Example](image)

Adding Comments to the Document in the New Box View

![New Box View Example](image)
To delete the comment, click on the chat bubble within the document again, then click the trashcan icon to remove it. Then click **Delete**.

**Inline Grading Panel**
The inline grading sidebar gives you all of the tools you need to grade the assignment inline.

A. Expand assignment details to show the information from the assignment content item.
B. Collapse or expand the grading sidebar for more screen real estate.
C. Select additional attempts from a drop-down list. Click the attempt to load the submission in the inline viewer and update the sidebar with the appropriate attempt-related data.
D. Type a grade for the attempt.
E. Download the originally submitted file. If more than one file was submitted for the attempt, all files are available here.
F. Expand the Inline Panel to view the rubric and comments fields.
   - Use the grading rubric associated with the assignment.
   - Add private notes, not visible to the student as feedback.
   - Type feedback the student can see and attach files. You can expand the feedback field to take advantage of the full content editor features.
**Supported Formats**

PDF, PPT, PPTX, DOC, and DOCX are the best formats for students to submit and are also supported by the SafeAssign tool.

New Box View only supports annotations on these file formats: AI, BMP, DCM, EPS, GIF, PNG, PS, PSD, SVS, TGA, TIF, and TIFF.

The converted document is displayed in the New Box viewer on the Grade Assignment page. Formatting and embedded images of the original document are preserved in the conversion.

The viewer is supported on current versions of Firefox, Chrome, Safari, and Internet Explorer. No plug-in or other application is necessary, though some users have reported issues in Safari or Internet Explorer. If you are experiencing issues, try switching browsers.

Users may experience a delay in the processing of their file (usually a few seconds). Depending on their browser, the viewer pane may or may not refresh automatically. If it does not, use your browser’s refresh button to refresh the screen.

If a student has uploaded a file that is not in a format supported by the inline viewer, you are prompted to download the file in question. You will not see the inline viewer.

---

**Activity: Making Annotations on Uploaded Documents**

In this lesson, we learned how to use the Annotation tools in the Inline Grading panel to markup students’ submitted documents. In your *Practice Course* we had a sample student submit a paper. Go to the Grade Center in your *Practice* Course and locate an assignment that needs grading. Practice using the annotation tools in Blackboard to markup and grade your student’s paper.
Blackboard Assignments are now integrated with the digital plagiarism detection program, SafeAssign. Faculty users have found the program to be effective both as a learning tool for students and as a deterrent to plagiarism. To find out about additional strategies for reducing plagiarism in your courses, visit the University of Hartford Center for Reading and Writing website at [http://uhaweb.hartford.edu/crw/main.htm](http://uhaweb.hartford.edu/crw/main.htm).

SafeAssign is a plagiarism detection tool. Papers or other assignments are submitted and cross-checked against public internet documents, ProQuest, and the collection of all papers submitted to SafeAssign by instructors and students from other institutions. Blocks of suspicious text are highlighted in a report, which also displays the percentage of suspected plagiarized text and a list of suspected sources. Scores over 40% indicate a high probability of plagiarism. While SafeAssign will help, it will not catch all incidents of plagiarism.

Since SafeAssign can’t tell if suspicious text is properly cited (and therefore not plagiarized), Blackboard recommends all reports be carefully reviewed by the instructor. **Instructors should consult Blackboard’s SafeAssign Instructor Manual for detailed instructions on using SafeAssign and reviewing SafeAssign Reports.** A link to this manual can be found on the FCLD website: [http://hartford.edu/fcld](http://hartford.edu/fcld).

**Three Ways to Use SafeAssign**

There are three ways to use the SafeAssign tool, and you need to decide which of them, or which combination of these you will use. Regardless of the method used, the instructor will be able to view the report returned from SafeAssign. Each method requires safeguards and notifications:

1. **Submission of drafts by students (recommended):** The instructor can set up a SafeAssignment so that students submit drafts of their assignment and then both can view the completed SafeAssign report. Students use a browse button to upload their drafts, and then they can then review SafeAssign’s report to check and proof their own citations to correct and rewrite their work. In this case, the student work is NOT added to SafeAssign’s collection of submitted works. **The primary purpose of using this method is for students to learn about plagiarism, especially unintentional plagiarism, and to rework their paper for final submission later.** After corrections are made, the paper can be resubmitted again through a second SafeAssignment that is not set up in draft mode – this second time, the paper will be added to the collection of papers.

2. **Submission of completed assignments by students:** The instructor can set up a SafeAssignment so that students submit completed assignments. The instructor can elect to reveal the report to the students. Students’ work is automatically added to the University’s SafeAssign collection of submitted files in this case. **Make sure students understand that by submitting their papers in this way, the paper will be added to the collection and it is considered ‘handed in’ to the instructor as well.**

3. **Direct submission of assignments by instructor (no access for students):** Instructors use a browse button to upload submitted papers and check for plagiarism. The instructor has the option of adding the submitted assignment to the SafeAssign collection of submitted
files. However, this last course of action raises issues of privacy and permission, and is not recommended without securing written permission from students.

**Student Notification**

The sections below were based on documentation provided by the University of Kansas and were used with permission.

If you plan to use the program for any of the three purposes listed above, please insert a statement such as the following into your syllabus:

*The issue of digital plagiarism has raised concerns about ethics, student writing experiences, and academic integrity. Although you may never have engaged in intentional plagiarism, many students do incorporate sources without citations, which is a form of plagiarism. The University of Hartford subscribes to a digital plagiarism detection program called SafeAssign, which you can use to check papers for this course and see whether you may have included in your paper material that requires a citation. Further instructions will be given in class.*

If you plan to use option two above, please insert an additional statement such as the following:

*You will upload your work to Blackboard through SafeAssign so that it can be checked against web pages and databases of existing papers. Your paper will then automatically become part of that database for future use.*

If you plan to use option three above, please insert an additional statement such as the following and provide a form of written permission:

*You will upload your work to Blackboard so that your instructor can have it checked against web pages and databases of existing papers using SafeAssign. Your paper will then automatically become part of that database for future use. Attached to this syllabus is a permission form allowing this use of your work. If you have any concerns about this use of your work, please let me know immediately. Otherwise, please return the permission form before the first assignment is due.*

**Getting Started with Safe Assign**

SafeAssign assignments are now integrated and designed to be added to Blackboard content areas (e.g., Course Documents, etc.) using the Blackboard Assignment Tool. It is not possible to use SafeAssign on a Blackboard document or assignment already uploaded to a course, so instructors must decide to use SafeAssign when they first set up an assignment in Blackboard. Students using MAC computers should download and use the Firefox browser, or they can change the Safari security settings to accept all cookies.
Activity: SafeAssign for Student Use – Draft Submission

SafeAssign assignments are now integrated and are designed to be added to Blackboard content areas (e.g., Course Documents, etc.) through the Blackboard Assignment Tool. Marks in front of the assignment link help distinguish a posted assignment from regular posted files.

The following section outlines the steps instructors take for setting up SafeAssign so students can check their own papers prior to final submission. Since this is for the student’s use only, you will need to add another non-draft SafeAssignment or provide some other means for submitting the final paper to you:

1. Select a content area for your assignment (e.g., Course Documents, etc.).

2. From the Assessments menu, select Assignment.

3. Type a name for the assignment, designate a point value (for grading), and enter instructions for the students on how to complete and submit it. Be sure to include a reminder to use the Submit button!

4. Select Yes to make assignment visible to students, select tracking if desired, and set availability dates if desired.

5. Submission Details: SafeAssign is now integrated into regular Blackboard Learn Assignments under this section. In this section, to accept a Draft Submission, you will check:
   - Check submissions for plagiarism under SafeAsign
   - Allow students to view SafeAssign originality report for their attempts
   - Exclude submissions from the Institutional and Global References Databases
   (This allows students to check their own papers, but without submitting them to the collection of papers, otherwise their final submission could end up 100% plagiarized if it was found in the collection.)

6. Optional: Create a course announcement to let students know that it is available to use.

7. Click Submit and OK.
Once the Assignment is set up, students go to the content area of the course, click on the View/Complete button and use a Browse button to submit files. After submitting, the student can click on the View/Complete link again to view the SafeAssign report. There will be a delay anywhere between several minutes to several hours before the report shows up. Be sure you provide your students instructions on how to read and interpret the reports, and to assure them that some of the matches are simple text found over and over again on the web, etc.

NOTE: If MAC PC users encounter trouble submitting papers to SafeAssign using the Safari browser, tell them to download and use the Firefox browser.

When setting up a SafeAssignment, check the box for “Exclude submissions from the Institutional and Global References Database.” If you do NOT use Draft mode, the work gets saved to SafeAssign’s database and subsequent submissions of that work will be flagged as plagiarized since it matches the first one in the database.

**Setting Up SafeAssign for Student Use – Final Submissions**

There are two ways to do this:

- Create a new SafeAssign assignment from scratch and follow all the steps above, but when you get to step 7, deselect the Exclude submissions checkbox.
- Go back into the current assignment after students have submitted and uncheck the Exclude submissions checkbox.

From that point forward, all entries will be submitted into the database and if they enter multiple drafts after this point, they will show as 100% plagiarized.
**Instructors – Direct Submit (student permission recommended)**

Direct Submit may be used by the instructor to privately check and/or submit papers. Instructors also have the option to submit it as a draft.

To use Direct Submit:
- Go to Course Tools.
- Select SafeAssign.
- Select Direct Submit.
- Select Browse to locate the file you wish to submit, or copy and paste text into the text box.

The instructor has the option of submitting it in draft mode or adding the submitted assignment to the SafeAssign collection of submitted files. **However, this last course of action raises issues of privacy and permission, and is not recommended without securing written permission from students.**

**Instructors - Viewing Reports Submitted by Instructor in Direct Submit**

Once an instructor has submitted papers through Direct Submit, they are processed by SafeAssign. To view these reports, click the SafeAssign checkmark icon corresponding to that paper, which is found in the SA Report column of the report table, as seen below.

Instructors also have the option of submitting more than one file at a time. To do this, put the set of papers you wish to submit in a folder, and then zip the folder. Once the folder has been zipped, you can upload it to SafeAssign as though it were a single paper.
Whether papers have been submitted together or singly, the instructor has the option of sorting and organizing them in folders. The SafeAssign reports and folders are accessible to anyone with instructor rights in the course.

**Instructors - Viewing Reports Submitted by Students**

Any papers submitted to SafeAssign by students be viewed by the instructor through the Control Panel.

1. Go to: **Course Tools > SafeAssign > Safe Assignments.** You will see a list of all your SafeAssignments.

![List of all SafeAssignments in Course]

2. Next to the SafeAssignment you wish to view, use the chevron arrow to select **View Submissions.**

3. All papers submitted for the assignment appear in a grid, showing the time and date they were submitted.

4. Click on the green checkmark in the SA Report column to access student reports.

![List of Reports for each Student who Submitted the Assignment]
The instructor has several options for managing submitted files:

<table>
<thead>
<tr>
<th>Download all Submissions</th>
<th>Saves all submitted assignments in a downloadable zip file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Shows text, authorship and student comments on a paper.</td>
</tr>
<tr>
<td>File</td>
<td>Opens (or Saves) an individual paper for downloading.</td>
</tr>
<tr>
<td>Matching</td>
<td>Shows the percentage of text matched to other sources.</td>
</tr>
<tr>
<td>SA Report</td>
<td>Opens SafeAssign’s report on a paper.</td>
</tr>
<tr>
<td>Submitted</td>
<td>Shows time and date submitted.</td>
</tr>
<tr>
<td>Clear Attempt</td>
<td>Removes paper from the database and allows student to resubmit.</td>
</tr>
</tbody>
</table>

During peak periods, such as mid-terms and finals week, there may be delays in getting reports back from SafeAssign. If you experience delays longer than 24 hours, please contact FCLD.

Student submissions to SafeAssign are compared against several sources:
- Institutional document archives: Contains all papers submitted to SafeAssign by users in their respective institutions.
- Global Reference Database: Contains over 15 million papers volunteered by students from Blackboard client institutions to help prevent cross-institutional plagiarism.
- ProQuest ABI/Inform database: More than 1,100 publication titles and about 2.6 million articles from the 1990s to present time, updated weekly.
- Internet: SafeAssign searches across the broader internet for matching text using the Yahoo! BOSS search service as the underlying internet index provider.

**Copying SafeAssign to a New Course**

If you copy course content and assignments from one course to another, you will need to synchronize SafeAssign before having your students submit assignments. When you synchronize SafeAssign, Blackboard updates the links to the SafeAssign database to ensure submissions are read and graded correctly. Here are the steps for synchronizing SafeAssign:

1. Enter your new (copied) course.
2. In the Control Panel, go to Course Tools > SafeAssign > SafeAssignments.
3. Click on the Synchronize this course button. You will receive a green confirmation bar when the synchronization is complete.

![Click Synchronize this course after copying to a New Course](image-url)
Rosters and Managing Users in Blackboard Courses

Instructors are able to view rosters and add users* to their Blackboard courses (other instructors, teaching assistants, and/or sample/test student account only).

You should never add students manually to the Blackboard course with the exception of your test student. When you add a student manually, they do not sync up to Banner for grades.

To view rosters/users in your course, go to your course:

1. On the control panel on the left, look under Course Management.
2. Click the Users and Groups link to expand it.
3. Click on the Users link.

Compare the student users you see here with what you are showing in the Self-Service Center.

The Enrollment Process

- Students are automatically enrolled in Blackboard courses.
- Enrollment changes in Banner may take 24 hrs. to update in Blackboard.
- If you manually enroll students in your course, you can break the automatic linkages between Banner and Blackboard.
**Checking Enrollment**

1. At the start of your course, compare Banner (Self Service) and Blackboard rosters.

2. If there is a discrepancy between the rosters, contact the students to verify when they enrolled.

3. If the student is missing from the Blackboard roster and enrolled more than 24 hours before, send an URGENT email to FCLD.

**Remember!**

For students to see your course in Blackboard, they must be on the Blackboard roster, and the course must be available. It’s a good practice to make the course available one week before it starts.

**Help! I deleted all my students!**

Sometimes it may appear that your students have deleted. It may be that you had tried to search for a student previously and their name or data may be in the search field.

To see your full roster in the users screen, set the **Search** box to: Username → Not blank → Delete any text in the next box → Click **Go**

![Users](https://via.placeholder.com/150)
Activity: Add a Test Student to Your Course

To add an instructor, teaching assistant or test student ONLY (see prior caution), follow these steps:

1. Click the Enroll User button → Find Users to Enroll (Do not enter anything into the search box next to Go on this screen.

2. On the Add Enrollments screen: (Your course ID) screen, under Enroll Users Enter the first part of the person’s Hartford email (before the @ sign) into the Username box. Click the dropdown to change it to the type of user they will be. At University of Hartford, we only use: Instructor, Teaching Assistant and Student. You should not be manually entering students into Blackboard courses except your own test student account, which begins with an underscore (_username).

3. When done, click Submit. Check the roster to make sure they appear. This will not work if the user is not in Banner and does not have a University of Hartford email account set up.
You’ve got your course set up for the term, but now it’s time to make it available to students to access. Until you make a course available, students who are enrolled cannot see it on their Blackboard Home page course list. Here’s how to set it to available:

1. On the control panel on the left, look under Course Management.
2. Click on Customization → Properties.
3. In the Properties window, you can update the Name of your course in this area (if you have multiple sections).
4. Go down to section 3. Set Availability, then click the Yes radio button.
5. **DO NOT CHANGE ANYTHING ELSE.** Click Submit.

**NOTE:** You can now set course availability from anywhere in your course

1. Navigate to your course.
2. Click the lock icon in the upper right (between the Student Preview eyeball icon and the Edit Mode) to toggle Availability on or off (red is off).

**Toggle Course Availability**
SEMINAR 4:
FOSTERING INTERACTION AND COLLABORATION

Distance education means there is “a distance between learner and teacher which is not merely geographic, but educational and psychological as well” (Moore, 1983). One hallmark of a well-designed online course is that it uses interaction to close up this distance, building in lots of different ways for students to work together and form their own online community. During this seminar, participants will learn how to foster and encourage interactivity using tools such as the Discussion Board, Blogs, Wikis, Journals, and other non-Blackboard tools.

Learning Objectives

✓ Formulate ways to facilitate group work in an online course, create Groups and understand how they work in terms of viewing group work in various tools.
✓ Be aware of the importance of creating essential questions that prompt deep, analytical, and thoughtful responses leading to a lively discussion. Create forums and threads to facilitate Discussions in Blackboard.
✓ Create a blog, wiki and a journal. Describe and contrast ways to use one or each in your online course.

Seminar Contents

Interaction and Collaboration ..................................................................................................... 107
Using Groups as a Collaboration Tool........................................................................................ 110
Article: Different Types of Group Work: Clearing up the Confusion........................................ 119
Article: How to Design Effective Online Group Work Activities............................................. 121
Article: Five Steps to Improving Online Group Work Assignments........................................... 122
Article: Fostering Collaboration in the Online Classroom ......................................................... 126
Discussion Boards....................................................................................................................... 128
Article: The Art of Asking Questions........................................................................................ 138
Distinction between Blogs, Wikis and Journals ................................................................. 141
Blackboard Blogs, Wikis and Discussions Comparison Chart................................................... 151
Seminar Activities
Activity: Creating a Random Enroll Group................................................................. 116
Activity: Creating a Discussion Forum........................................................................ 135
Activity: Replying to a Threaded Discussion............................................................. 137
Activity: Blackboard Journals.................................................................................... 142
Activity: Blackboard Blogs......................................................................................... 144
Activity: Blackboard Wikis......................................................................................... 148

Additional Resources/Web Sources
Visit the Seminar 4 Learning Module in your Preparing to Teach Online course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
In earlier lessons, we said you should try whenever possible to build in some form of interaction. This closes up the distance for learners, helps them build a sense of group, rather than feeling isolated. It also allows learners to share their own expertise with the class. Remember adult learners like interaction. They want to share.

**Why do we need interaction and collaboration?**

- It’s lonely out there.
- It’s better learning.
- It’s better suited for adult learners.

We need it to close distance, but also because it is a good match for who our learners are – adult learners.

- Adults tend to more self-directed and they need to know why they need to learn something.
- Adults possess personal histories which define their identities and serve as a learning resource for themselves and others.
- Motivation in adults is internally based, for example, self-esteem, curiosity, desire to achieve and accomplish.
- Adult learners have interest in immediate application for problem-solving. Their need to learn something is likely based on a need to solve real-life tasks.
- In other words, they like to ‘do’, apply knowledge. They like to interact and share themselves and their experiences. They want to be a partner in their learning. So, we build in interactions and collaboration to help meet these needs.

Michael Moore (1989) identified three types of interactions that should be planned for when developing an online course:

- Student-to-Student
- Student-to-Instructor
- Student with content

How do we accomplish this?

- Create and facilitate student-centered instruction
- Provide formal and informal ways to interact
- Choose activities and tools that will help foster interaction and collaboration
- Give lots of individual and whole-class feedback

Create and facilitate student-centered instruction

As an instructor face to face, you smile or frown, nod, make eye contact, walk around, etc., which are all ways to guide your students to say more or continue along that line of thinking, etc. You can do this online.

Just like you might in a face-to-face class, provide ways to draw out the understandings, guide the discussion. Try to refrain from coming in as the expert. Don’t immediately jump in. See if another student can provide the answer. Help learners take charge of their own learning. Provide lots of resources for them. Be flexible. Know when to direct, to step back, or to summarize.

You still need to provide guidelines, expectations, and rubrics which help define participation and what quality contributions are. For instance, as your students begin to post in the discussion board, keep an eye on the discussion to pull it back to the topic, if necessary, by creating a post, or post a few more leading questions to draw out more responses, or gently correct if necessary. But as much as possible, create detailed assignments, rubrics, assignment schedules, etc.
Provide formal and informal ways to interact
- Group assignments
  - Allow students use of the various tools in Groups so students can use email, private disc boards, etc., within their groups.
- Discussion Board
  - Create topic forums and ‘water cooler’ forums
- Journals for reflections
- Blogs for ‘opinion’ pieces
- Wikis for creating group projects

Choose activities and tools that will help foster interaction and collaboration
- Group Projects
- Wikis, where student create projects together
- Blogs and Discussion Board, where students can read and comment to each other
- Journals, where instructors and students have a private space to write and comment to each other

Give lots of individual and whole-class feedback
Offer feedback in each assignment by annotating student work, using the feedback features of Blackboard tools such as inline grading via the Grade Center, comments in Wikis, Journals, Blogs, and where else possible. Create Announcements that offer general feedback about students’ work in the course each week, for instance. Provide lots and lots of feedback. Remember, instruction is a feedback loop.
Using Groups as a Collaboration Tool

Tips for Groups (Davis, 1993)

- Make the group work relevant to course objectives
- Assign group tasks that allow for a fair division of labor and assign group members based on skill strengths
- Keep groups together
- Regularly check in with the groups
- Provide mechanisms for groups to deal with conflict and/or uncooperative members.
- Provide private space for groups to work (Blackboard groups)

Accessing Groups (Instructors)

1. Find Groups in Control Panel under Users/Groups.

2. Click on the arrow to reveal a menu that may be helpful for maintaining and communication with your groups.
**Accessing Groups (Students)**

1. When students are assigned to a group, they can find it in the ‘My Groups’ box directly under the Course Menu. They can click the right-facing arrow to show more details such as their group members, and links to the tools they can use in their group.

Students only see links to groups they have been assigned to as a member and only group members can collaborate and use tools within the group.

Instructors can see/comment/contribute/interact/collaborate within ALL groups.

---

**Creating Groups in Blackboard**

Blackboard can be used for student group projects and other small group activities. Blackboard groups allow smaller groups of students to meet online privately to share and exchange files, send group emails, participate in discussion boards, collaborate using blogs and wikis, and meet to chat in virtual classrooms. It’s especially useful to be able to create groups if an instructor has multiple sections enrolled in the same Blackboard course, as each section can be set up as a group allowing the instructor a means to communicate with each section individually.

Blackboard now has 3 ways to add students into groups:

- **Self-Enroll** – Students can select which group they want to join.
- **Manual Enroll** – The instructor creates the groups and enrolls students in each group.
- **Random Enroll** – The instructor creates the groups and Blackboard assigns students to the groups randomly.

Creating a group has two parts: first you create the groups, and then you assign students to the group.
To create groups in your course:

- In the Control Panel of your course, click on Users and Groups and then Groups.
- Point to Create Group Set in the Action Bar and select the type of groups you would like to create. (The options available to each group are the same.)
- Give the groups a name such as ‘Final Project Group’. Blackboard will add a number to each group name (e.g. ‘Final Project Group 1’, ‘Final Project Group 2’).
- Make sure Group Available is set to Yes.
- Decide which tools you would like to make available to each group:
  - Blog – Students can keep individual or group blogs. Both students and the instructor can comment on blog posts. Blogs can be graded.
  - Collaboration – Group chat tools.
  - Discussion Board - Group members can have discussions with one another. Note that instructors must set up the forum for students. If there isn’t one there, contact your instructor.
  - E-mail – Group members can send emails to the members of their group.
  - File Exchange – Group members can share files. Be sure to append filenames with initials to avoid overwriting each other’s files.
  - Journal – Group members can keep individual journals. Only the instructor can read student journal entries. Journals can be graded.
  - Tasks – Group members can set tasks with due dates and priority levels.
  - Wiki – Group members can collaborate on a wiki. Wikis can be graded.

The final steps for assigning students to groups will vary according to the option you have chosen.
**Self-Enroll**

If you are allowing students to choose their own groups, select the **Self-Enroll** option under **Group Set**.

Under **Group** is visible to students, click **Sign-Up Sheet Only** unless you want them to be able to sign up and then get straight to work without your approval. If ok to sign up and go to work, click **Yes**.

- Under **Sign-up Options**, give a name for the sign-up sheet and instructions for signing up.
- Select the maximum number of students that can enroll into each group.
- If you want students to see who else is in a group before signing up, click on **Show Members**.
- Select the total number of groups you would like to create.
- Click **Submit**.

When your students log in to your course, they go to **Tools → Groups** to see the group signup sheet. From here, they can click on a button to sign up for a group.
**Manual Enroll**

If you want to choose which students should go in which groups, click the Create Button, and then under Group Set select the Manual Enroll option.

- Enter a name for the groups, then under Group Set Options, select the number of groups you would like to create.

![Group Set Options](image)

- Click Submit. A new window will open up, allowing you to choose members for each group. Under each Group, click the Add Users button.
- In the Add Users menu, check each of the students you want in that group. When done, click Submit.

![Add Users](image)

- Click on the X next to the student name to remove them from the group.
• Use the **Add Group** and **Delete Group** buttons to add or remove extra groups if needed.
• When you have assigned students to each group, click **Submit** at the bottom of the page.

**Random Enroll**
Blackboard can also assign students into groups automatically. The instructor has the following options:

• **Determine Number of Groups by:** Choose either the number of students you want in each group or the total number of groups you want, and Blackboard will divide the students accordingly.

• **Determine How to Enroll any Remaining Members:** If the groups do not divide out evenly, you can choose to distribute the remaining members amongst the groups, put the remaining members in their own group, or manually add the remaining members to groups.
Activity: Creating a Random Enroll Group

Go to your *Practice Course* and create your first group, letting it randomly select sample students from your course.

1. On the control panel under *Course Management*, go to *Users and Groups*, then click on *Groups*.

2. In the *Groups* window, click the *Create* button, then click *Random Enroll*.

3. Give your Group Set a name (here you will select a generic name, ie) Groups – and if there is more than one group, it will automatically number it: Group 1, Group 2, etc. Fill in the description. Set the group visible to students.

4. Choose whether or not to grade the group, and other options.

5. At the very bottom, set your membership settings (Number of Students per group, number of groups, etc.)

6. When done, click *Submit*. 
Editing Group Settings
To edit the settings for a single group, go to Control Panel → Users and Groups → Groups. Click on the chevron next to the group name and select Edit. From here, you have the following options:

- **Group Information**: Edit the group name, add a description, or change the group availability.
- **Tool Availability**: Change which tools are available to the group, and decide which tools you want to include in the Grade Center.
- **Module Personalization**: Check Allow Personalization to let group members personalize their own group space.
- **Membership**: Add members to (or remove members from) the current group.

Instructor Access to Groups
To access individual group pages, go to Control Panel → Users and Groups → Groups and click on the group name. From here, you can view and grade students’ work in all of the group tools, including Blogs, Wikis, Journals and the Discussion Board.

Starting the Group Discussion – Adding Threads
If you would like students to post in the Group Discussion Board, you need to create a thread to “kick off” the discussion.

- Enter a group page and click on Group Discussion Board.
- Click on the group name to enter the forum.
- Select Create Thread in the upper left corner of the screen and add a starter question.
- Use the Reply button to respond to student postings.

Student Access to Groups
When students enter your Blackboard course, they will see their groups underneath the Course Menu. Click on the chevron to the right of the group name to open the page for this group and access the group tools (Blogs, Discussion Board, etc.). Students can only access the groups in which they are enrolled.
Removing/Deleting a Group

To remove a group:

- Go to Control Panel → Users and Groups → Groups.
- Click on the chevron next to the group name and select **Delete**.
- You will receive a warning message. Click **OK** to continue.
- If you have chosen to have graded Group Blogs, Wikis or Journals, a page will open up asking you which items you would like to remove from the Grade Center. Select the items you want to remove, and click **Delete**.

Removing Group Tools from the Grade Center

**So Why Groups? How do we use them?**

The next couple of pages are a couple of articles that we found that give some best practices and tips for using groups in an online environment. We hope that they are beneficial reading to you in setting up groups in your own online course.
Different Types of Group Work: Clearing up the Confusion

By: Maryellen Weimer, PhD

The emergence of different kinds of group work is a welcome outgrowth of the move away from lectures. There’s still plenty of lecturing going on, but there’s less than there used to be. In its place are a variety of activities that more effectively engage students; one of the most common being the use of group work.

As regular readers will know from previous posts, the evidence that students can learn from and with each other in groups is plentiful and persuasive. Group work is fast becoming one of most researched instructional approaches and use of it is widespread. I regularly find articles on groups in all of the 80 or so discipline-based pedagogical periodicals I read.

Four types of group work are best known and most researched: collaborative learning, cooperative learning, problem-based learning (often known by its acronym, PBL) and team-based learning (also known by its initials TBL). From the get-go, definitional confusion about these types has prevailed. Collaborative and cooperative learning labels are still being used more or less interchangeably, or it’s assumed that one is a subset of the other. PBL and TBL are regularly described as forms of collaborative or cooperative learning, which they are not.

A recent issue of the *Journal on Excellence in College Teaching* does a masterful job of clarifying the definitional differences between these forms of group work. As guest editors Neil Davidson, Claire Howell Major, and Larry K. Michaelsen explain, “we attempt to outline key characteristics and important similarities and differences among these instructional methods.” They do with two synthesis articles, and three articles apiece on each type of group work. Article authors are a who’s who of group work researchers and advocates. The ongoing confusion is of concern to the issue editors because of its “implications for research and the development of the field of teaching and learning in higher education, but also for the day-to-day practices of higher education instructors.” (p. 2)

The confusion and co-mingling of these different types of group work diminishes what makes each distinct. Collaborative and cooperative learning, for example, emerged from different philosophical traditions. The design, formation, and assessment of group activities for each are not the same. PBL and TBL, too, operate from different premises and involve different practices. These distinctions are advantageous because they make it possible to use group work to accomplish different instructional objectives. They also mean that some group structures are more suitable for some kinds of content. With a basic understanding of each, instructors can
design group learning experiences that better fit their goals, content, and students’ learning needs.

In the first synthesis article, which compares collaborative, cooperative learning, and PBL (highlights from this article appear in the February issue of *The Teaching Professor*) authors Neil Davidson and Claire Howell Major make clear that their intention is not to advocate for any of the three. They propose that champions of each brand of group work have much to learn from each other, and their hope is that their descriptive analysis will encourage “border crossing.”

For the most part, classroom practitioners are not purists. They’re after what works with their content and for their students. They also don’t particularly care about nomenclature. They’ve taken features from the various kinds of group work and created their own brands. From collaborative and cooperative learning, PBL and TBL have sprung a huge family of related offspring, and that’s good news. The bad news is that these new iterations are using the four family names, which means confusion about the types of group work continues. You could even make the case that the confusion is growing.

If you use group work, want to do so in an evidence-based manner, and would like to accurately label what you are doing, this issue can be your guide. It’s a scholarly analysis of group work, long overdue and done by the best. And the editors of the *Journal on Excellence in College Teaching* are giving Teaching Professor blog readers free access to the issue for two weeks. That’s a real gift. (Thank you, Milt Cox and Gregg Wentzell.) By the way, if you aren’t familiar with this journal, do make its acquaintance. I never miss an issue.

To access the journal, please go to [http://celt.miamioh.edu/ject/index.php](http://celt.miamioh.edu/ject/index.php) and click on Free Sample Issue: Small Group Learning. This will take you to the “Special Focus Issue: Small-Group Learning in Higher Education – Cooperative, Collaborative, Problem-Based, and Team-Based Learning.”
How to Design Effective Online Group Work Activities
By: Mary Bart

There are many reasons why students don’t like group work, and in the online classroom the list of reasons grows even longer as the asynchronous nature of online courses not only makes collaboration more difficult but almost counterintuitive.

In addition, there may be another issue at play that you haven’t even thought about, and it has to do with how group work is designed in the first place.

“Too often we give students an activity and call it group work when in reality it’s something they could do on their own,” says Jean Mandernach, PhD, associate professor of psychology at Grand Canyon University. “Then we get frustrated when they don’t work together and just do the work on their own.”

In the recent online seminar Online Group Work: Making It Meaningful and Manageable, Mandernach provided tips for adapting proven face-to-face group work strategies to the online environment. The key is to design tasks that are truly collaborative, meaning the students will benefit more from doing the activity as a group than doing it alone.

Effective online group activities often fall into one of three categories:

1. There’s no right answer, such as debates, or research on controversial issues.
2. There are multiple perspectives, such as analyzing current events, cultural comparisons, or case studies.
3. There are too many resources for one person to evaluate, so a jigsaw puzzle approach is needed with each student responsible for one part.

Online collaboration tools
While Skype and other real-time collaboration tools make it easier for dispersed students to “get together,” Mandernach cautions against overusing synchronous tools. Instead, she says, you should encourage your students to take advantage of the many asynchronous collaborative tools inside your course management system or some of the new Web 2.0 tools. Some of her favorite Web 2.0 tools include: Tokbox, VoiceThread, Creately, Google Docs, and Teambox.

These tools are relatively easy to use and help build a sense of community in the online classroom. They’re also another way to get students to buy into group work activities and using them makes the students more marketable upon graduation.
“If you can use the collaborative environment to really bring them into your classroom and get connected to you and connected to their peers you’re going to see a lot of benefits besides increased test scores,” Mandernach says. “Many employers and graduate schools really view online learning as learning in isolation, and I think it’s important for students to show that they are capable of collaborative work — that they can work independently and with others.”

**Online group work checklist**

As part of the seminar, Mandernach provided the following checklist for creating and implementing online group projects:

**Preparation**

- Students understand the value of both the process and product of the collaboration.
- Students have guidance concerning how to work in an asynchronous team.
- Group size is small enough to allow for full participation of all members.
- Course provides numerous opportunities for community building prior to group projects.

**Assignment**

- Assignment is an authentic measure of student learning.
- Assignment will benefit from collaborative work.
- Students have clear guidelines of the expected outcome of the collaborative assignment.
- Assignment creates a structure of positive interdependence in which individuals perceive that they will succeed when the group succeeds.
- Assignment is scheduled to allow adequate time for preparation and communication.
- Assignment is designed in a manner to allow students a level of personal control.

**Technology**

- Students are provided with tools and instructions to facilitate online communication.
- Each group has a collaborative workspace within the online course.
- Students have technology skills relevant for asynchronous communication.
- Back-up procedures are in place to deal with technology failure.

**Evaluation**

- Grading and/or evaluation strategies differentiate between the process and the product.
- Strategies are in place to monitor interaction processes.
- Clear grading rubrics are provided at the start of the assignment to guide student work.
- Self and peer evaluations are included in the process to monitor individual involvement and accountability.
Online Group Projects — Yikes! You can hear the moans and groans of students echoing through your computer monitors as you start the first week of your online course. The reasons for requiring a group project vary from one discipline to another, but there are educational and career motives for requiring group projects. Students will have an opportunity to develop team skills, improve communication skills, and leverage their own personal interests and experiences to contribute to a group project.

The skills learned by participating in a group project are applicable to nearly any career that a student is currently interested in or will be interested in at a future date. It is rare in today’s global economy that an individual will work independently on a project. Therefore, it is important that opportunities are provided to students to not only learn content, but to apply that content in a practical, near real-world environment.
Group projects may also cause both students and instructors additional work due to the potential issues that may arise during the course of the project. Issues often involve questions and concerns around grading, equal distribution of work, communication pitfalls, and managing expectations. The following guidelines offer some ways to manage online group projects and establish clear objectives in order to facilitate a robust and engaging experience for each member of the group. These guidelines are based on past experiences as an instructor in computer information systems. You may need to adjust the guidelines based on the specific project you assign.

1. **Define the Project**
The project should be integrated into the course objectives and not be viewed as an extra assignment or busy work. The project should allow students to practice specific skills based on the objectives of the course and demonstrate the ability to apply learning to a specific project.

2. **Establish Milestones**
The project should include specific milestones during the course. For example, require an outline, a project scope, a requirements document, and other pertinent deliverables. This will provide students with the opportunity to work on the project during the course, offer instructors an opportunity to gauge progress and provide feedback, and reduce student stress in terms of submitting one large project at the end of the course without any incremental deliveries and feedback.

3. **Use the Learning Management System (LMS)**
As part of the group project, encourage the use of your LMS. You can offer private group discussion areas, chat areas, and other collaboration tools that will encourage both communication and participation. You can choose to monitor these as well if needed. This promotes the use of the LMS features and offers exposure to different tools that the students may use in future online courses.

4. **Simplify and Clarify Grading**
This is perhaps the most difficult item to address. Groups are made up of individuals and each individual brings a set of expectations and values to the group. It is imperative that you establish clear grading expectations for the group project. You may choose to grade each participate separately or provide one grade for each project deliverable and apply that grade to all participants. The approach to providing one grade to all participants is my preference. I would also recommend periodic team evaluations to be completed. You can require this as the group delivers the incremental components of the project and to gain insight as to how each member is contributing. The peer evaluation may also be used as a percentage of the grade.

5. **Provide Encouragement**
This may be the first time students have participated in a group project, and it is important as an instructor to encourage and communicate the specific details of the project. You should also encourage each member of the group to utilize his/her strengths. Perhaps there is a member who
has strong technical or writing skills and the group should recognize this early in the project and make use of those strengths. Finally, as an instructor you should encourage each group to select a project that each member is able to contribute to and gain valuable lessons from the project. You can require that each group submit an outline or summary for approval as well.

Following these guidelines will not eliminate all of the potential issues that come into play with online group work assignments, but these guidelines will certainly minimize the issues and turn those moans and groans into excited and energized students that can apply the group project to future projects in their careers.

*Gregory Wells is an instructional designer at Colorado State University.*
Fostering Collaboration in the Online Classroom

By: Rob Kelly

Glenda Hernandez Baca, professor/coordinator of teacher education at Montgomery College, Takoma Park Campus, encourages the use of collaborative learning throughout online courses. In an interview with Online Classroom, she offered the following ideas for facilitating collaborative learning in group projects and in threaded discussions:

Make collaboration mandatory. “You have to make collaboration and participation mandatory in your courses. If it’s a choice, if you give students a choice of participating, I think you are telling them that collaboration is not that important,” Baca says. “If you can do something practical, students are going to be so much more engaged. It helps illustrate why it’s important.”

As for their concerns about finding the time to collaborate, Baca says that this is a challenge for everybody and is careful to not dismiss their concerns about the time it will take or the difficulty of coordinating the group’s efforts.

Provide advance notice that there will be collaborative assignments. Given students’ concerns about collaborative learning, it’s essential to let them know well in advance the extent and nature of what will be expected of them in the course. In addition to listing expectations in the syllabus (which she quizzes students on), Baca opens discussion forums between group members a month before a collaborative project begins, to get students comfortable interacting with each other.

Have students create a collaboration plan. There are different ways for students to work collaboratively, and what works for one group may not work for another. This is why it’s important to allow students to develop their own group processes. To that end, Baca has each group devise and submit to her a collaboration plan, delineating who will be responsible for which aspect of the project, how they will communicate, and when tasks will be accomplished.

In addition, she has them answer questions such as the following: What technology are you going to be using? What sources are you going to be researching? What is your backup plan if someone is not participating? Are you going to exchange phone numbers? What technology tools do you think will work best? How do you think this project will be best delivered to the rest of
the class—as a Web page, wiki, or PowerPoint presentation? “They’re all open-ended questions to get them to think about [the collaboration process] because oftentimes they don’t think about those kinds of things until the very end,” Baca says.

**Observe and monitor group participation.** “For some of the discussions I’m very involved as far as posting and responding to students, and saying things like, ‘This is an interesting comment. Can you elaborate on this?’ Just being there helps move the discussion along. For other discussions, like for the open forums for them to work together on collaborative projects, it’s more of me checking in: ‘Can you give me an update as to what’s going on? Were you able to get together as planned?’ It’s just me pushing them along through the process,” Baca says.

For the graded discussion questions she responds to students via email on a rotating basis. “If I have 25 students and they have to post at least twice during the week—and most people don’t just post twice a week, they post a lot more than that—it just gets overwhelming to respond to every student. I want students to know that I’m reading their comments. I think that’s so important, and because I cannot always respond to every single student, that’s my way to make sure that every student at least three or four times during the semester is getting something from me. That tells them that although I may not respond to them every single week, I’m reading their posts and they are valuable to me and the other students. I’m so amazed at how many people say, ‘Thank you so much for the feedback. Oftentimes we have all these discussions and nobody ever says anything about it. Nobody ever responds.’

“I think that is why students feel like it’s a waste of time or they get annoyed at these discussions, because it’s more of a chore and nothing is done with it. There is no meaning. As instructors we don’t always make meaning of their participation. If you’re going to ask students to participate and collaborate and be engaged, you need to be responsive to that and let them know how that comes into the bigger picture of the class and their learning. I think that’s when they understand why we’re doing this and they’re much more open to doing it.”

If our goal is to engage students interactively – not just with course content but also with each other, and with us as the instructor – what might be good strategies for undergrads? Well, there isn’t really any one right way, but here are some thoughts that might get you started. I think the trick is to figure out who your students are and find strategies that work with them.

So what might work for undergraduates? As an instructor, I think it’s probably safe to say that undergraduates students and adult students have some differences in terms of their overall development… So let’s generalize a bit about some of their characteristics:

- They are at a time in their lives where the relevant things are probably more social.
- Most have not yet fully developed higher level cognitive strategies like critical thinking.
- Peer opinion is important to them.
- They’re maybe not so good working in groups.
- They’re probably used to a more passive style of instruction.
- They tend to be focused on where school will get them.
- Emotionally, they tend to see issues in black and white.
- They like to challenge authority (you!).

If these are the general characteristics of undergrads, what can we do to engage them? Here are some strategies you might want to try for undergrads:

1. **Try to make the discussion/content relevant** - Integrate class content into what is happening in their lives today - current events, popular culture, daily experiences. Some discussion guides advocate using controversy. Be cautious about using this strategy as an issue like abortion may prove too explosive.

2. **Allow for some ownership of the discussion** - Find ways to let the students participate and feel like they are partially in charge. Only do this if you are comfortable with it and in ways that work for you. For example, let them help set the ground rules for discussion or help set up forum rules, assist you in choosing a guest lecturer, facilitate discussions, select topics, etc.

3. **Start with more structured style discussion strategies** and gradually lead up to a less structured, more open discussion as they become more confident and some trust has developed. Use group discussions rather than the ‘big’ discussion. You can do this by using small group discussions, plus then having the groups report out to larger discussion. Another idea is to start with small mini assignments until they understand the technology, then go on to more open-ended discussions. Kick things off, but then be willing to try to let go a bit and let the students talk. Encourage them to talk to one another.

4. **Set clear guidelines for the discussion** – What is and isn’t appropriate for posting, what is collaboration and what is cheating? What are appropriate ways to give feedback to each other? Make sure you tell them that your role is facilitator and then stick to it (i.e.,
ask yourself, are they all talking to you or to each other.) Let them know what they can expect from you in terms of responding/reading their posts. Think about what you will do if conflict arises.

5. **If you are comfortable with it, level the playing ground** – Try to be a participant as well as the leader. If you use ice-breakers, participate in it. The aim here is to build group trust because group trust is critical for feeling comfortable and engaging in conversation. Trust must come before natural dialogue, or risk-taking with opinions. If you plan to read their small group discussions (you can), you might want to think about sharing that with them.

The point is to match the strategy with who you have in front of you. Aim to build group trust. Most importantly – do what works for you and for them.

The online discussion is a flexible communication tool that can be used in a variety of ways. The diagram below illustrates the application of online discussions for a variety of teaching strategies.
Example Uses of Discussion Boards

- Use it to submit, share and/or critique individual assignments (raises submission quality).
- Invite guest lecturers to join the discussion.
- Initiate peer-to-peer discussions around content.
- Post group projects/final projects.
- Discuss case studies.
- Use it to cut down on e-mail, i.e., ‘repeat’ questions by having a FAQ forum, then answer only once and all students can read the response.
- Student-facilitated discussion.
- Continue discussions started in class.
- Share information about other internet resources relating to class content.

Tips for Using Discussion Board

- Think twice before you post!!
- Set ground rules and guidelines ahead of time.
- Allow students to help set the guidelines and rules for the discussion (if time allows).
- Encourage your students’ participation.
- Listen…know when to take a back seat.
- Talk to students, not at them.*
- Start off with an ice-breaker or an easy assignment.
- Aim to make discussions relevant to student’s interests.
- Set expected response times so students know when they should expect to hear from you – and when they won’t hear from you.
- Start with smaller group discussions then use the larger discussion for group report-outs.
- Ask open-ended questions rather than ‘yes’ or ‘no’ questions.
- Set the tone; if you want conversation, be conversational.
- Redirect conversations to other students when appropriate.
- Discuss techniques for giving feedback with your students.
- Be sure your starter questions aren’t actually assignments (unless that’s what you want to use the discussion).
- Remember that conflict is a natural byproduct of discussion and can be productive if managed and facilitated – be sure to be proactive.
- Check in with quieter students – encourage them.
- Try to foster and maintain the feeling of connectedness across the entire online course.
- Schedule a computer lab and conduct an orientation on discussion boards.
- Use emoticons and teach them to your students.
- Uphold the integrity of the group’s trust (don’t allow lurkers, etc.).*
- Consider using a rubric for grading discussions.
- Provide discussion examples to your students showing what a substantial post looks like.

**Suggested Resources**


Moore, M. (1989) *Three Types of Interaction*. Panel discussion convened by the Divisions of Independent Study and Educational Telecommunications of the National University Continuing Education Association at its annual meeting in Salt Lake City on 16 April, 1989


**Icebreakers**

[http://acadweb.snhu.edu/DE/Goddard_Gretchen/icebreaker%20activities.htm](http://acadweb.snhu.edu/DE/Goddard_Gretchen/icebreaker%20activities.htm)
Accessing Discussion Boards
There are essentially two types of Discussion Boards in Blackboard – the whole-class discussions accessible via the Course Menu and group discussions. Both can be accessed by instructors by going to Course Management → Course Tools → Discussion Board.

When you create groups, and give those groups the rights to use Discussion Board, you are essentially creating many Discussion Board areas in the course: one for the entire class and one each for the groups. You have access to all of them.

Students can access the Discussions one of two ways:

1. Instructors access Discussion Board tool in Course Tools… this links to all

2. The course number that appears at the top of the list links to all your full class discussions (all students have access).

However, all Discussion Boards show in this instructor view, so if you have created Groups that use the Discussion Board, they will be listed here as well.
The whole-class Discussion Board is available on the main Course Menu under Discussion Board, or via Blackboard Tools.

Course groups can have their own discussion boards. Group discussion boards are available only to users who are members of the group. If a group discussion board is available, access it from the groups link on the course menu or in the My Groups area.
**Inside a Discussion Forum**

Click a forum title to view the messages. Forum titles in bold contain unread posts.

View data on the number of posts and participants.

Click the number in the Unread Posts column for one-click access to a forum’s unread messages.

![Image of discussion forum interface](image-url)
Activity: Creating a Discussion Forum

To create a forum, go into your course, click the Discussion Board link on the Course Menu, then click the Create Forum button.

1. Access the discussion board and click Create Forum on the action bar.
2. On the Create Forum page, type a name and optional instructions or a description. On the main discussion board page, the description follows the forum name.
3. In the Forum Availability section, click Yes. Another option is to create forums ahead of time and set the availability to No until the discussion is ready to start.
4. Select the Display After and Display Until check boxes to enable the date and time selections. Display restrictions do not affect the forum availability, only when it appears.
5. Select the Forum Settings based on your specific needs.
To promote originality, creativity, and a variety of responses, you can choose Participants must create a thread to view other threads in this forum, which is the post first setting. Students must respond before they can read their classmates' posts.

In Standard View, users can see all previously created threads in the forum.

6. In the Grade and Due Date section, set your options accordingly. Selecting Grade Discussion Forum and inputting a point value also enables the Add Rubric button from which instructors can Select Rubric, Create New Rubric or Create from Existing.

Adding the Due Date will not allow students to submit posts after that date.

7. There are several other options to choose from in the Forum Options, select them if you wish to use them.

8. When done, click Submit.
Creating Threads
Within each forum, users can create multiple threads. A thread includes the initial post and any replies to it. Instructors have the option of allowing or not allowing students to start threads.

When you view the thread page, all posts and the forum description appear on one page. Forum descriptions are often used as prompts for discussion and are visible where you are posting. Large images of course members help you easily identify authors.

To help make replying easy, a Reply button appears directly below the post you wish to reply to. Clicking the Reply button opens up a text box in which you can type your reply and then click Submit when done.

Forum settings control who can post, and what other types of actions you can take, such as editing your own threads, posting anonymously, or rating posts. Depending on which forum settings your instructor has selected, you may be allowed to create a new thread.

Activity: Replying to a Threaded Discussion
In this exercise, you will practice replying to a thread that has already been created. Go to the Preparing to Teach Online course and go into the Introductions Forum and post a reply to the first thread you see there.

1. From the Course Menu, click on Discussion Board.
2. In the Discussion Board window, click the forum link for Introductions.
3. Click on the thread link Intro.
4. Read the introduction prompt and click the Reply button.
5. Append the Subject with your name (ie: Re: Intro – First Last) and type your introduction into the Message field.
6. When done, click Submit.

The following article from Faculty Focus centers on the art of asking questions. It gives some excellent pointers to get conversations started on your discussion boards.
At one time or another, most of us have been disappointed by the caliber of the questions students ask in class, online, or in the office. Many of them are such mundane questions: “Will material from the book be on the exam?” “How long should the paper be?” “Can we use Google to find references?” “Would you repeat what you just said? I didn’t get it all down in my notes.” Rarely do they ask thoughtful questions that probe the content and stir the interest of the teacher and other students.

So, how do we get them to ask better questions? What if we start by asking them the kinds of questions we hope they will ask us? Here are some suggestions that might help us model what good questions are and demonstrate how instrumental they can be in promoting thinking, understanding, and learning.

Prepare questions — Too often we ask questions as they come to us. Allen and Tanner write in an excellent article on questioning, “Although many teachers carefully plan test questions used as final assessments, … much less time is invested in oral questions that are interwoven in our teaching.” (p. 63) How many questions of the kind that generate discussion and lead to other questions come to us as we are teaching? Would more of those thought-provoking questions come to us if we thought about questions as we prepare and contemplate the content for class?
Play with the questions — Questions promote thinking before they are answered. It is in the
interstices between the question and the answer that minds turn. In that time before answers,
questions can be emphasized by having them on a PowerPoint or on the board and by
encouraging students to write the question in their notes. Maybe it’s a question that opens class
and doesn’t get answered until the end of class. Maybe it’s a question that gets asked repeatedly
across several class sessions with any number of possible answers entertained before a “good” or
“right” answer is designated.

Preserve good questions — If a question does generate interest, thoughtful responses, and good
discussion, that’s a question to keep in some more permanent way than simply trying to
remember it. Good questions can be preserved along with the course materials for that day.
Finding them there next semester enables us a revisit and possibly improve them. Do we need to
be reminded that probing questions about the content, not only encourage students to think, they
are good grist for the mill of our own thinking?

Ask questions that you don’t know the answer to — Students tend to think that teachers have
all the answers. Could that be because we answer all their questions? Marshall makes a point
worth remembering. Typically we ask students questions that we already know the answer to and
if any of you are like me, while the student is answering, I’m quietly thinking how much better
my answer is and how I will quickly deal with the student’s answer so I can then give my
answer. Asking a question you don’t know the answer to lets students know that you still have
things to learn. Asking students those questions and then thoughtfully attending to their answers
also indicates that you just might be able to learn something from a student. Could this be a way
to motivate them to ask better questions?

Ask questions you can’t answer — These questions are different from those you don’t know
the answer to. It’s possible to find answers to those questions. These are the questions currently
being confronted within the field or area of study that haven’t yet been answered. As of this
moment, the answers are unknown. A question that can’t be answered is inherently more
interesting than one that can be answered. Are there theories or research findings that suggest
answers? Are some of those more likely than others? Could the answer be something totally
unexpected? What if a student thinks she might have an idea about a possible answer?

Don’t ask open-ended questions when you know the answer you’re looking for
— Sometimes students offer answers but they aren’t the ones the teacher wanted to hear. If you
aren’t getting the answer you want, don’t play the “try to guess the answer I have in mind” game.
It reinforces the idea that the question has one answer that the teacher thinks is the right or best
answer. If the teacher has the answer, students are quick to conclude it’s the definitive right
answer, and that makes it an answer that they won’t spend any time thinking about.

We ask questions to get students interested, to help them understand, and to see if they do. We’d
like for our questions to promote lively discussions during which thoughtful perspectives are
exchanged, different views presented and new ideas are born. To accomplish that goal we need
to plan and use question in more purposeful ways. If questions start playing a more prominent
role in our teaching, the reward may be students asking questions we’d find interesting to answer
and they’d find more interesting to discuss.
Shouldn’t an article on questioning end with one? It should, and Allen and Tanner have a great one: “What would you predict would happen in your classroom if you changed the kinds of questions that you ask?” (p. 63)

**References**


**Distinction between Blogs, Wikis and Journals**

Instructors can cultivate collaborative learning and interaction between students, between students and their instructor, and with the course content through the use of Blackboard’s blogs, wikis and journals tools.

- **A blog** (short for “web log”) is a type of website that is maintained by a single author or group of contributors. A blog is a collection of entries (or “posts”) of commentary, news or descriptions of events, and may include text, links, photos or video. The entries are most commonly arranged in reverse-chronological order, with the most recent post appearing on top. On the Internet, blogs are generally public to the world, although they may also be geared to smaller, more defined groups. Readers are able to respond to posts by leaving comments. One example of a group blog is Crooked Timber ([http://www.crookedtimber.org](http://www.crookedtimber.org)), a political blog run by a group of academics from around the world. Good ideas for using blogs in teaching and learning include encouraging reactions to class readings, course content or current news events; or for following up on class discussions with relevant links or materials. NOTE: Blogs that are made ‘public’ in Blackboard are only available to the students registered in the course.

- **A wiki** is a series of linked Web pages collaboratively created by many authors. They are collections of information organized with one topic per page of the wiki, and are available to the world to read and often to write. One of the most well-known wikis on the Internet is Wikipedia ([http://wikipedia.org](http://wikipedia.org)). Wikis can be used in teaching and learning to build a glossary of terms, create a knowledge base, write a collaborative document, create a collection of clarifications or explanations, organize signups for class presentations, or show the steps for working out specific problems in a math or science course. They are extremely flexible.

- **A journal**, like a diary, is a collection of personal reflections. By default, journals in Blackboard are private between a student and instructor, but can be shared if the instructor wishes. Ideas for using journals for teaching and learning include student reflections on internships, service learning experiences, field work, or specific course assignments. They can also be a great addition to students’ e-portfolios.
Activity: Blackboard Journals

Basic steps for using a Journal:

- Create the new journal, then open it and add the first entry. Students access the journal through their Tools menu.
- Optional: Add your journal to a content area or add a button for it on your course menu.
- Make sure your syllabus contains instruction, rubrics, models, a schedule of when to contribute, and other instructional guidelines.

Creating a Journal Button on the Course Menu

Sometimes we want to allow student to quickly access a tool they will use frequently in your course, in this case the Journals. To add a shortcut on the course menu, you will do the following.

1. Go into your Practice Course.
2. Click the + icon at the upper left of the Course Menu.
3. Choose Tool Link from the drop down.
4. Name it Journals, drop down type and select Journals, set to available.
5. Click Submit. This will link to all course journals.

It is also possible to add a specific blog to a course Content Area (e.g. “Course Documents” or “Course Information”) by opening that Content Area, then choosing Tools → Journals.

Creating a Journal:

Journals are created in much the same way as Wikis and Blogs. Go into your Practice Course and click on the Journal link on the Course Menu.

1. Click the Create Journal button.
2. Give your Journal a name. In the text box, add step-by-step instructions, including specific instructions for the Journal assignment and any desired formatting for entries.
3. Set up Journal options as desired, including: availability, date restrictions, indexing options (monthly is recommended), editing privileges and grading. If you elect to grade it, a column will automatically be added to the Grade Center.
4. Scroll down and set the Journal Availability to Yes.
5. Check the other options as you like and assign it a grade.
6. When done, click Submit. If you like, you can open your Journal and add the first journal entry.

Creating the First Journal Entry:

Go into the Preparing to Teach Online course and click on the Journal link on the Course Menu.
1. Click on the name of your journal to open it.
2. Click on **Create Journal Entry**. Give your journal entry a name and enter your text. Your students will also use the **Create Journal Entry** to add entries.
3. Click **Post Entry**, or **Save Entry as Draft** if you are not ready to publish it yet.
4. View your entry. Finished journal entries will be listed in the right-hand column of the Journal page. Students can only see and comment on their own entries, and instructors can see and comment on all student entries.

![Sample Student Journal (Instructor View)](image)

**Grading Journals**

If you choose ‘Grade’ when setting up the journal, a column will be added to the Grade Center automatically. Instructors can assign an overall grade for the student’s journal, but not for individual entries.

To grade a student’s journal entries, you can either enter the grades through the Grade Center or directly from the journal. To grade from the journal, do the following:

- Enter the journal that you wish to grade.
- Click on a student’s name to access that student’s journal.
- Click on the **Edit Grade** button on the right side of the screen.
- Enter the grade and any feedback, and click **Save Grade**.
- You can go back and edit the grade at any time. The grade will be saved in the Grade Center automatically.
Activity: Blackboard Blogs

Basic steps for using a Journal:
- Create the new blog, then open it and add the first entry. Students access the blog through their Tools menu.
- Optional: Add your blog to a content area or add a button for it on your course menu.
- Make sure your syllabus contains instruction, rubrics, models, a schedule of when to contribute, and other instructional guidelines.

Creating a Blog Button on the Course Menu
Just as you did with journals, if your students are using Blogs regularly, you may want to create a shortcut button for blogs on the Course Menu. Go into your Practice Course.

- Select the plus sign at the top of your course menu.
- Select Tool Link.
- Give the menu item a name.
- Under Type, select Blogs
- Select “Available to Users.”
- Click Submit. This will link to all course blogs.

It is also possible to add a specific blog to a course Content Area (e.g. “Course Documents” or “Course Information”) by opening that Content Area, then choosing Tools → Blogs.

How an Instructor Creates a Blog
1. From your course’s Control Panel, go to Course Tools and select Blogs.
2. Click Create Blog.

3. Give your blog a name.
4. In the text box, add step-by-step instructions for your students; these could include specific instructions for the blog assignment and any desired formatting guidance. For example, you might want to include rubrics, model blog entries, a schedule of when students are expected to contribute, or other relevant details. Note: You may also want to include these details in your syllabus.
5. Set up blog options as desired:
   - Blog Availability, Blog Date and Time Restrictions: set as appropriate.
   - Blog Participation: Choose to make a single “Course” blog, or make single-user blogs “Individual to All Students.” (See “Should I create an individual or a course blog?” below). Note that by default, Blackboard will “Allow Anonymous Comments” unless you un-check it (recommended.)

b. Blog Settings: Blackboard lists Blog entries according to when they were made; “Monthly Indexing” is usually simpler than “Weekly Indexing” because it creates fewer entries. We recommend “Allowing Users to Edit and Delete Entries” because it allows students much more control over how their blog entries look and read.

c. Grade Settings: Choose whether or not you want to record blog grades in Blackboard. If yes, a column will automatically be added to the Grade Center.

6. Click Submit.

Should I create an individual or a course blog?

When you create a blog, you have the option to make it an individual or a course blog. Both of these can be seen by all members of the course, but the posting options are slightly different:

- In a Course Blog, all course members can add entries and comments. Only the instructor can create a Course Blog and specify the topic to be addressed.
- In an Individual Blog, only the owner of the Blog can add entries, but all other course members can view and add comments. The instructor sets up individual blogs for students. The links to individual blogs can be found along the right side of the page.

We recommend selecting Course Blogs, as it allows all Course members to contribute and comment. If you would rather have students create private posts that only the instructor can see, we recommend using Blackboard’s Journal tool.

Important: Once you have created a blog, you cannot go back and change the blog type. Instead, you will need to delete the blog and create a new one

How to Add Blog Entry - Instructor

If you would like to create the first Blog Entry, say for posting introductions and you would like to be the first to post your entry, here’s how you would do it:

1. From your course’s Control Panel, go to Course Tools and select Blogs.
2. Click on the name of your blog to open it.
3. Click Create Blog Entry. Give your blog entry a name and enter your blog content in the text box. Your students will also use the Create Blog Entry to add blog entries.
4. Click **Post Entry**, or **Save Entry as Draft** if you are not ready to publish it yet. Finished blog entries pages will be listed in the right-hand column of the wiki. All blog authors can comment on blog entries using the **Comments** button.

**How to Add Blog Entry - Students**

Students add blog entries in the same way as instructors but get to them a little differently. Here’s how:

1. Click **Tools** from the course menu, and then click **Blogs**. (Alternatively, instructors can add Blogs to the course menu for students. See below, “Adding a Course Menu Item for a Blog”.)
2. Click the name of the blog.
3. Click **Create Blog Entry**. Give your blog entry a name and enter your blog content in the text box.
4. Click **Post Entry**, or **Save Entry as Draft** if you are not ready to publish it yet.
**Grading Blogs**

If you choose ‘Grade’ in the blog settings when you create your blog, a column will be added to the Grade Center automatically. Instructors can assign an overall grade for the student’s blog contributions. To grade a student’s blog posts, you can either enter the grades through the Grade Center or directly from the blog.

To grade from the blog, do the following:

- Enter the blog that you wish to grade.
- Click on a student’s name to access that student’s blog posts.
- Click on the **Edit Grade** button on the right side of the screen.
- Enter the grade and any feedback, and click **Save Grade**. This will be a grade for the overall blog, not for individual posts.
- You can go back and edit the grade at any time. The grade will be saved in the Grade Center automatically.
Activity: Blackboard Wikis

Basic steps for using a Wiki:

- Create the new wiki, then open it and add the first entry. Students access the wiki through their Tools menu.
- Optional: Add your wiki to a content area or add a button for it on your course menu.
- Make sure your syllabus contains instruction, rubrics, models, a schedule of when to contribute, and other instructional guidelines.

Adding a Course Menu Button for a Wiki

1. Click the + icon at the upper left of the Course Menu.
2. Choose Tool Link from the drop down.
3. Name Wikis, drop down type and select Wikis, set to available.
4. Click Submit.

It is also possible to add your wiki to a specific Content Area (e.g., “Course Information” or “Assignments”) using the Add Interactive Tool option.

How an Instructor Sets Up a Wiki:

1. Go to Course Tools and select Wikis from the dropdown menu.
2. Click Create Wiki.

3. Give your wiki a name.
4. In the text box, add step-by-step instructions for your students; these could include specific instructions for the wiki assignment and any desired formatting guidance. For example, you might want to include rubrics, model blog entries, a schedule of when students are expected to contribute, or other relevant details. Note: You may also want to include these details in your syllabus.
5. Set up Wiki options as desired:
   a. Wiki Date and Time Restrictions: Set “Wiki Availability” to “yes” to allow your students access. You may choose to “Limit Availability” by date if you want to limit when students can see or modify the Wiki.
b. **Wiki Participation:** We recommend that you keep the default setting under Student Access, which leaves the Wiki “Open to Editing” by students. Similarly, we recommend that in regard to “Student Comment Access”

c. **Wiki Settings:** Choose whether or not you want to record wiki grades in Blackboard. If you choose to do so, a column will automatically be added to the Grade Center. If you choose to grade the wiki, you will have the option of being alerted to the need to grade wiki entries after a specified number of wiki pages are saved.

6. Click **Submit**.

**Editing a Wiki:**

1. If you like, you can open your wiki and the first wiki page. Click on your wiki name to open it.

2. A form appears automatically when you first open the wiki. This form is used to add the first wiki page to your wiki. All subsequent pages will use the Create Wiki Page to access the form and add a wiki page. Give the page a name and enter your wiki content in the text box.

   This first wiki page can be used as:
   - an index page
   - the first page of wiki content
   - to provide a sample entry for your students
   - to elaborate further on instructions
   - the first actual content page for your wiki

Finished wiki pages will be listed in the right-hand column of the wiki. All wiki authors can comment on wiki entries using the **Comments** button.

Students can get to a wiki by clicking **Tools**, then **Wikis** from the course menu. (Alternatively, instructors can add Wikis to the course menu for students.) Once in the wiki, students add content either by using the Create Wiki Page button or the Edit Wiki Content button. Detailed instructions should be provided by instructors about how students might proceed with their work in a wiki.
Linking Wiki Pages Together

Typically wikis are a collection of web pages linked together by hyperlinks (think Wikipedia). In Blackboard, you can link to multiple Blackboard wiki pages together, or use the hyperlink to link out to web pages on the Internet. The first might be a good way to organize a student wiki project, with the first page as a table of contents, while the second example might be a good way to put together an annotated bibliography, as shown here:

To link wiki pages together in Blackboard,

- Create your initial wiki page. Be sure you have some text on it.
- Create a second wiki page with a title page. You should now have two wiki pages.
- Go back to the first page. Edit the page to add the title of the second page.
- Highlight the text, then select the Link to Wiki Page icon.

A new window opens. Under Select Wiki Page Link, select the wiki page you are wish to link. Click Submit.

NOTE: It is also possible to change the highlighted text on the initial page to the linked page name by using the Wiki Page Options → Rename Wiki Page Link.
Blackboard Blogs, Wikis and Discussions Comparison Chart

<table>
<thead>
<tr>
<th>Topic</th>
<th>Blog</th>
<th>Wiki</th>
<th>Discussion Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin</td>
<td>From Web Log</td>
<td>From Hawai’ian wiki wiki which means quick</td>
<td>From purpose + bulletin board</td>
</tr>
<tr>
<td>Focus</td>
<td>Author centered</td>
<td>Document centered</td>
<td>Topic centered</td>
</tr>
<tr>
<td>Control</td>
<td>Administrator (or small group)</td>
<td>All (thought this can be modified)</td>
<td>Administrator + Group</td>
</tr>
<tr>
<td>Comments</td>
<td>Encouraged but not focus</td>
<td>No real comments (all editable)</td>
<td>Comment driven</td>
</tr>
<tr>
<td>Purpose</td>
<td>Share a log of events and personal insights</td>
<td>Creation of documents, projects, resources</td>
<td>Provide support, discuss topics</td>
</tr>
<tr>
<td>Organization</td>
<td>Content displayed with most recent posting first</td>
<td>As participants decide, can have multiple pages or one</td>
<td>Threads</td>
</tr>
<tr>
<td>Voice</td>
<td>Conversational</td>
<td>Passive and Active</td>
<td>Conversational or more formal</td>
</tr>
<tr>
<td>Design</td>
<td>Themes, Personal, primarily text though some are images or audio only</td>
<td>Participant decided, continuously changing, primarily text</td>
<td>Generally static, text-based</td>
</tr>
<tr>
<td>Content permanence</td>
<td>Static 1 once posted, considered old and rarely revisited</td>
<td>Continuous change (though all is archived)</td>
<td>As long as administrator/ software/ school allows</td>
</tr>
<tr>
<td>Ownership</td>
<td>Posting owned by poster</td>
<td>Topics considered public space and owned by all</td>
<td>Threads and posts owned by group with equal responsibilities</td>
</tr>
<tr>
<td>Features</td>
<td>Customizable, password protection, guest logs, archiving, private messages, listserv, gadgets, media-rich, &quot;Emergent voice,&quot; more like a traditional website (with pages), archives, ease of use, top of page remains the same, meant for a specific purpose so less overwhelming</td>
<td>Collaborative, limited media in some boards, ease of following threads</td>
<td></td>
</tr>
<tr>
<td>Challenges</td>
<td>Difficult to sustain, one person (or group) centered, Top of page changes, content becomes old</td>
<td>Limitations for conversation, Best with a fairly limited number of people, Content not permanent, fewer features, not as portable (still true?), lack of control, external websites do not usually link-to, not always democratic</td>
<td>Lack of customizability, not as much media capability, potential lack of control, some discussion boards do not have search features</td>
</tr>
</tbody>
</table>
### Possible uses

- For individual or small group, getting a specific message out, editorial, personal voice, initiate discussions,
- Internal communication, community communication, constructive criticism, website option, projects or programs, informational, address book, documentation, specific
- Socratic method, opinions, response-driven, familiar, topic-driven

### Privacy/Security

- Choice, but not guaranteed private or secure
- Choice, but not guaranteed private or secure
- Private to class/instructor

### Scenarios/Reasons to use for teaching and learning

- Chronological; comments (from peers on each others’ or students to instructor post); student blogs
- Student(s), instructor, groups, or whole class; good for building from scratch; Group work plus repository of resources; specific projects; can embed in Blackboard
- Topic-based discussions; since “locked-in” Blackboard, more secure (but more steps to get there)

---


Gathered by Michelle Rodems, The Center for Teaching and Learning, Bowling Green State University

**References**


Shepherd, C. (2007, April 13). One more time: what’s the difference between a blog and a wiki? From [https://www.blogger.com/comment.g?blogID=17959023&postID=2103355645939499573](https://www.blogger.com/comment.g?blogID=17959023&postID=2103355645939499573)

SEMINAR 5: TESTS, GRADING, FEEDBACK & SUPPORT

The pace on an online course means it is very important to keep your students informed about their progress throughout the duration of the course. While tools such as the Retention Center and Performance Dashboard provide you information about students who may be falling behind, there are several Blackboard tools designed to help you evaluate student work, communicate expectations and provide feedback to your students, so they stay on track. Today we’ll take a look at some of these tools and features.

Learning Objectives
✓ Create a test using Blackboard’s tool called Tests, Surveys, and Pools, deploy and choose appropriate options.
✓ Discover what it looks like when students take tests and see their grade.
✓ Perform basic functions in the grade center including:
  o Basic housekeeping for the start of the term.
  o Editing auto-created grade columns.
  o Adding additional grade columns to correspond to all graded material in the course.
  o Creating a ‘calculated’ grade column to keep a running total of grades for each student.
✓ Provide feedback on tests/quizzes and Grade Center.
✓ Create rubrics to define expectations and to give formative and summative feedback.
✓ Explore My Grades and know where to find feedback and support from a student perspective.

Seminar Contents
Ways to Evaluate Learning......................................................................................................... 155
Formative vs. Summative Assessments ...................................................................................... 156
Evaluating with Rubrics .............................................................................................................. 157
Activity: Create a Blackboard Rubric ......................................................................................... 160
Blackboard Tests ......................................................................................................................... 165
Activity: Create a Test in Blackboard Using the Test Manager ................................................. 166
Blackboard Surveys .................................................................................................................... 177
Blackboard’s Grade Center ......................................................................................................... 179
**Additional Resources/Web Sources**
Visit the Seminar 5 Learning Module in your Preparing to Teach Online course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
There are many ways to evaluate learning in online courses; here are a few:

- **Tests and quizzes** – These are your most typical forms of assessment, but proctoring could be an issue, and targets lower order cognitive skills

- **Reflections** – Use journals or discussion posts. For example, create weekly reflections: “What is the one thing you learned this week that you feel is most important?” “What would you like to learn more about?”

- **Authentic Assessments** – These could be both an activity and/or a way of evaluating learning, real world experiences or content relevant to students’ circumstances (ie: Assignments, Papers, etc.)

- **Self-evaluations** – Use rubrics in a group that only the instructor has access to or create a Blackboard quiz

- **Peer evaluations** – critiques of other students’ work and/or post assignments publicly on discussion board for peer feedback

- **Pre and post testing** – do several throughout term

- **Live check-ins** – Skype or WebEx

- **Observational data** – rubrics (summative and formative)

A few other thoughts:

- Consider the difference between low stakes versus high stakes assessments
- Match your type of evaluation to your assignment
- Consider how you will be evaluating groups
Formative vs. Summative Assessments

Formative assessment
The goal of formative assessment is to provide ongoing feedback during instruction that can be used by both instructors and students to improve teaching and learning. By checking in regularly, the instructor is able to see where students are struggling and help get them back on track before it is too late. In turn, students receive feedback that helps them to see areas where they need to work harder or seek additional help. Formative assessments are ‘check-ins’ for the learning process, so they are usually low stakes, counting little towards the overall grade; essentially used to gather data about how the learning is going. While most homework is formative assessment, other in-class examples might include:

- Asking students to write a muddiest point or main point paragraph at the end of a class
- Having students turn in a draft of a final paper

Summative assessment
In contrast, summative assessment is used to evaluate students, to see how well they did in comparison to some other standard or benchmark. A final exam is the most common form of summative assessment, but there are other means as well. These are usually high stakes, carrying a lot of weight in terms of grading points. Examples include:

- Midterms and finals
- Recitals
- Term papers
- Final Projects

Instructional designers use summative assessments to go back and make changes to the overall course, or fine tune activities – a form continuous quality improvement. (Carnegie Mellon Eberly Center for Teaching Excellence, 2012).
What is a rubric?
Rubrics are a checklist or chart that can be used in grading. They are particularly useful when grading subjectively and are often used to grade discussion boards. They are a scoring guide, explicitly spelling out what students are expected to do to earn a given grade. That means both you and your students have a blueprint for good work versus not so good work. Rubrics are flexible and adaptable to your needs, so they can be used across a wide variety of assignments.

There is a good online resource for creating rubrics called Rubristar [http://rubistar.4teachers.org](http://rubistar.4teachers.org). Although it was designed for K-12, you will find it a very helpful way to begin creating rubrics across a variety of assignments.

Here’s an example of a rubric being constructed using a RubriStar template.

![Creating and Editing Your Rubric](http://rubistar.4teachers.org/index.php)
**Why use Rubrics?**

They clearly spell out to students the criteria for earning a given grade. Rubrics:

- Help grade subjective assignments such as discussions, case studies, and projects.
- Provide accurate, unbiased, and consistent grading.
- Make grading more efficient.
- Provide feedback to students so they can improve.

<table>
<thead>
<tr>
<th>Category</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirements</td>
<td>All project requirements have been included and show great</td>
<td>Some requirements have been met, but do not include details and</td>
<td>Some requirements are lacking or the project does not match the</td>
<td>Most requirements are lacking or did not get instructor approval.</td>
</tr>
<tr>
<td></td>
<td>attention to details and substance. Proposal submitted to and</td>
<td>substance. Proposal submitted and approved by instructor.</td>
<td>proposal as approved by instructor.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>approved by instructor.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality of Materials</td>
<td>There are a wide variety of support materials (e.g.,</td>
<td>There are 1-2 support materials and these are careful and</td>
<td>There is only 1 supporting materials; materials</td>
<td>Materials appear careless or haphazard. Many details need</td>
</tr>
<tr>
<td></td>
<td>assessment examples, screen captures, etc.) and great care taken</td>
<td>accurate for the most part, but 1-2 details could have been</td>
<td>accurately followed the plan, but 3-4 details could have</td>
<td>refinement for a strong or attractive product.</td>
</tr>
<tr>
<td></td>
<td>in so that the materials are neat, attractive, and follow</td>
<td>been refined for a more attractive product.</td>
<td>been refined for a more attractive product.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>instructional plan accurately.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall Organization</td>
<td>Student has developed a clear plan for organizing the project</td>
<td>Student has developed a clear plan for organizing the project</td>
<td>Student has developed a clear plan for organizing the project</td>
<td>No clear plan for organizing the project and/or student cannot</td>
</tr>
<tr>
<td></td>
<td>through the individual assignments during term and the final</td>
<td>through the project through the individual assignments during</td>
<td>through the project, but either did not turn in individual</td>
<td>explain his or her organizational plan. OR last-minute topic</td>
</tr>
<tr>
<td></td>
<td>product integrates all</td>
<td>term, but the final product could be more cohesive.</td>
<td>assignments or they lacked substance.</td>
<td>change rendered individual assignments ineffective for</td>
</tr>
<tr>
<td></td>
<td>pieces cohesively.</td>
<td></td>
<td></td>
<td>organizing final project.</td>
</tr>
<tr>
<td>Match of instructional</td>
<td>Project shows an appropriate and accurate match of</td>
<td>Most of the instructional technologies are an appropriate</td>
<td>Very few of the instructional technologies are an appropriate</td>
<td>The selection of instructional strategies is obviously not</td>
</tr>
<tr>
<td>strategies with</td>
<td>instructional strategies with selected technologies in design</td>
<td>match.</td>
<td>match.</td>
<td>appropriate.</td>
</tr>
<tr>
<td>instructional plans</td>
<td>plan.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sequencing</td>
<td>Information is organized in a clear, logical way. It is easy</td>
<td>Most of the project instructions are organized in a clear, logical</td>
<td>Some information is logically sequenced. An occasional card or</td>
<td>There is no clear plan for the organization of information.</td>
</tr>
<tr>
<td></td>
<td>to follow the step-by-step flow of the instruction.</td>
<td>way and there is a step-by-step, but it is hard to discern.</td>
<td>item of information seems out of place.</td>
<td></td>
</tr>
<tr>
<td>Assessment</td>
<td>Formative and Summative assessments are included. Assessment</td>
<td>Formative and Summative assessments are included. Assessment</td>
<td>Formative and Summative assessment are included. Assessment</td>
<td>Assessment plans are poorly thought out, not clearly</td>
</tr>
<tr>
<td></td>
<td>plans are clearly distinguishable, diverse, appropriately</td>
<td>plans are clearly distinguishable, diverse and detailed, but</td>
<td>plans are clearly distinguishable, but lacking in diversity,</td>
<td>distinguishable from one another (or only includes one of the</td>
</tr>
<tr>
<td></td>
<td>criteria, referenced, and examples are provided.</td>
<td>no examples are included.</td>
<td>details, and no examples are included.</td>
<td>forms of assessment), and there are no examples.</td>
</tr>
<tr>
<td>Presentation</td>
<td>Student is completely prepared and has obviously rehearsed.</td>
<td>Student seems prepared but might have needed a couple more</td>
<td>The student is somewhat prepared, but it is clear that</td>
<td>Student does not seem at all prepared.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rehearsals.</td>
<td>rehearsal was lacking.</td>
<td></td>
</tr>
</tbody>
</table>

Rubrics are a coherent set of criteria for student work that assesses student performance. A rubric divides different aspects of work into sections. Each section is broken down into categories and describes the criteria for excellence in each category. Rubrics are important because they clearly define instructor expectations for the quality of work students should achieve on different assignments.

NOTE: Much of the first page of this guide came from an FCLD presentation facilitated by Dr. Peter Oliver, Associate Professor of Educational Psychology and Human Development in the College of Education, Nursing, and Health Professions, and used source materials from the Carnegie Mellon Eberly Center for Teaching Excellence & Educational Innovation: [http://www.cmu.edu/teaching/design/teach/rubrics.html](http://www.cmu.edu/teaching/design/teach/rubrics.html)
Practical Reasons for using Rubrics:

- Aid instructors in grading assignments quickly and efficiently.
- Allow instructors to provide both formative (in the course of writing) and summative (final product) feedback to the student.
- Instructors can weight importance of various elements of the assignment appropriately.
- Provide consistency in grading for courses that may have multiple graders (adjuncts and teaching assistants)
- Aid students in understanding what the expectations are while they are writing or working on graded assignments.
- Allow students to recognize strengths and weaknesses in their work and make adaptations.
- Make it harder for students to contest grades.

Example Rubric:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Level 4</th>
<th>Level 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language &amp; Grammar 10/30</td>
<td>Multiple errors. No evidence of editing or review</td>
<td>Many errors that prevent or limit understanding.</td>
<td>Several errors that require further more attention.</td>
<td>Minor errors exist. Strong evidence of editorial review.</td>
<td>Well-written, Minor errors exist.</td>
</tr>
<tr>
<td>Connections &amp; Content 15/30</td>
<td>Ideas not connected much at all.</td>
<td>Connections are simplistic and not developed much.</td>
<td>Offers several connections to topic-related issues</td>
<td>Offers thoughtful and well developed connections.</td>
<td>Offers numerous, excellent connections with references to other issues.</td>
</tr>
<tr>
<td>Original 5/30</td>
<td>Writing shows no creative substance or imaginative quality.</td>
<td>Writing shows limited creativity and innovation.</td>
<td>Writing is occasionally creative and innovative.</td>
<td>Writing is generally creative and interesting.</td>
<td>Writing is clearly original, creative and innovative.</td>
</tr>
</tbody>
</table>

Creating rubrics in Blackboard is easy to do and can be tied into the grading for the assignment, discussion board, journal, blog, and wiki. We will explain how they are created here.
Activity: Create a Blackboard Rubric

It is helpful to map your rubric out on paper first. Afterwards, we can easily translate that to Blackboard. Or alternatively, use helpful websites like RubiStar http://rubistar.4teachers.org/index.php to help jumpstart the process. RubiStar has editable templates that can be edited and customized.

How do I create a rubric?

- From scratch…
- Make a list of criteria.
- Have someone else provide feedback if possible.
- Cull the list down to no more than 8 categories.
- Create rating scale and determine grading (percent, score, A-F).
- Put together in grid fashion (unless you are just making a checklist).

Alternatively, you can use an online rubric creator

- Google using rubric creator as search term.
- Can generate one just to get ideas.

Some online rubric creators are:

iRubric http://www.rcampus.com/indexrubric.cfm

Rubrics4Teachers http://www.rubrics4teachers.com/


Step One: Map out your rubric on paper

Step Two: Build the Rubric in Blackboard
Blackboard has a rubric generator – Blackboard rubrics can be exported and imported among your Blackboard courses.

![Example of a Blackboard generated rubric](image)

**Steps to create a rubric**

1. On the main course menu, navigate to the Course Management area → Course Tools → Rubrics

2. In the Rubrics window, click the **Create Rubric** button.

Next we begin editing in the Edit Rubric window:

3. Name your rubric and give it a description:
4. Below, in the *Rubric Detail* section, determine whether you will be grading on percentages or points, point ranges or percentage ranges via the *Rubric Type* dropdown box.

![Rubric Detail](image)

5. Change Headers for Criteria and Levels of Achievement as you like by clicking the dropdown arrow next to each header, then click *Edit*.

![Edit Levels of Achievement](image)

6. Add Rows and Columns as needed with the *Add Row* and *Add Column* buttons at the top.

![Add Row and Add Column](image)

7. Once you have your columns and rows set up, begin entering the point values and descriptions for each column/row.

![Rubric Detail Grid](image)

8. Spell check is also available by clicking the *abc* icon in the bottom right of each block.

9. When done, click *Submit*. 

Preparation to Teach Online | Faculty Center for Learning Development
**Attaching the Rubric to Graded Assignments**

1. Create your Assignment as usual.
2. Scroll down to the **Grading** section of the Assignment window and under Points Possible, hover over the **Add Rubric** button, then click **Select Rubric** from the dropdown menu.

3. In the Select Rubrics window, choose your rubric, then click **Submit**.

4. You will get a pop up saying “Click OK to assign the rubric’s Maximum Points as the Points Possible,” then click **OK**.

5. Back in the Assignment window, decide if you want to show the rubric to students, along with scores. Click the icon under show Rubric to Students → Select **Yes (With Rubric Scores)**

6. When done in the Assignment window, click **Submit**.
**Attaching the Rubric to Discussions**

1. Create your Discussion as usual.
2. Scroll down to the **Forum Settings** section of the Create Forum window and under Grade, select **Grade Discussion Forum** and enter a point value.
3. The **Associated Rubrics** section will then appear. Hover over the **Add Rubric** button, then click **Select Rubric**.
4. Follow steps 3-5 from **Attaching the Rubric to Assignments** as above. When done, click **Submit**.

**Attaching the Rubric to Journals, Blogs or Wikis**

1. Create your Journal, Blog or Wiki as usual.
2. Scroll down to the **Grade Settings** section of the Create Journal, Blog or Wiki window and under Grade, select **Grade: Points Possible** and enter a point value.
3. The **Associated Rubrics** section will then appear. Hover over the **Add Rubric** button, then click **Select Rubric**.
4. Follow steps 3-5 from **Attaching the Rubric to Assignments** as above. When done, click **Submit**.

**Additional Resources:**
- Example Rubrics: [http://www.cmu.edu/teaching/designteach/teach/rubrics.html](http://www.cmu.edu/teaching/designteach/teach/rubrics.html)
Blackboard Tests

This document covers the step-by-step instructions for Blackboard Tests. Blackboard tests are a great way for instructors to track student progress. Instructors can create quick ‘check-ins’ or longer, cumulative tests. Since Blackboard tests are not proctored, online instructors often use them for open book tests, practice exams, self-testing, or mini-quizzes. Blackboard tests offer very helpful test options and a dizzying array of question types (even hotspots!). Most test question types are automatically graded and entered into Grade Center (with the exception of short answer and essay questions).

Note that while this document covers how to use questions from Blackboard Pools (test banks) in creating tests, instructions on how to work with those pools and their questions are documented separately (see FCLD’s website: http://hartford.edu/fcld). For the purposes of this document, the word “quiz” and “test” are used interchangeably.

To begin creating Tests, Surveys and Pools for your course, go to Control Panel → Course Tools → Tests, Surveys and Pools.

Overview
Creating tests in Blackboard is a five-step process.

1. Create the test.
2. Add questions to the test.
3. Deploy the test in a content area (e.g. Course Documents or Assignments) using the “Create Assessment” button.
4. Determine the test options (number of allowed attempts, time limits, etc.).
5. Make the test available to students.

Tip: There is always the slight chance that a technical glitch happens while a student is taking a test. Remind your students to save each answer as they progress through the test to avoid losing answers. When appropriate, you can also use test settings, such as allowing multiple submissions, which can make it possible for students to recover from technical problems.

NOTE: It is recommended to allow at least two attempts in a non-proctored test environment. This reduces students calling in the wee hours when a technical glitch has occurred for them to get you to reset the test or quiz for them. It is further recommended that Force Completion be set to OFF.
Activity: Create a Test in Blackboard Using the Test Manager

Step 1: Access the Test Manager
1. From the Control Panel, click on Course Tools → Tests, Surveys and Pools → Tests.
2. Click Build Test. A new screen opens called Test Information.
3. Enter a name, description, and instructions for the test. The instructions refer to the entire test so keep them general. Include cautions and tips and reminders (e.g., save your answers as you go).
4. Click on Submit. The Test Canvas window (which is used to add questions) appears.

Step 2: Add Basic Questions to your Test
There are three options for adding questions:

Create Question: Type new questions from scratch, using a variety of questions types (e.g., true/false, matching, essay, etc).

Reuse Question: Search for questions from previously created tests or pools and add them to your test. You can select which questions to use, or have Blackboard insert a random block of questions from a pool.

Upload Question: Upload questions from a word processor document. Be careful - this is not as straightforward as it sounds! We do not recommend this option as it is not as efficient as creating questions directly on Blackboard.

Creating Test Questions
Here are the steps for creating test questions:

1. Click Create Question.
2. Select a question type from the menu (as shown to the right).
3. Enter question text and choose options.
4. Enter answers as required by the question type. By default, Blackboard sets the first answer as the correct one. Use the radio button to select the correct answer.
5. Provide feedback and/or other options, if desired.
6. Provide Categories, Levels of Difficulty, Topics, or Keywords to enhance searching capabilities.
7. Click Submit to add question to pool.
8. Repeat Steps 1 through 7 to continue adding questions.
9. Click OK.
10. Be sure to adjust point values for each question entered (as needed).
Reusing Test Questions

One quick way to add questions to a test is to import a random block of questions from a pool. Please note that the instructor should complete all question modifications in the pool before adding its questions to a block used in a test. To add a random block to your test:

1. Point to Reuse Questions on the Action Bar, and select Create Random Block.
2. Select the name of the pool and the question types from which you want to draw questions. (It is not possible to import them from other tests.) The questions that meet these criteria will appear on the right side of the page.
3. Click Submit. This will insert a block of questions into your test.
4. Choose how many questions you would like to display and how many points you would like each question to be worth.

In the example shown below, there are eleven multiple choice questions in the pool “Campaigns and the Media.” The test will display four random questions from this pool to each student, and each question will be worth ten points.

Creating a Question Block

After importing, the questions appear to be one question in the test, because Blackboard dynamically ‘grabs’ random questions when students actually take a test. In other words, the block of questions is basically a link back to the pool, activated during test taking.

The option Create Question Set works in the same way, except that you get to choose specific questions to add to the test rather than a type of question.

Step 3: Creation Settings: Enabling Advanced Question Options

If you are going to draw questions from a question pool to populate a test, it might be helpful to categorize pool questions and mark them with keywords for easy searching in the future.
To categorize questions and add keywords for an existing question pool:

1. From the Pool Canvas, Select **Question Settings**.

```
Pool Canvas: Test Pool

The Pool Canvas presents an inventory list of questions that can be managed and searched. You can use the check boxes to select any or all questions and then delete them or change their points, or edit questions individually. More Help

<table>
<thead>
<tr>
<th>Create Question</th>
<th>Find Questions</th>
<th>Upload Questions</th>
<th>Question Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Instructions</td>
<td>Total Questions 0</td>
<td>Total Points 0</td>
</tr>
</tbody>
</table>
```

**Accessing Question Settings**

2. Make your selections relating to Feedback, then Images, Files and Web Links.
3. To be able to add categories, topics, etc., you must choose to enable “**Question Metadata**”
4. Click **Submit**. This adds the option ‘Categories and Keywords” to each question. Now you can open each question and assign it a category.
5. If there are already questions in the pool, select **Modify** to the right of each question. This opens the question for editing.
6. Assign keywords to a question by typing them in the space provided. Adding keywords will help you when searching for questions later.
7. To assign the question to a category, scroll down to Option Five, **Categories and Keywords**. Click **Add** to add categories, topics, levels of difficulty or keywords.
8. If you have categories already, click on the button **Choose from Existing** and select a category from the list. The more questions associated with a category, the larger the category link will be.
9. Once you have added the categories, click **Submit** at the bottom of the page.

```
4. Categories and Keywords

Click Add to add a Category, Topic, Level of Difficulty, or Keyword to the question of Categories, Topics, Levels of Difficulty, or Keywords.

Categories: None
Topics: None
Levels of Difficulty: None
Keywords: None
```

**Adding Categories and Keywords**
**Step 4: Deploying a Test or Survey within a Content Area**

After creating a test or survey, it must be placed in a content area for students. Blackboard refers to this as “deployment.” Tests/Surveys can be deployed from any content area within your course.

To deploy a Test or Survey, do the following:

1. Select the Content Area where you want students to access the test/survey (e.g., Course Documents, Assignments, etc.).
2. Click on Assessments on the Action Bar and select Test or Survey.

   ![Selecting the “Test” button from the Content Area menu](image)

3. Ignore the “Create” button if you already have created a test with test questions. Instead;
4. Select an “existing test” from the list provided. Click Submit.
5. You will receive confirmation that your test was added successfully. Select OK in the bottom right corner of the window.

**Step 5: Making the Test Available and Other Settings**

Once the test has been added to a content area, you can then edit it or make it accessible to students so they can take it. To make it available, first locate it in the Content Area:

1. Hover over the name, then click the arrow next to it and select Edit the Test Options.
2. Modify the test name and description if needed (usually not necessary).
3. If desired, select to have the test open in a new browser window.
4. Use the Test Availability options to determine how and when the test will be administered to the students. **Important:** If you elect to make the test available on or after a certain date, check to be sure you have also clicked “Yes” after “Make the link available.”
Test availability options include:

a. Making the link available (to students).
b. Generating an announcement about the test in the Announcements Area.
c. **Multiple Attempts** settings control whether students can attempt the test more than once. By default, Blackboard will record only the last attempt, but you can change this in the Grade Center. We recommend two attempts.
d. **Force Completion** makes students complete the entire test in one session.
e. **Set Timer**. The effect of **Set Timer** depends on whether you choose to turn on the **Auto-Submit** feature. With **Auto Submit** on, Blackboard closes and saves a student test when time expires, *regardless of whether a student has completed it*. If **Auto Submit** is off, test takers can continue past time limit, but Blackboard records the submission as past time. We don’t recommend auto submit.
f. Select the dates to make the test available. **Note**: If you select dates to make the test available, you must also select “Make the Link Available.”
g. **Password**. This is useful if you are proctoring the test in a lab or if you want to provide individual access to a test (for example, in the case of a student making up a late test).
Self-assessment Options may be used to include the score in Grade Center or to hide the score and individual work from you. These are helpful if you are designing a test for students to test their own subject knowledge, perhaps prior to an actual in-class exam. **Warning: if you choose “Hide results…” you are essentially creating an aggregated survey, of which you cannot see individual results.**

![Self-Assessment Options](image)

Test Feedback Options allow the instructor to control what students will see displayed when they complete a test. Sometimes test security concerns dictate that you should show less information, while at other times more feedback can provide greater student learning.

![Test Feedback Options](image)

Be cautious when choosing how and when you want scores and feedback to be displayed to students.

**What scores/feedback the students should see:**

- **Score** – the score only will be shown.
- **Answers:**
  - All Answers – students can see all answers to all questions on the test.
  - Correct – students only see what answers they got correct and incorrect.
  - Submitted – students only see what they have submitted.
  - Feedback – if you have written feedback, this will display to students.
  - Show Incorrect Questions – will show the students which questions they got incorrect.
When the students should see scores/feedback:

A. After Submission – after the students submit the test/quiz they can see your feedback.
B. One-time View – students will only be shown the feedback once.
C. On Specific Date – students will be able to see feedback only on the date you choose.
D. After Due Date – requires you to set the due date for the quiz/test, and feedback to students will only be shown on and after that date.
E. After Availability End Date – If you set date restrictions on the quiz/test, students will be able to see feedback only after the availability end date.
F. After Attempts are graded – After you have graded all attempts, students can see feedback.

You can also do a secondary display option:

Most instructors find the settings in the following example work well:

An instructor teaches 3 sections of MAT111 and wants all three classes to take the same test. The instructor sets up the test to show the score - and nothing else - to the student immediately after the student submits the test. Then later, after all three sections have completed the test, the instructor has a specific date setting that will allow the students to see more feedback, in this case, what they submitted and the questions they got correct, as well as any written feedback as shown below.

Finally, complete the Test Presentation options and click Submit.
NOTE: Instructors can check a test and even take it themselves, by clicking on the Student Preview button.

**Tests and the Grade Center**

Instructors do not need to add a column in Grade Center for each test or survey, as Blackboard adds one automatically when a test is deployed. Surveys will not show a grade, but a checkmark is entered to indicate student completion.

By default, tests are entered with the raw score (unless you choose to display it otherwise, for example, as a letter grade). An exclamation point means the instructor needs to enter the grade. Instructors simply click on the exclamation point and Blackboard will open up the test or assignment from the Grade Center to allow the instructor to complete grading.

Upon completing the grading, Blackboard will total the score and automatically enter the score in the grade center. For more information on managing tests and surveys in the online Grade Center, please refer to FCLD’s handout on Blackboard’s Grade Center: [https://www.hartford.edu/faculty-staff/faculty/ffcld/files/731041-getting-started-withgradecenter.pdf](https://www.hartford.edu/faculty-staff/faculty/ffcld/files/731041-getting-started-withgradecenter.pdf)

**Interpreting Test Information in Grade Center**

Grade Center provides other important information for instructors about student’s testing progress. From within the Grade Center, you can access a reminder of what each icon means by clicking on the **Icon Legend** button, which is at the lower right hand side of the Grade Center. Below is the legend, along with explanations you might find helpful.

<table>
<thead>
<tr>
<th>Icon Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Mark (in green circle):</td>
<td>Completed. A Survey (or assignment graded as complete/incomplete) has been finished.</td>
</tr>
<tr>
<td>Check Mark (green):</td>
<td>External Grade. Always shows to students. Column cannot be removed.</td>
</tr>
<tr>
<td>Blue Circle:</td>
<td>Attempt in Progress. Student is either currently working on a test or a technical glitch caused the student to be ‘kicked out’ of the test finishing.</td>
</tr>
<tr>
<td>Exclamation Point (yellow):</td>
<td>Needs Grading. The instructor must manually enter grade.</td>
</tr>
<tr>
<td>Exclamation Point (red):</td>
<td>Error. If the instructor clicks on the question mark, Blackboard will do its best to describe the error.</td>
</tr>
<tr>
<td>Dash:</td>
<td>The test or survey has not yet been taken by the student.</td>
</tr>
</tbody>
</table>
Clearing Test Attempts
As noted above, the Notebook and Pencil icon (Attempt in Progress) indicates one of two things:

1) The student has begun the test but has not yet submitted it.
2) There was a technical glitch and the test is locked up.

If the Notebook and Pencil icon was a result of a technical glitch, the instructor can clear the attempt and have the student start over. **Check with the student before you clear the attempt, in case he or she is currently taking the test, and/or be sure to check for any saved answers. This will help you avoid deleting the student’s test results by accident.**

To clear a test attempt:

- From the Grade Center, click on the downward arrow icon next to the Notebook icon.
- Select View Grade Details. You will see a list of the attempts the student has made to complete the test.
- Click on View Attempt to see the student’s test. Be sure to print the test if the student has any answers in it, just in case there is a dispute over the attempt. Often, the Attempt in Progress icon is due to students backing out of a test with the browser back button, or because their Internet connection was lost mid-way through the test.
- Select Clear Attempt to erase the student’s attempt.
- If the test was set up with multiple attempts, you will see all of the student’s attempts listed here, with the option to view or clear each attempt.

If you have chosen to display the test questions one at a time, individual answers will be saved automatically as the student completes the test. If this is the case, you can view the student’s attempt and grade it manually in the Grade Center – you will NOT need to clear the attempt.

Removing Tests
There are three methods to “remove” tests. Usually, instructors only wish to remove the student’s access to the test, but not the grades or the test attempts. If this is the case, use the first method listed below. If your test did not allow multiple attempts, the second method is also safe.

**Method One: Changing the Test Availability (Recommended)**
If you wish to ‘remove’ the test, but preserve all test attempts and grades associated with the test in the Grade Center, change the availability of the test.

- Locate the test where it is deployed.
- Hover over the test name, then click the arrow and select **Edit the Test Options.**
- Scroll to the second section, **Test Availability.**
- Set “Make the Link Available” to **No.**
This hides the test from the students. As an alternate method, you can also change the Display After/Display Until dates so that the students no longer have access to the test after a specified date. Be sure you have checkmarks next to the date checkboxes or test access will remain!

**Method Two: Removing the student’s link to the test, along with test attempts**

If you wish to remove the test deployment link, and/or all test attempts and test grades associated with the test in the Grade Center, do the following:

- Find the deployed test within your course.
- Hover over the name of the test, then click on the downward arrow to its right. On the menu that appears, select **Delete**.
- A warning appears, along with two options (see below).

![Removing a Test from a content area](image)

Typically, you will select “Preserve scores in the Grade Center for this Test, but delete all attempts for this Test.” (Think carefully: note that all test attempts will be removed!) The other choice is even more drastic, since it also deletes all grade center records associated with the test.

**Method Three: Permanently Removing a Test and Associated Test Grades**

To permanently remove a test from the Test Manager (not recommended) along with any grades and attempts associated with it:

- Remove the test deployment link using Method Two above.
- Go to the Tests, Surveys and Pools, then Tests.
- Locate the test you wish to remove.
- Click on the downward arrow and select **Delete**. Confirm the deletion by clicking **OK**.
- The test and all grades associated with it are removed.
**Exporting Test Results**
Test results can be downloaded into a spreadsheet program. To do so:

- Enter the Grade Center from the Control Panel.
- Hover over the test’s name, then click the arrow and select **Download Results**.
- Select **Comma** to create a comma-delimited file, which can be opened in Excel.
- Select how you would like the results to display in the spreadsheet:
  - By User, or By Question and User
  - Only Valid Attempts, or All Attempts
- Select **Click to download results** and save file on your local computer.

**Moving Tests & Surveys from Course to Course**
Individual tests and surveys can be exported and imported from course to course. To export a test or survey from the course you want to move it from:

1. Go to Tests (or Surveys) then mouse over the name of the test or survey. Click on the downward arrow that appears to the right of the title, then choose **Export**.

2. A dialog box will open that lets you open or save a zipped version of the file. Choose to save the test on your computer or thumb drive. Make sure you know what the file is called and where you are saving it.

3. Open the course where you want to place the item, then go to Tests or Surveys. The **Import** button is available at the top of the page in Tests as well as Surveys.

4. In the Test Import screen that appears, click **Browse My Computer**, then upload the zipped test file from where you saved it and click **Submit**.
Blackboard Surveys

Surveys provide a great way to gauge student’s prior knowledge before class, so the instructor can fine-tune instruction, or after class, to see if students “got it.” Surveys are created the same way as tests, but there are a few differences. Instructions for setting up surveys are outlined below:

Creating a Survey
- Go to Control Panel → Test, Surveys and Pools → Surveys.

Deploying a Survey
- Deploy the survey in a content area (e.g., Assignments) using the same Create Assessment menu used to deploy Tests.

NOTE: Instructors may not deploy a test or survey from the Announcements Page because this is not considered a Content Area in Blackboard.

- You can add a course menu content area (button) called “Tests and Surveys” and deploy the survey there, if you wish. Click on the red button with the + sign above your course menu to create a new Content Area
- As you deploy the survey, Blackboard will allow you to create an automatic announcement telling students where to access the test or survey. You can also make a conventional Announcement that includes a link to the survey.

Tip: When you create the Content Area and assign it a name, make sure that you select “Available to Users.”
**Removing a Survey**

Instructors have two steps for removing a survey that has already been deployed in a course:

1. First remove the link to the survey in the content area. When you remove a survey from a content area, a warning appears, giving you the option to change your mind and cancel.

   ![Removing a Survey from a Content Area](image)

2. Go to Surveys, (in Tests, Pools and Surveys), then mouse over the name of the survey. Click the downward arrow that appears and click **Remove**.

   **Note:** An instructor should remove a survey from the Surveys area of the course only when sure that students no longer have access to a survey in the content area.

**Viewing Survey Results from the Grade Center**

Surveys are not graded. Instructors are given statistical results only. Survey results are accessed through the Grade Center. Here are the steps:

- From the Grade Center, hover over the name of the survey at the top of the grade column and click on the drop down arrow arrow.
- Click on **Attempts Statistics**.
- Review anonymous statistics in Blackboard.
- As attempts are anonymous, it is nearly impossible to see individual results without downloading to your computer as a comma delimited file (see section on Exporting Survey Results).

**Exporting Survey Results**

Survey results can be downloaded into a spreadsheet program. To do so:

- Enter the Grade Center from the Control Panel.
- Hover over the test’s name, then click the arrow and select **Download Results**.
- Select **Comma** to create a comma-delimited file, which can be opened in Excel.
- Select how you would like the results to display in the spreadsheet:
  - By User, or By Question and User
  - Only Valid Attempts, or All Attempts
- Select **Click to download results** and save file on your local computer.
Blackboard’s Grade Center

Blackboard’s Grade Center is an online grade book. It helps you calculate running grades, track student progress, provide feedback to students, download grades to your computer – even create reports. You don’t have to type in student names; Blackboard does it for you. All you have to do is add columns. Some columns are created automatically by Blackboard when you use Blackboard features such as Tests, Surveys, Assignments, and any other items you create with a ‘graded’ status. The Grade Center is very flexible, allowing you to drop lowest grades, weight grades, filter views, and more. Students can’t see Grade Center but they can see their own individual grades in a tool called My Grades.

IMPORTANT: The Grade Center is complex. It is strongly recommended that you attend a Grade Center seminar. Please contact FCLD to find out when a Grade Center seminar is offered. Call 768-4661 or email fcld@hartford.edu. You may check our seminar schedule here: https://www.hartford.edu/faculty-staff/faculty/fcld/seminars-workshops/default.aspx

Overview

The Grade Center can serve as a communication tool, an evaluation tool, and a timely feedback mechanism. To achieve any of these, the best practice is to add all Grade Center items, grading schema (letter grade settings), weights, and other options before the semester begins. By finalizing your Grade Center early, students who click on their grade center view, My Grades, at the beginning of the semester can see all assignments, tests, graded forums, and other items along with the descriptions, points possible, due dates, etc., giving them a great overview of the course and an extension to your syllabus. Please note that Blackboard Grade Center is not your grade of record, and you must still input your grades into Self-Service using the University’s official 4.0 scale.

Basic Steps (Detailed Steps Follow)

- Design and build your course.
- Delete unnecessary columns such as extra student information and duplicate total/weighted total columns.
- Add columns via deployment of tests, surveys, assignment tools, and discussion board grading, then modify those columns as necessary.
- Add any other columns you’ll need.
- Set up a calculated column, e.g., running weighted total.
- Click the Preview User icon in the upper right to enroll your preview user (test student) into your course.
- When done, click the Exit Preview button and select “Keep the preview user and all data,” then click Continue.
- Enter comments and test scores for you as your test student as if the semester were over.
• Click the **Preview User** icon again to view the course as a student and click on **My Grades** from the **Tools Menu**. Check to make sure grades are reporting properly, descriptions are clear, comments look okay, and that tests and surveys work properly to avoid errors during the semester.

**IMPORTANT:** You will need to submit your final grades for the semester using Banner, Self-Service Center. Blackboard will not do this automatically. Please call your department if you need help submitting grades.

**Viewing and Accessing Grades**

Instructors, Teaching Assistants, and Graders are the only roles in Blackboard that can edit and view the full Grade Center. This view includes all assignments, menus, and grades for **all** students. Students can only view and access their own grades and related information. They are never able to see another student’s grades.

Instructors access the **Grade Center** from the **Control Panel**, and then select **Grade Center ➔ Full Grade Center** (see image at left).

NOTE: Students access their grades from within each course via **Tools ➔ My Grades**. Many instructors add this tool to their course menu. Here’s how:

- Make sure **Edit Mode** is set to ON.
- Point to the ‘plus sign’ icon on the upper left of the course menu and click **Tool Link**.
- Type in a name, such as ‘Check Your Grades’.
- Change ‘Type:’ to **My Grades**.
- Click Available to Users.
- **Submit**.

**Grade Center Basics**

**Step One: Make the Most of your Space**

The grade center is a basically a spreadsheet comprised of columns and rows. Students are automatically listed in the Grade Center, appearing as rows, when they are enrolled into your Blackboard course. Columns are manually added by you or automatically added when you add an item to your course with a graded component (such as an Assignment, Test, Journal, Wiki or Blog).
To conserve space, it is recommended that you hide some of the default columns included in every grade center. These include: Username, Student ID, Last Access, and Availability.

![Grade Center](image)

Here’s how to hide student information columns:

- Point to the column heading such as ‘Username’ and click the arrow to reveal the drop-down menu.
- Click Hide Column.

It’s important to hide only student information columns (see them circled above) as opposed to hiding any of your graded columns. Using ‘Hide Column’ for graded columns only hides the columns from you; your students can still see them in their ‘My Grades’ and it may cause confusion.

To further save space and reduce confusion for your students, it would be best to remove the extra ‘final grade’ columns that appear such as **Weighted Total** and **Total**. You may find several of these since they are duplicated by course copying and by the Blackboard system course creation process. These columns help you set up your final grading scenario, so you only need to keep one. Use **Weighted Total** to help you set up grading if you weight grades to arrive at a final grade, and use **Total** to help you set up grading if you add points to arrive at a final grade.

Here’s how to delete extra **Weighted Total** and/or **Total** columns:

- Point to the column heading such as ‘Weighted Total’ and click the arrow to reveal the drop-down menu.
- Click **Delete Column**.

**NOTE:** If you see a green check in the column heading, it will stop you from deleting the column. To continue, move the green check to a column you want to keep. Here’s how:

- Click the arrow in the label of a column you want to keep.
- From the drop down menu, click **Set as External Grade**. Note that students will **ALWAYS** be able to see this column.

The green check will move to that column and allow you to delete the columns you do not want to keep.
Step Two: Creating Columns in the Grade Center
You have the option of creating columns either manually or automatically. Automatic columns will appear linked to any item you add to your course that has an automatic grading option (such as Assignment or Test) and those items that you have chosen the option of grading within Blackboard. It’s best to create your course fully, then add any columns manually that have not been already added.

1. To create a column in Grade Center, select **Create Column** (see image below).

   ![Creating a Column in the Grade Center](image)

2. Fill in the column name and description.
3. Assign it to a category, which is used for weighting grades by category, for example, all items with the category of ‘Test’ are weighted at 20% in final grades.
4. Assign points possible (100 point totals are easiest and recommended).

Grade Center columns are added automatically whenever you add tests or Surveys, Assignments, and any graded activity to Blackboard.
**Step Three: Checking and/or Editing Grade Center Columns**

To edit or find out information about a column, click the arrow next to a column heading. A drop-down menu opens. Some of the options you may see are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Column Information</td>
<td>Shows information about the column.</td>
</tr>
<tr>
<td>Grade Attempts</td>
<td>Shows what students have submitted.</td>
</tr>
<tr>
<td>Grade with User Names Hidden</td>
<td>Allows anonymity while grading.</td>
</tr>
<tr>
<td>Reconcile Grades</td>
<td>Allows you to review grader progress for the current assignment, and provide an official reconciled grade for each attempt (useful when multiple graders).</td>
</tr>
<tr>
<td>Assignment File Download</td>
<td>Allows you to quickly download all submitted documents for that grade column.</td>
</tr>
<tr>
<td>Assignment File Cleanup</td>
<td>Will delete documents associated with any or all students by selecting the users and clicking Delete.</td>
</tr>
<tr>
<td>Rubric Evaluation Report</td>
<td>Displays the average results of evaluations using the selected Rubric for the selected Grade Center column.</td>
</tr>
<tr>
<td>Edit Column Information</td>
<td>Allows you to go back into the column to modify it.</td>
</tr>
<tr>
<td>Column Statistics</td>
<td>Shows statistics for that item, such as grade distribution.</td>
</tr>
<tr>
<td>Set as External Grade</td>
<td>Allows one grade to show outside of Grade Center. This cannot be blocked from student view and cannot be hidden.</td>
</tr>
<tr>
<td>Hide from Students (on/off)</td>
<td>Allows you to show the column to students or hide the column from students.</td>
</tr>
<tr>
<td>Clear Attempts for All Users</td>
<td>Clears any submitted work for that grade column.</td>
</tr>
<tr>
<td>Sort Ascending/Sort Descending</td>
<td>Sorts the column by grade. Note that when you select this, all other information will be carried with that particular sort. To resort by last name (default view), click on the last name column heading.</td>
</tr>
<tr>
<td>Hide from Instructor View</td>
<td>Hides the column from your view only. Students can still see the item unless you have hidden it using the show/hide to users option.</td>
</tr>
</tbody>
</table>

These options vary slightly when created automatically, reflecting the tool’s capability.

**Step Four: Setting up a Calculated Grade Column**

After you have created your Grade Center columns, you are ready to set up the calculated column. If you don’t have one, select **Create Calculated Column > Weighted Column** or **Total Column**. After providing the column name and description, you have the ability to select columns and/or categories that will make up the final grade by setting it as the external grade.

The weighted totals column will need to be adjusted by going to **Edit Column Information** and applying weights to assignments or categories created. As setting up the Weighted Total column can be a bit complicated, it is recommended you set an appointment with FCLD to come in for a consultation on setting up your grade center. Make sure you have your syllabus with you when you come to your appointment.
Step Five: Entering Grades
To enter grades in Full Grade Center:

- Click into a cell for a graded column.
- Type the grade.
- Click Enter.

Depending on the type of column, e.g., Assignment Tool, Graded Discussion Board, the menu of each cell provides options for viewing work, adding comments, and grading. Click the arrow associated with each cell to use other tools such as View Grade Details, or Grade User Activity, etc.

Downloading Grades
To download grades or print a roster in Full Grade Center, point your cursor to Work Offline located in the upper right and select Download. Fill in information for “Data” based on what you want to download, leave “Options” as set, click Submit, and then follow your browser’s cues to download.

General Tips and Tricks
Feedback is one of the most important tools in teaching and learning. Using Grade Center affords many feedback pathways: grades, anonymous surveys (input from students, results for you!), comments to students, printable reports, email, and benchmarks such as a mid-semester grade.

Here are a few tips and tricks that may help you take full advantage of Blackboard’s Grade Center.

1. A great view of your Grade Center is available from Full Grade Center by clicking Manage Column Organization.
2. Click on the Student Preview button so you can see your course from a student’s point of view.
   - Take tests and surveys, do assignments, and monitor how Grade Center performs so you have a good idea of what to expect during the semester.
   - As the Preview User, click Tools on the course menu, and select My Grades.
   - When done, click the Exit Preview button. Make sure you select the second option in the pop-up window that says “Keep the preview user and all data,” then click Continue.
3. Make adjustments before the semester begins in order to avoid frantic emails from students, as changes midterm may affect grades negatively and students may comment about it.

4. The Grade Center offers tools for analyzing and reporting on your Grade Center data. For instance, you can set up a couple of short surveys at the beginning and middle of your course, and then use the results to adjust content and delivery if necessary.

5. Hide your final total columns if you do not want students to see Grade Center’s calculations.

6. If your **Total** and **Weighted Total** columns do not seem to be adding up correctly, check the Points Possible you have given to each assignment. We recommend using 100 points as a raw score default, even if you use letter grades.

**More...**
Additional instructions, how-to videos and other documentation is available in the following locations:

- Select **Help>Blackboard Help for Instructor** under the Control Panel of Blackboard courses or click this link: https://en-us.help.blackboard.com/Learn/9.1_2014_04/Instructor
- Visit FCLD’s website and click the “Teaching with Blackboard” menu item or go to: https://www.hartford.edu/faculty-staff/faculty/fcld/teaching-blackboard/default.aspx
- Visit Blackboard’s **On Demand Learning Center** website: http://ondemand.blackboard.com/
- Since Blackboard’s learning management system (LMS) higher education market share is about 50%, ‘Google’ your inquiry and you’ll find plenty of university-based instructions.

**IMPORTANT:** It is strongly recommended that you attend a Grade Center seminar. Please contact FCLD to find out when a Grade Center seminar is offered. Call 768-4661 or email fcld@hartford.edu or go to http://hartford.edu/fcld and click on the Workshops link on the left side of the page to see upcoming FCLD seminars.
One of the best ways to learn about teaching online is hearing about the experiences of instructors who have taught online in the past. University of Hartford instructors will show their online courses, share tips & tricks, and field questions from audience participants in this informal Q & A session.

Learning Objectives

- Share best practice principles in creating an online course.
- Discover how to make discussions and content meaningful to students.
- Share how to take a ‘conversational’ tone in your online course as you would in your face-to-face course.

Additional Resources/Web Sources

Visit the Seminar 6 Learning Module in your Preparing to Teach Online course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
SEMINAR 7: ADDITIONAL TOOLS FOR TEACHING ONLINE (OPTIONAL)

Experience more advanced tools that can be used for teaching online such as Narrating PowerPoints, Explain Everything, YouTube, Video Everywhere, Ensemble, Echo 360 Personal Capture, and WebEx. Discuss best practices for several tools and when it is best to use them for different applications.

The topic of Seminar 7 will help you get an idea of educational technologies you may need outside of Blackboard tools.

Common questions from online instructors:

- How can I create videos that capture my screen and voice to demo software, create ‘how-tos’, offer feedback on written text, or otherwise capture what’s on my screen and add my narration?
- I have long-standing PowerPoint or Keynote presentations that I use during my teaching, how can I narrate them to use for online teaching?
- What can I use for synchronous meetings for ‘office hours’, test review, personal feedback, ‘oral reports’, etc.
- How can I record just my voice, or just a quick video of me with my voice? I would like to introduce myself or intro new topics this way, but don’t want to spend time/money to make ‘big productions’.
- Can I record my voice and writing to show a worked problem, for instance?
- Does my publisher have content that may help me build my course?

Seminar Contents
Creating Digital Content for Online Teaching and Learning ..................................................... 191
Capturing Your Computer Screen including Audio (Your Voice) ............................................. 192
Helpful Tips for Audio Recording .............................................................................................. 193
Narrating PowerPoint .................................................................................................................. 194
Creating a Narrated PowerPoint ................................................................................................. 195
Getting Started with Ensemble ................................................................................................... 196
Using Ensemble Anthem Screen Capture .................................................................................. 212
Explain Everything ..................................................................................................................... 224
Additional Resources/Web Sources
Visit the Seminar 7 Learning Module in your Preparing to Teach Online course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
## Creating Digital Content for Online Teaching and Learning

### How can I create videos that capture my screen and voice in order to:
- introduce my course and myself
- create ‘how-to’ videos
- create quick topic intros/summaries

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensemble Anthem (UH License)</td>
</tr>
<tr>
<td>Snagit</td>
</tr>
<tr>
<td>Camtasia</td>
</tr>
<tr>
<td>Quicktime on a Mac (free)</td>
</tr>
</tbody>
</table>

### How can I create videos that capture my writing and voice to:
- Show worked problems
- Annotate and talk over images
- Annotate and talk, such as for offering feedback on written work

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensemble Anthem (UH License)</td>
</tr>
<tr>
<td>Echoopen</td>
</tr>
<tr>
<td>iPad apps: Explain Everything, Educreations</td>
</tr>
<tr>
<td>Camtasia + Smoothdraw + Bamboo tablet</td>
</tr>
<tr>
<td>Camtasia + Smoothdraw on a tablet computer like Microsoft Surface</td>
</tr>
<tr>
<td>Work on a Sympodium/SMARTBoard</td>
</tr>
</tbody>
</table>

### I have prepared PowerPoint/Keynote presentations that I use during my teaching. How can I narrate them to use for online teaching?

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Narrating PP using PP</td>
</tr>
<tr>
<td>Narrating Keynote using Keynote.</td>
</tr>
<tr>
<td>Ensemble Anthem (UH License)</td>
</tr>
<tr>
<td>Narrating with the Camtasia ‘add on’</td>
</tr>
</tbody>
</table>

### What can I use for synchronous meetings to accomplish:
- office hours,
- test reviews,
- feedback,
- oral presentations

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebEx (free for UofH faculty; free for attendees)</td>
</tr>
<tr>
<td>Skype or Skype for Business</td>
</tr>
</tbody>
</table>

Remember, though, that asynchronous communication and collaboration is a better choice for online teaching and learning.

### How can I record just my voice, or just a quick video of me with my voice? I would like to introduce myself or intro new topics this way, but don’t want to spend time/money to make ‘big productions’.

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensemble Anthem (UH License)</td>
</tr>
<tr>
<td>Audacity</td>
</tr>
<tr>
<td>SoundCloud</td>
</tr>
</tbody>
</table>

### Publisher Content and other resources

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Talk with your publisher rep</td>
</tr>
<tr>
<td>Explore OER and Creative Commons</td>
</tr>
</tbody>
</table>

### Where can I store my media (video and audio) files?

<table>
<thead>
<tr>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensemble (UH License), links to Blackboard</td>
</tr>
</tbody>
</table>
# Capturing Your Computer Screen including Audio (Your Voice)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Manufacturer/Website</th>
<th>Cost</th>
<th>Free Trial</th>
<th>Ease of Use</th>
<th>Other Information</th>
</tr>
</thead>
</table>
| Ensemble Anthem    | Ensemble is UH Licensed https://ensemble.hartford.edu | Free to Faculty and Staff, fill out request form |            | Easy        | --Great for creating quick videos for introductions, showing students around your own course, quick how-tos, etc.  
                             --Unlimited number of videos  
                             --Easy to open, capture, record, and save quickly.  
                             --Links directly to Blackboard |
| SnagIt             | TechSmith https://www.techsmith.com/snagit-pricing.html | $30/edu pricing | 30 days    | Easy        | --Screen capture (pictures) with editing possibilities like adding arrows or circles, etc.  
                             --Screen capture short videos |
                             --Has a steeper learning curve than Ensemble or Snagit but does a LOT more in terms of adding enhancements to video.  
                             --Works great with PP, i.e., you can import a PP, narrate over it, and save a video. |
| Captivate          | Adobe http://www.adobe.com/products/captivate.edu.html | $399/edu pricing | 30 days    | Difficult   | - Designed to capture and create sophisticated interactive online tutorials, but can also be used like Camtasia to narrate a PowerPoint.  
                             -More complex so more difficult to learn. |

If you want to capture your screen while you write and talk – like working through a math or statistics solution - there are a lot of options to do this. Contact FCLD for more information and referrals to faculty on campus already doing this.
Helpful Tips for Audio Recording

Here are some basic pointers for recording which can assist in improving the quality of your presentations:

1. **Invest in a good microphone.** Most laptops have built-in microphones, but the quality of these is not always the best for narrating PowerPoint or Personal Capture. For improved quality, it is recommended that you purchase a USB microphone rather than an analog (the two metal end type) microphone. If you have another electronic portable device that enables recording, you may be able to use that as many models have built-in microphones. [http://amazon.com](http://amazon.com) has great USB microphones for less than $50.00.

2. **Microphone positioning.** Make sure your microphone is positioned close to your mouth, but not eating the microphone. You want to have a good, quality recording, but not sound like you’re over modulating or causing feedback for your student listeners.

3. **Record in a quiet room.** Some background noise is inevitable, but make sure it’s not too distracting. Try to avoid distractions such as background chatter, ringing phones, or barking dogs. Unplug machines and turn off fans and air conditioners. Sometimes your microphone drivers allow you to eliminate background noise. Light noise makes you more personable.

4. **Read from a script.** Have your script ready (typed and spaced presenter notes). Rehearse your script before recording. Create a conversational tone and pretend you’re talking to your class instead of just reading the script. Practice it a few times to make sure it flows right. Don’t worry about the uhs or ums in there… It just makes you more personable.

5. **Speak at a constant volume.** Try to maintain the same speech level throughout your presentation so as to avoid fluctuations in your voice. If you have to stop recording and start again, make sure to rewind and listen to your voice again and try to match the same pitch and volume when you start recording again.

6. **Speak in a friendly and casual tone.** Practice what you say, try to sound natural and friendly. Smile! When you smile while you speak, it makes a difference in your voice. Try not to sound too formal or serious or you may bore your students and distance them from your content. Don’t rush through speaking. Speak normally and enunciate. Don’t speak too slowly. Find a happy medium pace while speaking.

7. **Review your recording.** Do an initial test and play back immediately. This will help you find an optimal speaking volume and tone and help with getting your microphone positioned properly to have a nice, decent recording. Don’t worry about editing any flubs, ums or ahs.
### Narrating PowerPoint

<table>
<thead>
<tr>
<th>Tool</th>
<th>Pros</th>
<th>Cons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using PowerPoint</td>
<td>• Familiar, i.e., you already know how to use PowerPoint.</td>
<td>• Narrating is per slide only, i.e., you can’t click to the next slide while talking, rather you need to stop talking, change slides, then start talking again. *</td>
</tr>
<tr>
<td></td>
<td>• Already have PowerPoint – nothing to purchase.</td>
<td>• Different ways audio file is handled depending on whether you are using PP on a PC or a Mac.</td>
</tr>
<tr>
<td></td>
<td>• Can use your PowerPoint presentation as is (although breaking them up into fewer slides is recommended).</td>
<td>• Resulting file with narration can be huge, so we recommend you upload it to our in-house YouTube, Ensemble (OTS can provide a user account). (* However, if you use Keynote on a Mac, “Record Slideshow” is very easy to use for narrating, and you CAN talk and move around your slideshow freely.)</td>
</tr>
<tr>
<td></td>
<td>• Only equipment needed is your computer and a headset (or just use the built-in mic on a laptop).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The resulting file is all-in-one and handled just like your ‘regular’ PP.</td>
<td></td>
</tr>
</tbody>
</table>

| Using Ensemble Anthem | Free Ensemble Anthem account for University of Hartford Instructors | Need to get an account and familiarizing yourself with the Ensemble Anthem interface. |
|                       | • Display your PowerPoint, Website or anything on your screen, record the session with or without a webcam and narrate – do not stop on every slide. |                                                   |
|                       | • Links into your Blackboard course                                   |                                                   |
|                       | • Students easily access in Blackboard, streaming media so no need to download. |                                                   |

| Using Camtasia        | Works seamlessly with PowerPoint, i.e., open your PP in Camtasia and just narrate. | Need to buy Camtasia, although you do have the option of using it free for 30 days. |
|                       | • Only equipment needed is your computer and a headset (or built-in mic). | • Need to learn Camtasia’s interface. |
|                       | • Great finished product.                                               |                                                   |

With all media creation, you will be faced with the problem of what to do with the large files that you create. Media files – video, audio, combination of both, screen captures – are usually very large files. For files like these, it’s best to have them streamed to your students as opposed to having them stored in Blackboard where students need to download them to view. If you can, use a technology that stores video for you and give you a link for streaming (like TechSmith products), or be sure to get an Ensemble account to you can store your media files and just link to them within Blackboard.
Creating a Narrated PowerPoint

Adding narration to a PowerPoint can help instructors to create standalone “mini lectures” that can be uploaded to Ensemble and linked within Blackboard (as narrated PowerPoints can be quite large). Students can view the PowerPoint and hear the instructor’s commentary right from their computers at home, allowing instructors to free up class time for interactive engagement or to make up canceled classes. Narrated PowerPoints can also be used in online classes to provide students with the mini lectures or ‘lecturettes’ on key content or concepts.

To record narrations in PowerPoint, all you need is a computer microphone – you don’t need to download any additional software. Ideally, you would want a headset with microphone.

Here are the steps for adding narration to your PowerPoint:

- Create your PowerPoint presentation as you would normally do, or find an existing presentation you would like to narrate.
- Click on Slide Show → Record Slide Show → Start Recording at the top of the screen to start recording your narration.
- While recording your narration, click on the mouse to advance the slides.
- When you are finished recording, right click on your mouse and select End Show or use the esc key. Be patient, it might take a moment to end.
- Save the presentation and upload it to Blackboard.

Adding Narration to a PowerPoint

First, you will need to create your PowerPoint presentation and save it. (You can’t record narration until you have saved the presentation first.) To begin adding narration, go to Slide Show → Record Slide Show.

A window will appear, asking you what you want to record. Be sure to check both boxes and select Start Recording.

Your presentation will open in a new window. You can begin your narration, clicking the mouse to advance your slides as you speak.

Important: PowerPoint records the narration as an individual audio file for each slide. Be sure to pause when you have finished narrating a slide and do not begin again until the new slide has appeared, otherwise, you will clip part of your audio.
When you are finished recording your narration, right click and select **End Show** or use the **esc** key.

**Viewing your Narrated PowerPoint**
To view your completed presentation, click on **Slide Show** and select **From Beginning**.

The narration will begin and the slides will advance automatically as you view the presentation.

**Saving and Distributing your Narrated PowerPoint**
It is a good idea to save the narrated PowerPoint as a new file, in case you ever need to go back and edit or change the original PowerPoint. To save the narrated version, go to **File ➔ Save As**. Be sure to give it a new name so it doesn’t overwrite the original.

Narrated PowerPoints are large, posing problems for students and storage. To get around this, we export the narrated PowerPoint as a video file, then upload it to Ensemble.

To save your presentation as a video, go to **File ➔ Export** and select **Create a Video**. Be patient! Conversion can take a long time...look for the progress bar at the bottom of the PowerPoint screen and wait for it to finish.

Now that it is a movie file, we can upload it to Ensemble (see page 196).

**NOTE: For MAC Users**
There is a known issue saving PowerPoint (2011) as videos for MACs. It creates two files, an audio and an image file, and loses the audio part. Two solutions can be tried to resolve this:

1. Open the PowerPoint presentation in Keynote and export to Quicktime (easiest).
2. Do a screencast of giving your presentation with Ensemble Anthem.

**Getting Started with Ensemble**
Ensemble Video is an in-house video server like YouTube and was designed for publishing and sharing large media files, such as audio and video files. It can be used to share video lectures, instructional videos, and helps centralize campus media by providing ‘one stop media shopping’
Preparing to Teach Online | Faculty Center for Learning Development

for students and faculty. Ensemble is user-friendly and intuitive, and uploaded videos are organized into libraries that can be shared with others. Since videos are streamed rather than downloaded to a person’s computer, they are better protected. Ensemble videos can be accessed from a website, a playlist or directly with Blackboard, providing an easy way to share videos with students in a class.

**A few important details:**

- Instructors must request a user account in order to start using Ensemble.
- Maximum upload video size is 12 GB (about 150 minutes of iPhone HD video).
- Instructors should KEEP copies of original uploaded videos. Ensemble compresses them into several formats suitable for streaming, and then DISCARDS the original.
- Instructors looking for permanent storage of videos should discuss options with OTS.
- **NOTE:** Ensemble will not reorient videos recorded vertically.

**Logging into your account:**

- Email [OTS@hartford.edu](mailto:OTS@hartford.edu) to request an Ensemble user account be set up for you.
- Go to [https://ensemble.hartford.edu](https://ensemble.hartford.edu)

![Image of Ensemble login page]

- Enter your login information. Your username is the same as your Hartford username (without @hartford.edu) and your password is your University email password. Be sure to set *Identity Provider* dropdown to **Faculty**. Then click the **Login** button.
You are now at the main page of your media library. The main menu buttons for your account are found at the top of the page and along the left side as shown below.

**Uploading a video to your ensemble account**

- If you aren’t there already, click on the Media Library button. The Media Library contains all your uploaded videos and is also where you can upload additional videos. Uploaded videos are shown as thumbnails.
- To publish a new video click on the +Add button.

You will be presented with a series of screens allowing you to provide basic information about the video, including title, date of creation, credits, and more. The first screen is the Enter Description page. From this screen, add the video’s title, description, keywords and credits.
The Edit Page

1. Keywords will help you to locate videos in your library and will be useful when you have lots of videos in your library and you need to find one quickly. Be sure to separate Keywords with commas.

![Enter Description]

2. In the Credits section, you have the option of providing information about who made the movie. If you have multiple contributors, you can click the + Add Credit button to add another person.

![Enter Credits]

3. At the bottom of the screen, click Continue to proceed to the Manage Content page.
**Manage Content Page**

1. Under *Options*, Audio/Video is selected by default. You can change this to other options.
2. Under *Workflow*, select the correct video format.
   - Choose **ScreenCapture** for videos such as narrated PowerPoint presentations or software demonstrations, when clarity of detail outweighs smooth motion.
   - Choose **Widescreen** for videos that have the extended rectangular shape of a movie screen or widescreen TV (16:9 aspect ratio).
   - Choose **Standard** for video that has the normal “TV square” shape (4:3 aspect ratio).

The Manage Video Page

3. Click **Add File**. Locate the video file you wish to upload and follow the instructions in the upload window OR drag and drop the file from where you have it saved on your computer into the middle of this upload interface where it says **“Drag file here.”**
4. Click the **Start Upload** button, then WAIT FOR THE UPLOAD TO FINISH. (See picture below.) If you continue before it finishes, it will fail to upload.
5. Auto-Captions will be on by default if you are teaching an online course, flipped or hybrid course. If Auto-Captions are greyed out and you are teaching one of these types of courses, contact OTS@hartford.edu to enable captions for you.

6. Once the progress bar has reached 100%, the screen below will appear down in the Media section. After you upload your file, Ensemble converts the video into a streaming file. As your content moves through the process, Ensemble posts status updates via a series of messages: Waiting for Conversion, Converting...ending with File Ready. The full process may take some time, as there may be several copies. Depending on the bandwidth chosen, Ensemble may prepare many versions suitable to different devices and bandwidths. In this case, it’s OK to advance before the conversions finish. You may now click Continue.
**Publish Page**
The next page is the *Publish page*. If you have set up playlists and libraries, they will show up here and you can then add your video to a playlist (must be created first.) Additionally, you will see some other ways to share/publish your videos.

---

**Choose to Publish your Video to a Playlist or Share**

Below are descriptions for each:

<table>
<thead>
<tr>
<th>Playlists</th>
<th>Allow you to publish videos to a list that you can then embed a group of videos together in your Blackboard course or on a website.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared Libraries</td>
<td>Allows you to create library or collection of videos to share with others. Great for creating a departmental set of videos on a specific subject (e.g. Calculus I videos) to share with others in your department.</td>
</tr>
<tr>
<td>Groups</td>
<td>Allows you to share videos with students, faculty or Ensemble administrators as “groups.”</td>
</tr>
<tr>
<td>Social Sharing Tools</td>
<td>Share your videos on <img src="twitter.png" alt="Twitter" />, <img src="facebook.png" alt="Facebook" />, <img src="google.png" alt="Google+" />, <img src="linkedin.png" alt="LinkedIn" />, <img src="pinterest.png" alt="Pinterest" />, <img src="email.png" alt="Email" /></td>
</tr>
<tr>
<td>Schedule Publishing</td>
<td>Set Display After and Display Until dates (much as you would within your Blackboard course.</td>
</tr>
</tbody>
</table>

When done, click **Publish**. You will now see the video listed in your Media Library.

**Automatic Captions in Ensemble**
This section will be explained in more detail in Seminar 8.
Publishing your Video to Blackboard

- Log into Blackboard.
- Click on Recordings, Course Documents, or another place you wish to put the video. Be sure that Edit Mode is "ON."
- Click Build Content ➔ Ensemble Video.
- It may tell you that you are connecting to an LTI service, click Launch.

Ensemble should pass through your login credentials to Blackboard (if you already have an Ensemble account); however, if it doesn’t recognize you, it may ask you to input your login credentials. Remember: Your username is the same as your Hartford username (without @hartford.edu) and your password is your University email password. Be sure to set Identity Provider dropdown to Faculty. Then click the Submit button.

You can either click the Choose Media button at top (default), if you just want to search your entire library (which once logged in will display in the browser window, Choose Playlist to select a playlist that you have pre-set up in Ensemble, Choose Dropbox to select a student submission form, or Choose Quiz to choose from a preset Ensemble Quiz.
Choose Media
To add one of the videos from the library (as shown above), click the green + sign under the video. Instructors can search their library by typing the name of the video into the search bar or by scrolling through the entire Media Library. You can also choose to preview the video by clicking the black arrow button.

Video Options
Once you click the green + button, you can choose additional options by clicking the cog icon (Media Embed Options). If you are using this for course content, be sure to include an accessible version too (e.g. lecture notes, transcript, etc.) or enable captioning. You can do this by selecting Captions “On” by Default. See options below, choose as you like, then click Save.

When done, click Save again next to your video. The video should now be added to your content page. Please be patient while videos load.
**Choose Playlist**

This option allows you to choose pre-set playlists of videos to show in Blackboard. For details on how to create playlists, the directions follow.

- Click the green + button next to the playlist you want to add.
- In the new window that appears, choose how you want to add the playlist (either as a link to the playlist, or embedding the playlist directly into Blackboard), then click on **Save**.

![Add Playlist](image)

**Creating an Ensemble Playlist**

An Ensemble Playlist is a web page that displays a collection of Ensemble videos selected from your Media Library.

- From the *Media Library* page, click on the **Playlists** button on the left menu.
- Click **Add** then give it a name. Click **Save**. This creates a playlist within Ensemble.
- The logo allows you to include a logo next to videos in playlist (it is optional).
- A new window will display the title of the Playlist.
Categories
A new feature of Ensemble is to organize your playlist by Categories. For example, you are teaching CS110 and want to organize your videos by week. Once you have created your Playlist, click the Categories button, then click Add to add a category into the playlist.
Publishing to an Ensemble-Created Playlist

Now that you have created a playlist, it will appear as a publish option whenever you upload a video and add it to the playlist on the Publish page.

- You can also add previously uploaded videos to the playlist.
  - Go back to Media Library on the menu on the left.
  - Find the video you want to add to the playlist. Then click the Publish button under it.

Video in Media Library – Click Publish

- Select the playlist we had previously created, then click Publish.

Selecting the Playlist

- To add more videos to the playlist, return to your Media Library and click the Publish button next to those videos you wish to add.
- All playlists will be listed. Select the playlist you want, then click Save and Publish.

Choose Dropbox

Instructors have the ability to create a “Dropbox” within Ensemble, which generates a form for student submitted videos or audio files. The instructor creates the Dropbox within their Ensemble account at https://ensemble.hartford.edu and can then link the form within Blackboard. NOTE: Video or audio files submitted via this form appear in the Instructor’s media library in Ensemble.
This option allows you to choose these pre-set dropboxes to link to.

1. Click the **Choose Dropbox** tab.
2. Find the **Dropbox** that you want to link to within the list, then click the **Choose button** next to it.

### Selecting the Dropbox

3. Then either Preview, or click **Save** to continue.
4. The link to your submission form will appear at the bottom of your content area.

---

**Choose Quizzes**

This option will allow instructors to embed video quizzes pre-created within Ensemble.

1. Click the **Choose Quiz** tab.
2. Find the quiz you want to embed, then click the **Choose button**.
3. Preview the Quiz, choose your Quiz Embed Options (make sure Captions are “On by Default”, then click Save.

![Ensemble Quiz Options](image1)

4. Your quiz will appear at the bottom of your content area. Note, that this is a link and not an embedded quiz, and will open in a new window when clicked.

![Ensemble Quiz Link in Blackboard](image2)

5. Click the link to open. The Quiz will give directions to the students, and then prompts them to Start Quiz.

![Start the Quiz](image3)

6. The questions will appear at the point in the video in which you inserted them.
Quiz questions start at the point you entered them in the video

**Publishing your Video to a Website Outside of Ensemble or Blackboard**

If you are publishing to personal or company web server, getting the embed codes for Ensemble is now easier than previous versions.

- Go to your Media Library.
- Find the video you want and under it, click the `<>` **Embed** button.

There are two types of embed code you can choose, the iframes-based code (which is the default) or Javascript, as well as set a few other customizations (like adding the Title, Auto Play, Captions, Hide Controls, and Social Tools). Try the iframes embed code first and if it doesn’t work, switch to the Javascript embed code.
**Publishing your Video to YouTube (YouTube account required)**

- From the left tool bar, click **Administration → Library → YouTube**
- Fill in the necessary information. You may have to click on the “Help” button to find out how to obtain some of the information from your YouTube account.
- Click **Update**.

![Input YouTube Credentials](image)

**Advanced Ensemble Features**

Ensemble has several other features of note, including:

- Shared Libraries – allows others to transfer or copy videos from your media library (i.e. think of a department that shares videos.)
- A Dropbox that can be used for student submissions.
- The ability to annotate videos.
- Auto-publish RSS feeds for iTunes/iTunes U.
- Google Analytics for tracking how many people view the videos.
- Activity reporting.

Please see the Content Administrator Guide for further information on these topics [http://support.ensemblevideo.com/](http://support.ensemblevideo.com/).
The University of Hartford has a lecture capture platform, Anthem, which is part of our Ensemble streaming media platform. Lecture capture records an instructor’s lecture and then provides students with a link to the recording in Blackboard or via email for later playback. This is often referred to as **Personal Capture** (often referred to as PCAP), and is used to record mini-lectures or demonstrations or to explain difficult concepts so students can review them at home. These recordings can be used to “flip your classroom” — a strategy where students watch short, pre-recorded video “lectureettes” and use the class time for discussion or application of the material.

This guide provides an overview to getting started with **Ensemble Anthem Screen Capture**, including technical requirements, tips and best practices.

Here are the steps for recording a mini-lecture with Ensemble Anthem:

1. Fill out the Ensemble Request form on the FCLD website at: [https://www.hartford.edu/faculty-staff/faculty/fcld/blackboard-course-requests-forms/ensemble%20request%20form.aspx](https://www.hartford.edu/faculty-staff/faculty/fcld/blackboard-course-requests-forms/ensemble%20request%20form.aspx).
2. Log into Ensemble and click the **Record** button to download Anthem to your home or office computer.
3. Click the **Record** button again to begin recording mini-lectures using audio, webcam video and screen shots from your computer.
4. Link the recordings to your Blackboard course.

**Install Ensemble Anthem (PC)**

Before recording for the first time (on any new computer), you will need to download and install the Ensemble Anthem software. This is for individual use only. Please do not install on classroom computers.

1. When you are in Ensemble in any web browser, you will see a record button near the top of the window as shown below. Click on the **Record** button.
2. A new window will appear asking you if you have installed the Ensemble Anthem Screen Capture application. It should auto detect that you are using a PC, and at the top of the window, click on Download.

![Click on the Download button to download to your computer](image)

3. After the installer file downloads, open the installer file and run through the install process. Once it is complete, the application will be installed on your machine.

**Begin Recording**

There are two ways to record using Ensemble Anthem:

A. You can open the Ensemble Anthem application directly from your computer.

B. When you are logged into Ensemble in any web browser (https://ensemble.hartford.edu), you will see a record button near the top of the window as shown below. Click on the Record button.

![Click Record to get started](image)

A message will appear, as shown below. Click on Open Ensemble Anthem. To stop this message from appearing in the future, click on the box next to Always open these types of links in the associated app.

![Click the Open Ensemble Anthem button](image)
The Ensemble Anthem application will open and you will see the window shown below.

There are four different options for recording:

**Screen:** Records the screen and from a microphone.

**Screen & Webcam:** Records the screen, the microphone and video from a webcam.

**Webcam:** Records from a webcam and microphone.

**Voice:** Records from a microphone.

If you would like to record your computer screen, click on **Screen**. A new window will appear, asking you to select a screen (if you have multiple monitors), and then asks you to select an area to capture, either the full screen or a specific area of the screen, as shown below. When you have selected your options and are ready to record, click the **Record** button.

A window will appear along with a countdown letting you know when Anthem will begin recording, as shown below.
- To Pause/Resume the recording at any time, press Alt + P.
- To Draw on the recording, press Alt + D.

While you are recording a screen capture, there will be a menu in the corner of your screen, as shown below. Sometimes, this window will be hidden and you will need to find the Ensemble icon located at the bottom of your Windows Toolbar and click on it to open it.

**Locate the Ensemble Icon on your Windows Toolbar**

![Recording Screen Capture](image)

**Recording is in Progress, use the Tools if needed**

**Draw:** Click the pencil icon to draw on the screen while you are recording it. This allows you to highlight certain areas.

**Pause:** This pauses the recording. Click on the pause button again to continue.

**Done:** This allows you to finish the recording and save it.

**Cancel:** This will stop the recording and will not save it.

There is also a timer in the window that will tell you how long your screen capture is running.

**Using the Draw Tool while Recording**

You can annotate screen recordings while in progress by clicking on the Draw button in the *Recording Screen Capture* window.

![Click on the Draw button to annotate your screen recording](image)

When you click on the **Draw** button, a new menu will appear, as shown below. This menu offers a variety of options for annotating your screen, such as free-hand drawing, adding lines and shapes, etc. Click **Done**, when finished annotating with the Draw Tool.
The Annotation Options under the Draw Tool

When you are finished with your recording, click on the **Done** button in the Recording Screen capture menu.

![Recording Screen Capture](image)

Click on the **Done** button to finish recording your screen

**Preview/Edit your Recording and Upload your Video**

A new window will now open, the Video Editor, where you will be able to preview your video, as well as trim certain parts of the video, add titles and credits, etc.

![Video Editor Window](image)

- When you are done making edits to your video, click on the **Done** button towards the bottom of the video editor window.
- The upload video window will appear, as shown below. Here you can give your video a title and a description, and at the bottom of the window, you can also see the length of the video.
**Upload:** This will save the recording on your computer and upload the recording directly to your media library on Ensemble.

**Preview:** This will take you back into the video editor window where you can preview the video and make edits.

**Save:** This will only save your recording to your computer; it will not upload it to your media library in Ensemble.

To upload the video to your media library, click on **Upload**. You will see a progress bar appear, and when it is done, a confirmation that the upload was completed successfully, as shown below.

Your video will now appear in your Ensemble Media Library, and can be displayed in your Blackboard course, on your website or shared as you like. Other Ensemble documentation can be found on the FCLD website at: [https://hartford.edu/fcld](https://hartford.edu/fcld).
Install Ensemble Anthem (Mac)
Before recording for the first time (on any new computer), you will need to download and install the Ensemble Anthem software. This is for individual use only. Please do not install on classroom computers.

4. When you are in Ensemble in any web browser, you will see a record button near the top of the window as shown below. Click on the **Record** button.

5. A new window will appear asking you if you have installed the Ensemble Anthem Screen Capture application. It should auto detect that you are using a Mac, and at the top of the window, click on **Download**.

6. After the file downloads, you will need to add this to the Applications folder. Click on the Ensemble Anthem icon and drag it to the Applications icon.
Begin Recording
There are two ways to record using Ensemble Anthem:

C. You can open the Ensemble Anthem application directly from your computer.
D. When you are logged into Ensemble in any web browser (https://ensemble.hartford.edu),
you will see a record button near the top of the window as shown below. Click on the
Record button.

A message will appear, as shown below. Click on Open Ensemble Anthem. To stop this
message from appearing in the future, click on the box next to Always open these types of links in
the associated app.

The Ensemble Anthem application will open and you will see the window shown below.

There are four different options for recording:

Screen: Records the screen and from a microphone.

Screen & Webcam: Records the screen, the microphone and
video from a webcam.

Webcam: Records from a webcam and microphone.

Voice: Records from a microphone.

If you would like to record your computer screen, click on Screen. A new window will appear,
asking you to select an area to capture, either the full screen or a specific area of the screen, as
shown below (Note: if you have multiple monitors, it will first ask you which monitor screen do you want to record, and then will give you the selection window shown below). When you have selected your options and are ready to record, click the **Record** button.

Select the area to capture, then click **Record**

A window will appear along with a countdown letting you know when Anthem will begin recording, as shown below.

The countdown to start recording begins

- To Pause/Resume the recording at any time, press `option` + P.
- To Draw on the recording, press `option` + D.
While you are recording a screen capture, there will be a menu in the corner of your screen (see Recording is in Progress, below). Sometimes, this window will be hidden and you will need to find the Ensemble icon located at the bottom of your Mac dock and click on it to open it.

Locate the Ensemble Icon on your Macintosh Dock

Recording is in Progress, use the Tools if needed

**Draw:** Click the pencil icon to draw on the screen while you are recording it. This allows you to highlight certain areas.

**Pause:** This pauses the recording. Click on the pause button again to continue.

**Done:** This allows you to finish the recording and save it.

**Cancel:** This will stop the recording and will not save it.

There is also a timer in the window that will tell you how long your screen capture is running.

**Using the Draw Tool while Recording**

You can annotate screen recordings while in progress by clicking on the Draw button in the Recording Screen Capture window.

When you click on the **Draw** button, a new menu will appear, as shown below. This menu offers a variety of options for annotating your screen, such as free-hand drawing, adding lines and shapes, etc. Click **Done**, when finished annotating with the Draw Tool.
When you are finished with your recording, click on the **Done** button in the Recording Screen capture menu.

![Ensemble Anthem: Screen Capture Started](image)

**Click on the Done button to finish recording your screen**

**Preview/Edit your Recording and Upload your Video**

A new window will now open, the Video Editor, where you will be able to preview your video, as well as trim certain parts of the video, add titles and credits, etc.

![The Video Editor Window](image)

- When you are done making edits to your video, click on the **Done** button towards the bottom of the video editor window.
- The upload video window will appear, as shown below. Here you can give your video a title and a description, and at the bottom of the window, you can also see the length of the video.
Upload: This will save the recording on your computer and upload the recording directly to your media library on Ensemble.

Preview: This will take you back into the video editor window where you can preview the video and make edits.

Save: This will only save your recording to your computer; it will not upload it to your media library in Ensemble.

To upload the video to your media library, click on **Upload**. You will see a progress bar appear, and when it is done, a confirmation that the upload was completed successfully, as shown below.

Your video will now appear in your Ensemble Media Library, and can be displayed in your Blackboard course, on your website or shared as you like. Other Ensemble documentation can be found on the FCLD website at: [https://hartford.edu/fcld](https://hartford.edu/fcld).
Explain Everything is an interactive screencasting tool for your phone, tablet or computer. With this tool you are able to pull up websites or open Word documents, PowerPoints, images, etc. and annotate directly on the screen. It acts as an interactive whiteboard app. You can upload your screen captures then to YouTube, Vimeo and a variety of other sites.

With Explain Everything, you can animate and record your screen. Add and transform objects, draw on the stage, and describe your ideas and actions.

Recorded screencasts can be edited on a timeline, and exported and shared as a video, editable project, image or PDF.

You can share your projects, import and export documents, images, videos and Explain Everything creations via integrated cloud video services, file storage providers (such as Dropbox and Google Drive), content management systems and via your regular Windows or Mac Network folders.

Explain Everything is available via iTunes, Googleplay and the Windows Store.
Explain Everything utilizes slide-based storyboarding for preparing explanations and presentations. When recording, all actions on the screen including drawing, moving, scaling, rotating, and addition of objects are recorded along with any audio narration which is captured through the iPad microphone. Explanations and Presentations can be exported and shared as movies and images. Project files can be shared via Email and Dropbox for collaborative design.

It is best to avoid using the **Undo** or **Delete** tools while recording. Use the **Eraser** tool to remove pen drawings while recording, but otherwise pause the recording, delete unwanted objects, and then resume recording in order to prevent objects from reappearing during playback.

**Design Tools**
**Getting Started**

Go to [www.explaneverything.com](http://www.explaneverything.com) and click on **Support → Tutorials** and choose your platform (iOS, Android or Windows) from the dropdown.

**Creating a New Project**

- On the Home Screen tap **New Project**
- Select **Blank Project**

**Editing a Project**

Use the Tools on the left to create visuals – you can create visuals before you record or while you are recording.

- **New Slide** – Add a new slide after the current slide
- **Slide Sorter** – View thumbnails of slides. Press & hold thumbnails to rearrange slide order.
- **Draw Tool** – Pen tool to draw. Press & hold to change style.
- **Laser Pointer** – Press your finger to activate laser pointer.
- **Shape Tool** – Add shapes. Press & hold to change style.
- **Text Tool** – Insert text. Press & hold to change style.
- **Insert Image** – Insert image from photo roll, camera, Dropbox or Google Drive. Crop before inserting image.
- **Delete/Erase** – Tap delete and then select the object you wish to delete and press the red X. This tool becomes an eraser when you are drawing.
- **Arrange** – Tap arrange and then select the object you wish to arrange and move forwards and backwards.
- **Undo** – Undo the last action (doesn’t work during recording)
- **Zoom & Pan** – Zoom in and out using two finger pinch. Use one finger to move around the stage. Double tap to return to 100%.

**Tip:** To save an image in Safari, tap and hold the image. Select Save Image.

**Tip:** To edit a shape or text, double tap on it.
Navigating
To move between slides while recording, tap the forward or back arrows (at the bottom).

Recording
When recording, all the actions on the screen, including drawing, moving, scaling, rotating, and the addition of objects are recorded along with any audio.

Note: Each slide is recorded separately in the project. When the project is saved as a final movie, all the recorded slides will merge as one seamless movie.

Tip: To play the entire project at once, tap and hold the play button, then tap the yellow arrow.

Saving & Exporting
Explain Everything autosaves all projects anytime that you leave the app.

- To save different versions or rename the project, tap Save.
- Select the Video button to export final project to Camera Roll (if you plan on uploading to Ensemble for Embedding in Blackboard)
- You can also export to YouTube, Dropbox, Evernote, GoogleDrive, iTunes, box, OneDrive, Vimeo, youku.com and more.
- Select the Save button to export the file that you can continue to work on your device or Export to PDF, Image or Video File.
Getting your Video from Explain Everything to Ensemble

Follow these easy steps to get your video that you created on your tablet up onto Blackboard:

1. On the bottom bar, make sure you click the Export Video/Project button → click Movie to Camera Roll

2. Explain Everything will take and convert your file to a video (may take 5-10 minutes or more depending on how big your video is). When it is done, it will say 100% complete.

3. Once your video is created, go to http://ensemble.hartford.edu on your tablet.
   - Log in with your username and email password, drop down for faculty.
   - Follow directions found on page 198 to upload your video to Ensemble. Browse your tablet’s camera roll to locate the video(s) you want to import into Ensemble.

4. Once your video is uploaded to Ensemble, log into your Blackboard account and go to your course.
   - Follow directions on page 203 to embed your Ensemble video in Blackboard.
Accessibility and Universal Design are hot topics in education today. Not only is making content accessible the law, it is the right thing to do. It helps learners of all abilities, not just the disabled students. Often, students do not disclose disabilities in an online higher education environment. Unlike in K-12, they are not required to, and you do not know who is sitting on the other side of the screen. Making course content accessible also fosters an environment that welcomes and values students, regardless of ability, and while this clearly helps students with readily apparent disabilities, it also helps non-native speakers, students with learning disabilities, those with differing learning styles, as well as busy parents and commuter students.

In traditional face-to-face instruction, accommodations are made upon student request, but the pacing of online courses prevents this just-in-time approach; instructors need to create accessible courses for all their online courses, proactively anticipating any need for accessible content.

The topic of Seminar 8 will help you get an idea of how to make educational materials accessible and introduce you to some tools to make the process easier.

**Seminar Contents**

- What is Accessibility? ................................................................. 231
- How does this translate to the (online) classroom? ..................... 232
- Blackboard Ally ............................................................................ 233
- Closed Captioning of Videos ....................................................... 237
- Ensemble Closed Captioning ....................................................... 237
- Blackboard Accessibility Checklist ............................................. 242
- Creating Accessible Documents ................................................ 245

**Additional Resources/Web Sources**
Visit the Seminar 8 Learning Module in your Preparing to Teach Online course in Blackboard for additional videos, PowerPoints, and web resources. These will be available to you for the duration of the course and for future reference.
**What is Accessibility?**

“Accessibility means equal access. The ability of all persons, regardless of special needs or disabilities, to access, use, and benefit from everything within their environment.”

Suzanne Anderson McNeil  
Assistant Vice President, Student Health and Wellness  
Dean of Students Office/Student Affairs  
University of Hartford

---

**The Americans with Disabilities Act (ADA)**

“…Prohibits discrimination against people with disabilities in employment, transportation, public accommodation, communications, and governmental activities. The ADA also establishes requirements for telecommunications relay services.”

(https://www.dol.gov/general/topic/disability/ada)

---

**The Rehabilitation Act of 1973 (the “Rehab Act”)**

Prohibits discrimination on the basis of disability in programs run by federal agencies; in programs that receive federal financial assistance; in federal employment; and in the employment practices of federal contractors.

- **Section 504** “makes it illegal for federal agencies, or programs or activities that receive federal financial assistance or are conducted by a federal agency, to discriminate against qualified individuals with disabilities.”

- **Section 508** “requires federal electronic and information technology to be accessible to people with disabilities, including employees and members of the public.”

Not just a legal issue, it’s a retention issue

Over 1 billion people globally experience a disability of some sort. Some are visible, but many are not. The rate of students with disabilities are rising and many students don’t disclose.

Take a look at the numbers:

1. Over BILLION People globally experience disability
2. 2.4% visual disabilities
3. 3.6% hearing disabilities
4. 15% Of the world’s population
5. 6.2% Of average college-age students in the US (16-20 years Old)
6. 7.1% ambulatory disabilities
7. 5.2% cognitive disabilities

Data from: [http://www.who.int/disabilities/world_report/](http://www.who.int/disabilities/world_report/)

---

How does this translate to the (online) classroom?

The challenge is making education accessible to all. This means that the teaching methods, strategies, and educational materials should be inclusive and available to all students, including:

- Online Activities
- Reading Materials (Documents/PDFs)
- Images
- Tests/Quizzes
- Videos/Audio Files
So how do we do this? Put the “U” in Universal Design for Learning

It is a lot to think about but is critical to do and is an on-going process. We do not expect 100% accessible content from day one, but you should be able to show progress.

- Use Alternate Tags (Descriptions on images)
- Use Heading Styles within a document and Headers on table rows
- Incorporate engaging material (such as videos, simulations, etc.)
- Caption or transcript videos and audio
- Provide meaningful links (instead of “Read More” or “Click Here”)
- Ensure that PDFs and Documents can be read by text-to-speech software
- Choose textbooks that are accessible and have accessible content

Instructors should not feel as though they need fix everything all at once. Start with the online course you are about to teach and prioritize the most critical fixes, such as alt tags and headings. The idea is to make progress, not to make you feel overwhelmed and there are tools that make this easier for you. Some of these tools are:

- Blackboard Ally
- Adobe Acrobat Pro
- Microsoft’s Built-in Accessibility Checker
- Ensemble Automatic Captioning

---

**Blackboard Ally**

Blackboard Ally is an accessibility checker now available in all Blackboard courses. Ally provides insight into the course's level of accessibility, and makes suggestions on how the instructor can improve the accessibility of course content. Your class is full of diverse students with unique learning abilities. Providing them with more accessible original content means they can choose formats that work best for them: HTML for improved reading on mobile phones, Electronic Braille for the visually impaired, and Audio for learning on the go. Ally automatically scans your original content, and performs a series of steps to make them more accessible.
**Alternative Formats for Students**

Ally automatically generates these “Alternative Formats” for all your course files, and makes them available for download to you and your students. Your original file will not be affected by the alternative formats.

Students choose the file type that’s best for them and then they click **Download**. Note: the file may take a few minutes to generate.

For more info on alternative formats, visit:
https://help.blackboard.com/Ally/Ally_for_LMS/Student/Alternative_Formats

**Ally Indicators for Instructors**

Ally integrates with Blackboard, and provides feedback within your course. Students do not see this feedback. Inside your course you will find the Ally indicators next to files or content. If you have no course files yet, upload one, and an indicator will appear next to the file name. Click the indicator to view your accessibility feedback. Follow along step-by-step to improve your original file.

![Needs help! A little better Almost there Perfect!]

**Steps to Updating Files**

1. Click the Indicator
2. Read the Feedback
3. Improve your file
4. Increase your score

**5 Easy Ways to Improve Document Accessibility**

There are many ways to improve the accessibility of your documents and Ally will walk you through each one step-by-step. Below are the five easiest ways to improve your course’s accessibility score and in the following sections, we will walk through each in a little bit more detail:

1. Provide Alternative Text for Images
2. Don’t Use Scanned PDFs
3. Use Document Heading Styles
4. Use Header Rows on Tables
5. Create Tagged PDFs
**Provide Alternative Text for Images**

Images can be a great way to engage your learners with different modes of learning, and can help communicate complex ideas to students. For students with visual impairments, “alternative descriptions” that explain the content of an image are crucial for their learning. For all students, text descriptions can provide deeper context to aid their comprehension. Images embedded directly into Blackboard, Word Documents, PowerPoints, Excel and PDFs should include alternate text so people with vision impairments get the same information as anyone else.

If your image is only for visual effects, and doesn't contain information relevant to the learning content, select **Indicate image is decorative**.

**Fixing Scanned PDFs**

PDF (Portable Document Format) makes a simple, compressed file that any of us can view on any computer or any device with a free PDF reader app. However, a scanned PDF is inherently inaccessible because the content of the document is a graphic representing the letters on the page, not searchable text. It is more like an image. This means assistive technology (such as screen readers) cannot read this type of PDF. There are several steps in fixing a PDF.

When you come across a scanned PDF, do your best to replace it with a proper digital text document. There are converters for scanned PDFs to OCR (Optical Character Recognition) which allows the text to be searchable and to be able to be read by a screen reader. Adobe Acrobat Pro is one such program, but there are also free programs out there, such as: [http://www.free-online-ocr.com/](http://www.free-online-ocr.com/).

**Use Document Heading Styles**

Headings make navigating documents easier for all. By using headings in your document styles, you can design sections and sub-sections for your documents. Headers can help students navigate and comprehend texts, and are essential for screen readers. Heading Styles are built into your favorite Word Processing application (such as Microsoft Word) and are readily available on the ribbon.

![Word Menu used to Apply Heading Styles](https://support.office.com/en-us/article/add-a-heading-3eb8b917-56dc-4a17-891a-a026b2e790f2)

For more information on adding Heading Styles, visit: [https://support.office.com/en-us/article/add-a-heading-3eb8b917-56dc-4a17-891a-a026b2e790f2](https://support.office.com/en-us/article/add-a-heading-3eb8b917-56dc-4a17-891a-a026b2e790f2)
Use Header Rows on Tables

Headers make navigating tables easier. Using tables in your documents can be a great way to help organize complex information for students. To make sure your tables are effective and accessible, however, you should only use them for data, and not for visual layouts. Adding headers to your tables improves how your students navigate tables, especially if they use a screen reader.

Headers can be added to tables right within your Word Processing document (such as Microsoft Word). Directions for adding table headers: [https://support.office.com/en-us/article/format-a-table-e6e77bc6-1f4e-467e-b818-2e2acc488006#bm10](https://support.office.com/en-us/article/format-a-table-e6e77bc6-1f4e-467e-b818-2e2acc488006#bm10)

Create Tagged PDFs

Ensure that your documents and presentations stay accessible when converting to PDF. Although keeping your content in the original source file is the best way to ensure the document remains accessible, many instructors prefer to export their documents and presentations as PDFs. When exporting as PDF, it's important to check your export settings to make sure that the PDF will be tagged. This makes sure the PDF is easy to navigate.

NOTE:

- **Microsoft Word**: Select File and Save As. Select PDF from the File Format menu. Select *Best for electronic distribution and accessibility* and select Export.
- **PowerPoint**: You can't save PowerPoint files as tagged PDFs. Upload the PowerPoint file instead.

Sometimes we don’t have access to the original file, and a Tagged PDF is still needed. Certain software such as Adobe Acrobat Pro or online free from: [https://pdfix.net/apps/add-tags-to-pdf/#pdfix_online_sample](https://pdfix.net/apps/add-tags-to-pdf/#pdfix_online_sample)

Scanning PDF Documents for Accessibility

1. **Adobe Acrobat Pro**
   Adobe Acrobat Pro X and higher comes with a comprehensive accessibility checker that you can use to check one document at a time and it will flag issues for correction within the document.
2. **PAC - PDF Accessibility Checker**

Scanning Microsoft Documents for Accessibility

Microsoft Word, PowerPoint and Excel have a built-in Accessibility Checker. For more information on using this: [https://support.office.com/en-us/article/use-the-accessibility-checker-to-find-accessibility-issues-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f](https://support.office.com/en-us/article/use-the-accessibility-checker-to-find-accessibility-issues-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f)
Closed Captioning of Videos

It is critical to include subtitles/captions for any video content you add to your online course. If you are using videos from other sources, check to see if they have the Closed Captioning (CC) symbol in the lower right to toggle captioning on/off. TedTalks, PBS and news sources often have closed captioning included automatically, but if you include content from YouTube, you need to make sure they have captioning or see if the video owner has enabled community captioning. If not, you can reach out to the content creator to see if they can caption the file. If you are uploading your own content to Ensemble, we have a solution for you!

Ensemble Closed Captioning

Ensemble is a place to upload your videos or audio content so they can be linked into Blackboard or other websites. Provided you have been granted captioning privileges, all new videos uploaded to Ensemble will automatically be captioned, but videos uploaded prior to 2018 will need to be manually submitted for captioning.

Priority for captioning privileges are given to instructors or staff who:

1. teach fully online, flipped or blended classes
2. create videos used for training or marketing purposes
3. support students who request accommodations

If you have not signed up for Ensemble or Automatic Captioning, please fill out the form here, and your account will be created/updated for you:
http://hartford.edu/academics/faculty/fcld/course_requests/EnsembleRequest.aspx

Once you have an account, FCLD can help you get started.

Automatic Captioning when Uploading Videos to Your Library

Upload your video to Ensemble, just as you normally do. When completed, the video shows up as Ready in your Media Library and you will see a thumbnail of the video with the CC icon in the lower right corner. The video should now be edited for accuracy using Ensemble’s Amara Caption Editor.

Closed Captioning on your Video in Ensemble
Manually Captioning Videos Already in your Media Library
If your video was published to Ensemble before Automatic Captions were turned on, you can submit them for automatic captioning. It takes just a few minutes to process your video (depending on size). Check back by refreshing this screen. For a 1 hour video, I would allow 10-15 minutes for automatic captioning to process, but oftentimes it takes less time (depending on volume of submissions).

1. To submit your video for Automatic Captions in Ensemble, first find your video in the Media Library, then click on Manage.

   ![Click Manage to navigate to the Captions tab](image)

2. In the upper right corner, you will then click the Caption tab.

   ![Click the Caption tab](image)

3. Click the Submit for Automatic Captioning button.

   ![Click the Submit for Automatic Captioning Button](image)
**Editing Captions in Ensemble Using the Amara Caption Editor**

Once your video has been captioned, you will notice a CC symbol shows up in the lower right hand corner of the thumbnail in your Media Library. You are now able to edit the captions for this video.

1. Return to the caption tab by clicking **Manage**, then click the **Captions** tab.
2. You will notice your file has caption files in the block under the name of your video.

![Automatic Caption Files](image1)

**Automatic Captioning of Videos**

3. If you see your caption files, click the **Amara Caption Editor** subtab, then click the **Launch Amara Editor** button.

![Click Amara Caption Editor, then Launch Amara Editor](image2)

The Amara Caption Editor has a built in tutorial on how to edit the captions in the upper left and right corners. The video displays in the upper center of the screen. You can play and stop and click anywhere in the timeline to jump around on the video. You will see the original version on the bottom left, the edited version bottom center and any notes you want to make on the lower right.
The Amara Caption Editor Introduction Screen

4. To hide the introduction screen, click on the banner at the bottom of the window and it will disappear.

5. Edit the captions in the lower center window directly there by clicking and typing in the window.

Edit Captions in the lower center window

6. If you need to save your work and come back to it later, click the Save Draft button in the upper right, then exit. **NOTE:** The window may time out on you if you leave it idle too long.

7. When satisfied with your captions, you click the Publish button in the upper right.

8. Exit when finished.
Save Draft, Publish and Exit in the Amara Caption Editor Window
Blackboard Accessibility Checklist

Section 508 of the US Rehabilitation Act, requires that all institutions that use federal funds, such as financial aid, are required to comply with these standards to make content accessible.

Some guidelines to ensure your course is accessible to Blackboard participants:

Media (Audio and Video):

Text alternatives should be provided to make audio and video content accessible to the deaf and those who have difficulty hearing.

- Text descriptions and ALT tags are provided for all video content.
- Text transcripts provided for all audio content.
- Text transcripts or closed captioning provided for all video content.

Images, Tables and Graphs:

Images

- Use appropriate **alt** text for images, tables and graphs with function (Video link in resources below)
  - NOTE: To create an “alt” tag when adding an embedded image in Bb, click the image icon in the text box editor, browse for image file, In the Insert Image options box that appears, enter a description of the image in the Alt Text line, Enter a long description so the screen readers can describe the image, and then click Submit.
- Images without function (decorative/background images) have no alt text entered.
- Minimal-to-no use of flickering animated graphic elements.

Tables

- Summaries are provided for data tables.
- Data tables include identifying headers.
- Are your tables images or text? Screen readers can read text tables. Provide long descriptions for tables that are images.

Text and Color:

Ensure that the foreground/background colors, as well as the written text, have sufficient contrast to make your content more readable for everyone. NOTE: Screen readers do not recognize color.
**Text**

- Use a standard font-size and style (no elaborate text) – Bb default is Arial, size 3 (12 pt.)
- Blinking or moving text is avoided.
- Do not underline text in Blackboard – this suggests a hyperlink to a document or external page for the user to click on. This can confuse those with visual disabilities.

**Color**

- Text color contrast.
- Minimal use of color (overuse of many colors can be confusing to the viewer)
- Do not use only color to emphasize points in your content.
  - **NOTE**: Example, avoid the use of “all items in RED are required”
- No yellow-blue or red-green combinations.
  - **NOTE**: Color blind students will not be able to read these combinations

**Testing:**

New features have been added to Bb’s test options called “Test Availability Exceptions.” Instructors can select one or more students to make a number of exceptions to the already established settings for the test. Exceptions can be used to provide accommodations to disabled students, such as extended time or more attempts on the test.

**Course Layout:**

**Menu Buttons**

- High contrast between text color and background for best readability.
- Do not use patterned buttons.
- Remove or hide buttons/tools that are not used.

**Course Links**

- Descriptively and consistently name course links. Avoid usage of “click here” or “more.”
- Make sure links are recognizable (underlined).
- High contrast between text color and background.
- Set links to open in a new window.

**Course Layout**

- Use a standard navigation scheme and menu-structure for students to navigate the course.
- Appropriate use of white space.
- Minimal scrolling on pages.
- Tables are not used to format/organize images or text.
**Attaching Documents:**

- Linked titles for documents attached in Bb include the file extension (.pdf/.rtf/.doc, etc.)

**Microsoft Word Documents**

Office does a great job of making your documents automatically accessible in Word, but you need to check and provide alt tag descriptions of images/tables/graphs in there as well.

- Use appropriate alt text for images/links.
- Use Heading Styles to format documents (Title, Heading 1, Heading 2, Paragraph…)
- Ensure Tables have Header Rows
- Run the Accessibility Checker.
  - File > Info > Prepare for Sharing > Check Accessibility

**Microsoft PowerPoint**

PowerPoint is a great tool to use, but makes accessibility a little bit harder since you can embed audio/videos/images, etc. in your presentation. You need to be really sure you are using the notes section as well as alt tags to describe content that is not text based.

- Use appropriate alt text for images/links.
- Provide transcripts for audio/videos.
- Ensure videos have closed captioning where appropriate.
- It may be necessary to provide a text alternative to PowerPoint.
- Run the Accessibility Checker.
  - File > Info > Prepare for Sharing > Check Accessibility

**Portable Document Files (PDF)**

There are several concerns about PDF files. Many times, PDFs are scans from a textbook or other source. These scans are not accessibility friendly. For best practices, ensure that either:

- PDFs are created from Word documents or other programs that do text to PDF conversion (check that you are able to highlight the text in the PDF file).
  - It may be necessary to create a text file in addition to your PDF.
- PDFs are created with OCR scanning software.
  - Optical Character Recognition (OCR) allows you to convert different types of documents, such as scanned paper documents or PDF files into editable and searchable data.
  - Many scanners today come with OCR capable software packages.
  - Free online OCR scanner: [http://www.free-ocr.com/](http://www.free-ocr.com/) will take files you have scanned and run them through the OCR software to output a text based file.

**NOTE:** OCR is not perfect and you will have to manually check your document.
Applets and Plugins:

- Provide clear instructions and/or link to applets and plugins when required. If the audio file requires Windows Media Player or a Flash presentation requires Shockwave, the link must be given for students to download.

Resources:


Creating Accessible Documents

More information on creating accessible Word, PowerPoint, Excel or PDF documents can be found at: http://hartford.edu/academics/faculty/feld/resources/accessibility.aspx
REFERENCES


Assessment at Baruch. [Graph illustration Bloom’s Taxonomy, 1956], Baruch College, Retrieved from https://www.baruch.cuny.edu/assessment/creating.htm


Section 508 of the Rehabilitation Act. Section 508.gov Opening Doors to IT. Retrieved from http://www.section508.gov/Section-508-Of-The-Rehabilitation-Act


---

Preparing to Teach Online | Faculty Center for Learning Development 249


